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Introduction 

OpenBook User’s Guide 

About this Guide 

The OpenBook User’s Guide teaches you to use and 
customize OpenBook’s image acquisition and reading 
capabilities to fit your personal needs.  

The first book, the Quick Start Guide, gives you the basics to 
get up and running with OpenBook. Following the Quick 
Start Guide are more books that give complete instructions 
to all of OpenBook’s features. Finally you will find a list of 
keystrokes for quick reference. These keystrokes are also 
available in the back of the print and Braille Quick Start 
Guide as perforated reference cards.  

However you decide to use this guide, we will lead you to a 
more productive computing experience with this powerful 
software. 

Documentation Conventions 

In the OpenBook User’s Guide we will refer to various 
commands, menu options, and other selections. To make 
reading this guide as simple as possible, we have included a 
sample of the following conventions.  

When instructing you to type text into a command line or 
input field, the text will appear in this type style: 
C:\Openbk9\Obu.exe. 
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A hot key is a combination of keys pressed on the keyboard, 
which invokes the same response regardless of the 
application you are currently using. A hot key can be a single 
key on the keyboard, but more commonly it is several keys 
pressed in combination. For example, ALT+CTRL+O 
requires you to press all three keys simultaneously.  

Alternatively, shortcut keys invoke a different action 
depending on the application in which you are currently 
working. Shortcut keys also can be one key or multiple keys 
pressed in combination. Shortcut keys may also require you 
to press a sequence of keys, such as ALT+F, O. In this 
case, you would press the ALT key and the F key, release 
them, and then press the O key. These hot keys and 
shortcut keys will appear in bold text throughout the User’s 
Guide. 

Another convention we use in this Guide is the reference 
regarding the active state of an item. When we refer to an 
item in the active state, we mean that OpenBook is focusing 
on the item and certain keystrokes performed affect that 
item. OpenBook gives both auditory and visual feedback to 
indicate the active state.   
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Book 1 

Quick Start to OpenBook 

Welcome to OpenBook 

OpenBook is a software program that transforms your 
personal computer and scanner into a full-featured reading 
machine. Use any of today’s popular scanners or the 
PEARL™ Portable Reading Camera from Freedom 
Scientific, to acquire the text of your favorite magazine, 
book, or newspaper article, and let OpenBook immediately 
read that page aloud to you. Or open an electronic file from 
any of today’s most popular applications and edit at will. With 
OpenBook nothing is left inaccessible and even better, you 
are in control of how a page is read and presented on your 
computer screen. 

With the PEARL, you will experience instantaneous page 
acquisition, enabling OpenBook to process multiple pages 
within seconds. The PEARL camera has an automatic mode 
that senses motion and allows it to capture an image 
whenever a page is turned. When used on a laptop or 
netbook computer, you will have a truly portable acquisition 
and reading system while on the go.  

System Requirements 

The recommended system requirements for OpenBook are 
listed below.  
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Specification Minimum Requirement 

Operating system All 32-bit versions of 
Windows XP and Windows 
Server 2003, all 32- and 64-
bit versions of Windows 
Vista, and all 32- and 64-bit 
versions of Windows 7 and 
Windows Server 2008. 

Processor speed 500 MHz Intel® Pentium® or 
faster 

Memory (RAM) 256 MB (512 MB 
recommended 

Available hard disk space  
for installation 

1.2 GB (on the drive 
containing the Program Files 
and Windows folders) 

Video 256 color graphics 

Sound Windows compatible sound 
card and speakers 

Keyboard 104 key Keyboard 

Acquisition device A TWAIN or WIA-compatible 
flatbed scanner or the 
PEARL camera from 
Freedom Scientific 

CD ROM Drive  

Installing OpenBook 

To install OpenBook on your computer, do the following: 



 5 

Important:  If you will be using the PEARL, do not connect the 
camera to your computer until the OpenBook 
installation is complete. For more information on 
connecting and setting up PEARL, refer to the PEARL 
Quick Start Guide. 

1. Insert the OpenBook disc into your CD-ROM drive. 

2. The OpenBook Setup program starts. You will hear the 
installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
OpenBook installation. 

Note:  If your OpenBook installation disc does not start 
automatically, go to the Start button, select Run, and 
type D:\setup. If your CD-ROM drive is not D, 

substitute the correct drive letter. 

The OpenBook setup program will then begin. 

3. Choose the Typical installation to install OpenBook to the 
default location on your hard drive. Select the Custom 
installation if you want to install OpenBook in a location 
other than the default.  

4. Once installation is complete, you must restart your 
computer before using OpenBook. 

Note:  During installation on certain Windows systems, you 
may receive a message stating that software you are 
installing has not passed Windows Logo testing to 
verify its compatibility with Windows. If this occurs, 
choose the Continue button in Windows XP or Vista, or 
the Yes button in Windows 7 to ignore this message 
and resume the installation. OpenBook will install and 
run correctly. 
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Uninstalling OpenBook  

To uninstall OpenBook go to the Programs Menu and select 
OpenBook 9.0. In the Tools submenu select the Uninstall 
OpenBook option and follow the prompts to remove the 
software. If you have any other Freedom Scientific products 
such as JAWS or MAGic installed, make sure you choose 
the option to leave shared components. 

Activating OpenBook 

After you install OpenBook, you must activate your software. 
When you first start OpenBook, you are asked to activate the 
program. You can activate OpenBook at a later time by 
opening the Help menu and choosing Update Authorization. 
OpenBook runs in 40 minute mode until it is activated on 
your computer. To close the Activation dialog box and 
continue using OpenBook in 40 minute mode, choose Run 
as Demo. You must restart your computer every 40 minutes 
in order to continue using OpenBook until it is activated. 

Internet License Manager (ILM) allows you to quickly 
activate OpenBook using the Internet. If you do not have an 
Internet connection, you can activate OpenBook by 
telephone or fax. Alternatively, you can activate OpenBook 
with the assistance of a trusted friend, relative, or 
organization that has access to the Internet.  

Note:  Your user account must have power user or 
administrator privileges to activate OpenBook. Contact 
your network administrator if your account does not 
have the required level of access. 
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You can also use a dongle (a hardware device that connects 
to your computer's USB or parallel port) to make your 
OpenBook license more portable. A dongle allows you to 
use an authorized version of OpenBook on any computer as 
long as the dongle remains connected. 

Note:  Adding or removing certain hardware components may 
cause your computer's Locking Code to change. If this 
occurs, you must reactivate OpenBook. If you need to 
request more activations, go to 
http://www.fsactivate.com. 

Activating with Internet License Manager 

You can use Internet License Manager (ILM) to activate 
OpenBook using an Internet connection. This is the easiest 
and quickest way to activate your product. To activate 
OpenBook using the Internet, do the following: 

1. In the Activation dialog box, choose Start 
Activation.  

2. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-ROM 
drive and choose Activate Using Authorization CD. You can 
find your Authorization CD in the same sleeve as your 
OpenBook program disc. If you do not have your 
Authorization CD, choose Enter Your Authorization Number 
Manually. 

Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
3 of the activation. 

3. Choose Activate.  

4. Use the ARROW keys to select Now, Using the Internet 
(RECOMMENDED), and then press ENTER.  

http://www.fsactivate.com/
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5. If you used your Authorization CD, your 20-digit 
Authorization number is automatically inserted into the 
Authorization Number edit box. If your Authorization number 
is not shown, type it into the edit box. You can find your 
Authorization number in print and Braille on your OpenBook 
disc sleeve.  

6. Press ENTER to continue. You will be asked to connect 
to the Internet if you have not already done so. You 
must establish an Internet connection before continuing 
with the activation.  

7. If you have not registered OpenBook, you are asked to 
do so now. Registering OpenBook lets you receive 
technical support. Choose Register Now and complete 
the online registration form by following the instructions 
provided. You can choose to register later, but you 
must register the next time you activate OpenBook.  

8. After you submit your registration, Internet License 
Manager attempts to activate OpenBook. This process 
may take several minutes. When the activation is 
successful, choose Finish. 

Note:  If Internet License Manager cannot activate OpenBook 
because of your firewall software, see the next section, 
Troubleshooting Firewall Software. 

Troubleshooting Firewall Software 

Firewalls protect computer systems from being accessed by 
unauthorized users. Some network or personal firewall 
software may interfere with the installation, activation, or 
usage of OpenBook. The following information will help you 
reconfigure your firewall to work with OpenBook. Refer to 
your firewall software documentation for more information on 
allowing access for programs and files. 
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Note:  Hardware firewalls do not interfere with installing, 
activating, or running OpenBook. 

Firewall Interferes with Installation 

If your firewall software is preventing you from installing 
OpenBook on your computer, reconfigure the firewall to 
allow the file Setup.exe to run. Then retry the installation 
procedure. 

Firewall Interferes with Activation 

If your firewall software prevents you from activating 
OpenBook using the Internet, reconfigure the firewall to 
allow the following files to run: FSActivate.exe, CAUtil.exe, 
and CAUtil.enu. Once you have reconfigured your firewall, 
retry the activation process. If you cannot reconfigure the 
firewall, or if you still cannot activate OpenBook, go to 
www.FSActivate.com. Follow the instructions on the Web 
page to retrieve an Activation License code and activate 
your software. For more information on using 
www.FSActivate.com, see Activating through a Trusted Third 
Party. 

Firewall Interferes with Using OpenBook 

If the firewall software prevents OpenBook from running or 
starting, or displays a warning message, reconfigure the 
firewall to allow the file OBU.exe to run. 

Activating by Telephone 

If you do not have an Internet connection, you can call 
Freedom Scientific Customer Service. Customer Service will 
send you a CD in the mail that will automatically activate 
OpenBook. To activate OpenBook by telephone, do the 
following: 

1. In the Activation dialog box, choose Start Activation.  
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2. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-
ROM drive and choose Activate Using Authorization 
CD. You can find your Authorization CD in the same 
sleeve as your OpenBook program disc. If you do not 
have your Authorization CD, choose Enter Your 
Authorization Number Manually. 

Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
3 of the activation. 

3. Choose Activate.  

4. Use the ARROW keys to select Telephone to Receive 
Activation by Mail, and then press ENTER.  

5. Call (727) 803-8015. Provide the customer service 
representative with the Authorization number and 
Locking code shown in this dialog box. If your 
Authorization number is not shown, you can find it in 
print and Braille on your OpenBook disc sleeve. 

6. Choose Quit. You can continue using OpenBook in 40 
minute mode until you receive your CD. 

When you receive the CD with your Activation License code 
from Freedom Scientific, insert it into your CD-ROM drive to 
automatically activate OpenBook. 

Note:  If the CD does not automatically activate your software, 
press WINDOWS Key+R, type 
"D:\ActivationCode.exe" and press ENTER. If 

your CD-ROM drive is not D:, then substitute the 
correct letter. 
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Activating by Fax 

If you do not have an Internet connection, you can send a 
fax to Freedom Scientific with your Authorization number 
and Locking code. You will then receive an Activation 
License code either in an e-mail message or on a CD. To 
activate OpenBook by fax, do the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-
ROM drive and choose Activate Using Authorization 
CD. You can find your Authorization CD in the same 
sleeve as your OpenBook program disc. If you do not 
have your Authorization CD, choose Enter Your 
Authorization Number Manually. 

Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
3 of the activation. 

3. Choose Activate.  

4. Use the ARROW keys to select Fax, and then press 
ENTER.  

5. Complete the form by typing the required information into 
the edit boxes. If you want to receive your Activation 
License code in an e-mail message, enter your e-mail 
address. If you do not enter an e-mail address, 
Freedom Scientific will send you a CD in the mail that 
will automatically activate OpenBook. 
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6. If you used your Authorization CD, your 20-digit 
Authorization number is automatically inserted into the 
Authorization Number edit box. If your Authorization 
number is not shown, type it into the edit box. You can 
find your Authorization number in print and Braille on 
your OpenBook disc sleeve. 

7. Choose Print to send the form to your printer. After you 
have printed the form, choose Quit. 

8. Fax the printed form to (727) 803-8001. 

If you entered your e-mail address, you should receive an e-
mail message from Freedom Scientific within one or two 
business days. Follow the instructions provided in the 
message to activate OpenBook. If you do not enter an e-mail 
address, you will receive a CD from Freedom Scientific in 
the mail. Insert the CD into your CD-ROM drive to 
automatically activate OpenBook. 

Note:  If the CD does not automatically activate your software, 
press WINDOWS Key+R, type 
"D:\ActivationCode.exe" and press ENTER. If 

your CD-ROM drive is not D:, then substitute the 
correct letter. 

Activating through a Trusted Third Party 

If you know a friend, relative, or other trusted person with an 
Internet connection, they can help you activate OpenBook. 
Alternatively, you can use an Internet connection in a library, 
at work, or anywhere else. You or a trusted third party can 
visit http://www.FSActivate.com to obtain your Activation 
License code.  

http://www.fsactivate.com/
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Tip:   A free program from Freedom Scientific called 
Activation Media Image Creator lets you create a CD, 
3.5-inch disk, or e-mail attachment containing 
OpenBook license information.  

To obtain an Activation License code from FSActivate.com, 
do the following: 

1. Point your Web browser to http://www.FSActivate.com. 

2. Enter your 20-digit Authorization number and Locking 
code. Your Authorization number appears on your 
OpenBook disc sleeve in both print and Braille. To find 
your computer's Locking code, open the OpenBook 
Help menu and choose About OpenBook. 

Note:  The Locking code is unique for each individual 
computer. Be sure you enter the Locking code of the 
computer you intend to use with OpenBook when it is 
activated. 

3. Choose Submit License Request to receive an Activation 
License code.  

4. The remaining steps must be completed on the computer 
where the copy of OpenBook you want to activate is 
installed. Begin by starting OpenBook on this computer. 
From the OpenBook Help menu, choose Update 
Authorization.  

5. In the Activation dialog box, choose Start Activation.  

6. Read the message that displays and then choose 
Continue. Insert the Authorization CD into your CD-
ROM drive and choose Activate Using Authorization 
CD. You can find your Authorization CD in the same 
sleeve as your OpenBook program disc. If you do not 
have your Authorization CD, choose Enter Your 
Authorization Number Manually. 

http://www.fsactivate.com/
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Note:  If you have previously inserted your Authorization CD, 
you will not be asked to insert it again. Continue to step 
7 of the activation. 

7. Choose Activate.  

8. Use the ARROW keys to select the Activation Generated 
from www.FSActivate.com radio button and press 
ENTER.  

9. Type the Activation License code you received from 
www.FSActivate.com into the edit box and then press 
ENTER.  

10. After you have successfully activated OpenBook, choose 
Finish to complete the process. 

Using Activation Media Image Creator 

Activation Media Image Creator is a free program from 
Freedom Scientific that allows a user with an Internet 
connection to retrieve Activation License codes from 
Internet License Manager. The user can then distribute 
these Activation License codes on CD, 3.5-inch disk, or e-
mail. Users without Internet connections can use the files 
created by this program to activate OpenBook without 
having to type the lengthy Activation License code.  

To download the installation package for Activation Media 
Image Creator, visit www.FSActivate.com. After you install 
the program, follow the instructions in the Activation Media 
Image Creator online Help to retrieve and distribute 
Activation License codes from Internet License Manager. 
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Dongle Authorization 

A dongle is a hardware device that you can connect to a 
computer's parallel or USB port (depending on the type of 
dongle). OpenBook is authorized to run on that computer as 
long as the dongle remains connected. This is useful if you 
frequently need to use OpenBook on many different 
computers and do not want to activate the program on each 
of them.  

When OpenBook starts, it first determines whether a dongle 
is connected to the computer. If one is connected, 
OpenBook uses the features and information for the license 
associated with the dongle to authorize OpenBook. If no 
dongle is connected, OpenBook searches for the license 
information stored on the computer. You can use the 
Dongle Viewer utility to view information on the license 
associated with the dongle currently connected to your 
computer. To start this utility, go to the OpenBook 9.0 
program group, open the Tools submenu, and choose 
Dongle Viewer. 

Note:  It is recommended that you do not connect the dongle 
to your computer until after you install OpenBook. If the 
dongle was connected before or during installation, you 
must restart your computer to receive proper 
authorization. 

Dongles are sold separately or as an additional OpenBook 
feature. Contact Freedom Scientific Sales at 800-444-4443 
or 727-803-8000 if you want to purchase one.  

Note:  Certain international versions of OpenBook require a 
dongle for authorization. Using one of these versions 
without a dongle displays an error message. 
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Installing the RealSpeak Solo Direct 
Synthesizer 

Included with the OpenBook program disc is another disc 
containing the RealSpeak™ Solo Direct speech synthesizer. 
It contains a variety of voices in several languages. To install 
these voices, insert the disc into your computer's CD-ROM 
drive. Next, follow the instructions to select which voices you 
want to install, and complete the installation.  

You can also use the RealSpeak Solo Direct Sample and 
Download page available at 
http://www.freedomscientific.com/downloads/RealSpeak-
Solo-Direct-Voices/RealSpeak-Solo-Direct-Downloads.asp. 
On this page, you can preview voice samples, and then 
download and install voices directly from the Web page. 

Getting Started 

Launching OpenBook 

OpenBook gives you a variety of ways to launch the 
program.  

• Press the hot key, ALT+CTRL+O, which is 
automatically assigned when you install OpenBook. 
You must restart your computer after OpenBook is 
installed in order for this hot key to work correctly. 

• Using your mouse, double-click the OpenBook 9.0 icon 
on your desktop.  

• Go to the Start menu and select Programs. Select the 
OpenBook 9.0 program group and choose OpenBook 
9.0.  
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Once launched, OpenBook opens with a blank untitled 
document from which you can begin working and announces 
whether the document is in Read-only or Edit Mode. If you 
prefer, you can change the startup document to be the 
document you were working on last. To do this, go to the 
Settings Menu and select General Settings (ALT+G, G). In 
the General Settings Dialog box, press TAB until you arrive 
on the Open Untitled Document on Startup radio button. 
Press the DOWN ARROW key to select the Open Last 
Document on Startup radio button. If you want to make more 
setting changes, press ALT+A or TAB to the Apply button 
and press the SPACEBAR. Exit this properties page by 
pressing ENTER. Next, to change the settings so that 
OpenBook is always in this Mode, open the Settings Menu 
again (ALT+G). From the Menu, choose Save the Settings... 
. In the Save Settings dialog box, press ENTER to make the 
changes part of the default settings. For more information on 
this feature, please see the book, Using Settings Files. 

Closing OpenBook  

You can close OpenBook like any other Windows application 
by pressing ALT+F4, pointing the mouse and left clicking on 
the X in the top right hand corner of the window, or selecting 
Exit from the File menu.   

Acquiring and Reading 

OpenBook combines the best in image acquisition, image 
processing, and reading features to convert printed media 
into electronic format. It then displays and reads the content 
aloud giving you access to material that would otherwise be 
inaccessible or difficult to read.  
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When you install OpenBook, the Eloquence text-to-speech 
synthesizer from Nuance is also installed and is the default 
for reading. OpenBook can acquire images using either a 
scanner, or the PEARL camera. You can acquire one or 
more pages from a document, such as a book or piece of 
mail, and then read or edit the resulting text. If you want to 
keep the document you just acquired, you can then save it to 
a file on your computer. Additionally, you can customize the 
acquisition, processing, reading, and display properties of 
OpenBook. 

To acquire a page from a scanner, place the page on the 
scanner bed and press the F4 key when you are ready to 
acquire the page. 

To acquire a document from the PEARL, position the page 
under the camera so that the top edge is aligned with the 
page guide. Center the page between the outer edges of the 
page guide, or line up a side edge of the document with an 
outer edge of the page guide. Press the F4 key when you 
are ready to begin acquiring. 

Note:  The PEARL is optimized to work in normal room lighting 
under most conditions. The LED should be left off. 

Here are a few shortcut keys to get you started with 
OpenBook.  

• To have OpenBook read to you, press INSERT+DOWN 
ARROW.  

• To acquire a page, press F4 or SPACEBAR.  

• To toggle between Edit Mode and Read-only Mode, 
press CTRL+E.  

• To silence speech press the CTRL key. 
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• To read faster, press ALT+CTRL+PAGE UP. 

• To read slower, press ALT+CTRL+PAGE DOWN. 

Getting Help 

Online Help System 

OpenBook’s Online Help System consists of three 
components, the Contents page with its tree view of books 
and topics, the Index page with its alphabetical listing of 
topics, and the Text View, which displays all topic content. 
When you launch Help, OpenBook places you in the Text 
View. To move from the Text View to the Tree View of books 
and topics, press F6. To return to and begin reading the 
contents in the Text View, press F6 again. 

To navigate the books in the tree, use the UP and DOWN 
ARROW keys. The RIGHT ARROW key expands books to 
display their topics, while the LEFT ARROW key closes 
books. When you find the topic you want to read, press 
ENTER. OpenBook Help displays that topic and 
automatically begins reading the contents.  

Note:  To display the selected topic in the Text View, you must 
press ENTER. Simply moving back to the Text View 
without pressing ENTER does not display or read the 
newly selected topic. 

The Index page is particularly helpful if you are searching for 
a particular topic because it lists help topics in alphabetical 
order. To move between the Contents and the Index pages 
of Help, press CTRL+TAB.  
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Navigating the Index’s list of topics is similar to navigating 
the Tree View of the Contents page in that you can use the 
UP and DOWN ARROW keys to move you up and down the 
list of topics. Or if you know the topic you want to find, type 
its first letter. For instance, you want information on the 
Zoom feature of OpenBook. You would then type the letter 
Z. The Index automatically moves through the list to that 
topic or to a topic that begins with the letter Z. 

You can also navigate OpenBook’s Help System by pressing 
the TAB key. When you press the TAB key, you cycle 
between the three controls in Help. Pressing the TAB key 
once activates the Tree View or Index list, use the ARROW 
keys to navigate or open and close topics. Pressing the TAB 
key twice, activates the Tab Control on the Contents or 
Index page, use the LEFT and RIGHT ARROW keys to 
switch between the Contents or Index page. Pressing the 
TAB key again activates the Text View where the topic 
contents are displayed. Here you can press INSERT+DOWN 
ARROW to read or the ARROW keys to navigate the 
contents.  

Context-Sensitive Help 

When you are in a dialog box, press SHIFT+F1 to read the 
context-sensitive help message for the current item.  

You can also access context-sensitive help by right clicking 
the mouse on a control and selecting “What’s This” or by 
clicking on the ? (question mark) symbol at the top right 
corner of the dialog box and then clicking on a control. 
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Key Describer 

Turning on Key Describer allows you to safely explore 
keyboard commands without actually performing the 
command. For example, when you turn on Key Describer 
and press a key, OpenBook tells you what the selected key 
does without actually performing that particular function. To 
turn on Key Describer, press INSERT+1. Press INSERT+1 
again to turn off Key Describer and return to normal 
operation.  

OpenBook User’s Guide 

We provide you with the content of the OpenBook Online 
Help System in the OpenBook User’s Guide, which uses 
large text for easy reading. The manual contains the Quick 
Start Guide, a detailed description of OpenBook’s features, 
and pull out reference cards. 

Technical Support 

If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, 
(727) 803-8600 or e-mail Support@FreedomScientific.com. 
Office hours are from Monday through Friday 8:30 A.M. to 
7:00 P.M. Eastern Standard Time. 

Please have the following information on hand: 

• Product serial number used for registration. 

• Product name and version number. 

• Type of computer hardware you are using. 

• Software version number of Windows. 
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About OpenBook 

Select About OpenBook from the Help menu to view the 
version number of OpenBook you are currently running. This 
dialog box also displays your product serial number and your 
computer’s locking code (used for ILM activation). 

Updating OpenBook 

Freedom Scientific is continually seeking to improve and 
expand OpenBook. Periodically, updates to OpenBook will 
be released. It is recommended that you keep your software 
up-to-date so that you experience the greatest possible 
performance.  

Updating your software is quick and easy. To search for 
updates to OpenBook, do the following: 

Note:  Your computer must be running Windows XP or later, 
and it must be able to access the Internet in order to 
use the following update procedure. 

1. Press ALT+H or click on the Help menu. 

2. Press P or select Check for Updates. The update feature 
determines if you have the most current release. If you 
do not, select one or more items from the list and then 
select INSTALL to begin the update. All enhancements 
since the initial release are included in the update.  

Note:  If your computer has active firewall software (such as 
Windows Firewall), you may receive a warning 
indicating that either the FSAutoUpdate Application or 
FSAutoUpdate.exe is attempting to access the Internet. 
You must allow this process to access the Internet 
through the firewall in order to retrieve updates. 
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Migrating Files from a Prior Version of 
OpenBook 

If you have updated from a previous version of OpenBook, 
you probably have files stored in your old Library folder that 
you would like to be able to access in OpenBook 9.0. 

When you uninstall a prior version, the OpenBook folder, 
which contains the Library, remains on your hard drive to 
ensure any files saved in these folders are not removed. The 
following procedures will show you how to navigate to and 
open these files, as well as move the older files to your new 
library folder.   

 To open files that are located in a previous OpenBook 
library, do the following: 

1. Press CTRL+O to open the Select a File to Open dialog 
box. 

2. Press SHIFT+TAB two times to move to the Look in 
combo box and press UP ARROW until you hear Local 
Disk( C:). 

3. Press TAB to move to the Files list view and use the 
arrow keys to locate the folder of the previous 
OpenBook installation and press ENTER. For example, 
if the last version installed was 8.0, locate the folder 
OpenBK8. 

4. Locate the folder Users and press ENTER. 

5. Locate the folder Default and Press ENTER. 

6. Locate the folder Library and Press ENTER to open the 
Library folder. 

7. Locate the category folder that contains the file you wish 
to open and press ENTER. 

8. Locate the file and press ENTER to open it. 
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If you need to regularly access files from a previous library, 
you will find it more convenient to simply copy the entire 
library, or selected contents, into your OpenBook 9.0 library. 

To copy a library, do the following: 

Note:   These steps assume you are familiar with 
navigating the Windows operating system with your 
screen reader or screen magnification software. 

1. Press WINDOWS Key+R to open the Run dialog box 
and type c:\OpenBKX\users\default\library (where X 
refers to the version number, such as 7 or 8) and press 
ENTER. 

2. When the Library folder opens, press and hold the CTRL 
key while navigating through the list of folders using UP 
or DOWN ARROW. When you locate a folder that 
contains files, press the SPACEBAR to select it. 
Continue until you have selected all of the folders you 
want. Alternatively, if all of the folders contain important 
files, simply press CTRL+A to select everything at 
once. 

3. Press CTRL+C to copy. 

4. Go to the OpenBook 9.0 program group and press 
ENTER on My OpenBook Documents to open the 
OpenBook 9.0 library. 

5. When the Library folder opens, press CTRL+V to paste. 
If you receive a dialog box telling you that folders 
already exist, select Yes to all. 

All files from your previous library are now available in the 
OpenBook 9.0 library. 
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Book 2 

Navigating OpenBook 

Use Your Keyboard or Your Mouse  

With OpenBook, you can use your mouse or your keyboard 
to access most features. Many people use a combination of 
the two. The OpenBook documentation gives you 
information on performing actions with both the keyboard 
and the mouse. For example, you can either press ALT+F to 
access the File menu, or you can point and click the word 
File with the mouse. 

Using the Keyboard with OpenBook 

OpenBook uses many Microsoft Windows® keyboard 
commands. For instance, special keys such as ALT, CTRL, 
SHIFT, TAB, and INSERT are often combined with the 
Function Keys i.e., F1 through F12, to perform specific 
operations such as closing an application (ALT+F4).  

Special keys can also be combined with a letter to invoke a 
command for example, CTRL+S, which saves the current 
document without closing it. Or they can be combined with 
letters assigned to features such as ALT+Q, which accesses 
the Acquire menu.  

By default, OpenBook does not announce these keystrokes, 
also known as shortcut keys and access keys. 

To have OpenBook announce these keystrokes, press 
ALT+G, P, followed by ALT+K. This takes you to the 
Speech Settings Properties page. After you press ALT+K, 
OpenBook should say "Announce Shortcut and Access 
Keys: checked.” Press ENTER to save the settings and 
close the dialog box.  
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Tip:  The underlined letter on a menu, a command button, or 
a dialog box option identifies the Access key, while 
Shortcut keys usually correspond to a command name 
on a menu.  

If you are unsure how an item or control works you can 
activate context sensitive help with SHIFT+F1 on the 
keyboard. To use this feature press the TAB key to move to 
the control that you want to see the help for and press 
SHIFT+F1.  

OpenBook Keyboard Layouts 

OpenBook lets you choose from three different keyboard 
layouts depending on the type of keyboard you use. Select 
from Desktop, Laptop, or Traditional (Ruby). Additionally, if 
you use multiple Freedom Scientific products, many 
keystrokes in the Desktop and Laptop layouts mirror those 
found in JAWS, MAGic, and the PAC Mate to make it easier 
when switching between these applications. 

If your keyboard has a numeric keypad, usually located on 
the right side of the keyboard, choose desktop. Many 
OpenBook keystrokes will use this numeric keypad. Refer to 
the Topic Desktop Keyboard Layout for a complete list of 
desktop keystrokes. Note: The desktop keyboard layout is 
selected by default.  

If your keyboard does not have a numeric keypad, as is the 
case with most laptop computers, choose laptop. Refer to 
the topic Laptop Keyboard Layout for a complete list of 
laptop keystrokes.  
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If you have used OpenBook for many years and prefer the 
traditional OpenBook keystrokes, choose Traditional (Ruby). 
Refer to the topic Traditional (Ruby) Keyboard Layout for a 
complete list of the Traditional OpenBook keystrokes. 

To change the keyboard layout: 

1. Press ALT+G to open the Settings menu. 

2. Press K to open the Keyboard Settings dialog box. 

3. When this dialog box opens, the Keyboard Layout 
combo box is active. 

4. Use UP or DOWN ARROW to locate the keyboard 
layout you want to use. 

5. TAB to the Ok button and press SPACEBAR. 

Note:   In both Desktop and Laptop keyboard layouts, you 
must press the CAPS LOCK key twice quickly in order 
to toggle all caps on or off. This is because the CAPS 
LOCK key is also used to perform certain OpenBook 
commands, such as CAPS LOCK+DOWN ARROW to 
begin a Say All. 

Using the Mouse with OpenBook 

Point & Click 

With OpenBook you don’t have to learn keystrokes to 
perform actions. You can use the mouse to point at items on 
the user interface, and click the buttons to activate features. 
For example, if you are in a dialog box, you can use your 
mouse to click directly on any option in the dialog box to 
select it.  

If you are not sure how to activate a feature, use your mouse 
to open the menus and find the feature you need. 
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Left Click vs. Right Click 

The left mouse button is the more commonly used mouse 
button because it activates menus and controls.  

Alternatively, the right mouse button provides useful 
shortcuts to many items found under OpenBook’s menus. 
Right click on the user interface to see a context menu or 
right click on a control to view context sensitive help. To use 
the context sensitive help feature, move the mouse to the 
control you want help on and right click. A “What's This” 
button appears. Move your mouse over this button and click 
the left mouse button to have OpenBook open and read the 
context sensitive help topic. 
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Book 3 

User Interface, Dialog boxes & Controls 

Introduction to the User Interface 

The user interface automatically opens when you launch 
OpenBook. To open the program, press ALT+CTRL+O or 
select it in the Programs Menu.  

The OpenBook user interface consists of the Title Bar, the 
Menu Bar, the Document Window, the Status Bar, and the 
Scroll Bar. 

You can work in other applications without closing the 
OpenBook program by using ALT+TAB. When you want to 
return to OpenBook, press ALT+TAB again. If you have 
more than two applications opened at the same time, you 
hold the ALT key down while you press the TAB key until 
you reach the application you want to work in.   

Title Bar 

The Title Bar is the blue bar across the top of the application, 
which says, “OpenBook – [name of the file/document].” 
Locate the OpenBook Title Bar at the very top of the window. 
Press INSERT+T to hear the text of the Title Bar. 

To open the Application System Menu, press 
ALT+SPACEBAR, or click the OpenBook icon on the left 
side of the Title Bar.  

The Application Menu contains six items: 

• Restore – This item restores the application window to 
its previous size and location. 

• Move – With this item you can change the location of 
the application window. 
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• Size – This item lets you change the size of the 
application window. 

• Minimize – This item reduces the application window to 
an icon. 

• Maximize – This item enlarges the application window 
so that it fills the screen. 

• Close – This item closes the application window. 
(ALT+F4) 

Located on the right side of the Title Bar are three small 
icons. These icons provide an alternative way to minimize, 
maximize, restore, or close your application. You access 
these icons with the mouse. 

Menu Bar 

The Menu Bar is located just below the Title Bar and 
contains the File, Edit, Acquire, View, Tools, Launch, 
Advanced, Settings, Low Vision, Window, and Help Menus.  

To open these menus press ALT and the underlined letter, 
also referred to as the Access key. For example, press 
ALT+F to open the File menu. 

Document Window 

The Document Window also referred to as the Text View is 
the main area of the user interface, which remains blank until 
you open, acquire, or type content into a new document. 
Depending on the amount of memory in your computer, you 
can have multiple document windows open at the same 
time. Each document can be in either Edit Mode or Read-
only Mode. Similarly, you can acquire multiple documents 
into OpenBook and view each document by pressing 
CTRL+TAB.  
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Status Bar 

The Status Bar appears at the bottom of the document 
window. The left side displays the line the edit or reading 
cursor is on, the total number of lines in the document, the 
page number, the total number of pages, and whether there 
are any unprocessed images. Line information is not 
displayed when in the Exact View. The right side displays 
workflow status information such as "Acquiring," "Processing 
page N" (where n is the number of the page currently being 
processed), or "Processing complete." For example, line 20 
of 87, page 2 of 10, 8 unprocessed images Processing page 
3. The right side of the status bar will be blank if the 
document focus changes after the workflow is complete, if a 
workflow has been canceled during acquisition or 
processing, or no workflow is in progress for the current 
document. 

To read the Status Bar, press INSERT+PAGE DOWN. You 
can determine whether or not the status bar is displayed 
from the View Menu. 

Scroll Bar 

The Scroll Bar is the shaded bar along the right side of the 
document window. It allows you to view other parts of a 
document. You scroll a document using the UP and DOWN 
ARROW keys or the PAGE UP and PAGE DOWN keys on 
your keyboard. 

If you are a mouse user, left click your mouse on either the 
Scroll Up or Scroll Down Arrow. Or drag the box between the 
Scroll Arrows up or down by pressing and holding the left 
button on your mouse. 
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Dialog boxes & Controls 

Dialog boxes are smaller windows that usually appear from a 
menu choice. They contain controls used to configure 
various settings.  

There are many types of controls in a dialog box, such as 
edit fields, and combo boxes.  

In dialog boxes, TAB moves you forward through the 
controls, while SHIFT+TAB moves you backwards. 

When a dialog box opens, OpenBook automatically speaks 
the dialog box text as well as the first control. To hear the 
text again along with all of the controls available in the dialog 
box, press INSERT+B. 

Multi-Page Dialog Boxes 

A Multi-Page dialog box is a dialog box with multiple pages. 
When you open a multi-page dialog box, the name of the 
current page is announced after the name of the dialog box.  

Multi-page dialog boxes contain an extra control, the page 
tab control. Move to this control the same as any other 
control, by pressing TAB or SHIFT+TAB until it is reached. 
Press RIGHT ARROW or LEFT ARROW to move between 
the pages of the dialog box, and press TAB to move to the 
first control on that dialog box page. 

You can also press CTRL+TAB to switch pages in a multi-
page dialog box. 
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Radio Buttons 

Radio buttons are small circles. Use DOWN ARROW to 
move through the radio buttons, and when you land on the 
appropriate choice, press TAB to move to the next control.  

Note:  Only one radio button in a group can be selected at a 
time.  

Edit Fields 

Edit fields are similar to the edit fields in word processors. 
You can type text into an edit field, and typically you can use 
the same navigation keystrokes here, as you would in a 
document edit field. A multi-line edit field allows you to type 
more than one line in an edit field.  

Edit Combo Box 

An edit combo box is a combination of two controls: an edit 
field and a list box. You can either type in a value or press 
ALT+DOWN ARROW to open a list box. The list contains 
suggestions for the contents of this field. Use the UP and 
DOWN ARROW keys to move through the list, and use 
ALT+UP ARROW or ESC to close the list box. If you do not 
find your choice in the list box, type it in the edit field.  

Combo Box 

A plain combo box differs from the edit combo box. You 
must make your selection from suggestions provided by the 
program. Either press DOWN ARROW to move through the 
choices, or press the first letter of the choice you want to 
make.  
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Edit Spin Box 

The edit spin box is also a combination of two controls. You 
can type in this field, or use the arrow keys to move through 
the list of suggestions. Edit spin boxes are common for fields 
that require numeric values.  

Left/Right Sliders 

Left/right sliders are oriented horizontally. You can use your 
LEFT and RIGHT ARROW keys to adjust this control. For 
some left/right slider controls, you can use PAGE UP and 
PAGE DOWN to move by larger increments. 

Check Box 

A check box can be checked or unchecked. OpenBook 
announces the current state of a check box when you move 
to it. Press SPACEBAR to check or clear a check box.  

Buttons 

Buttons are common to most dialog boxes. When you 
encounter a button, press the SPACEBAR to activate the 
button.   
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Tree View 

In a tree view, items are presented in a hierarchical format, 
which is organized vertically on the screen. Press UP or 
DOWN ARROW to move through the tree view. When you 
hear, "closed…," you press RIGHT ARROW to open that 
level. You are then presented with more information beneath 
it. Press DOWN ARROW to move through the next level. 
One of those items may also be closed so you would press 
RIGHT ARROW again to open that item. If you want to close 
a level, press LEFT ARROW. To have an item display in the 
text view press ENTER on the standard keypad. 



 

 

36 

Book 4 

 Adjusting Speech 

OpenBook allows you to adjust the speech settings so you 
can determine how much feedback you receive, which 
makes it easier to distinguish where and what OpenBook is 
reading. 

Selecting Voices 

With OpenBook, you can assign different voices for reading 
and editing text, speaking menu and dialog box items, and 
for reading text that has emphasis such as underline, italic, 
or bold. Additionally, you can adjust the volume, pitch, and 
inflection of each voice.  

To select and adjust voices: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. When the Properties page opens the Voice Selection 
combo box is active. Use your UP or DOWN ARROW 
keys to select the voice you want to modify. Once you 
have selected a voice, press TAB to move to the next 
control. 

Your choices are: 

• Reading Voice - the voice used to read and edit text. 

• Menu Voice - the voice used to read menus and dialog 
boxes. 
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• Emphasis Voice - the voice used to read text that is 
bold, underlined and in italics. The Emphasis Voice also 
reads bookmarks when the Announce Bookmarks 
check box is enabled in the Speech Settings Properties 
page.  

Note:  In order to have OpenBook recognize text that is 
bold, underlined and in italics, you must enable the 
Keep Text Emphasis check box in the Process page for 
the selected workflow. Please see the Book, Workflows, 
for more information. 

4. Use the SPACEBAR to check the Apply Settings to All 
Voices check box if you want to globally apply your 
voice setting changes for one voice to the other voices. 

5. The next seven controls are combo boxes that allow 
you to select the synthesizer, voice language, voice 
name as well as adjust the voice rate, volume, pitch, 
and punctuation level. You can experiment with these 
adjustments until you find the settings you like. Use 
your UP and DOWN ARROW keys to make your 
selections or point and click with your mouse. Press the 
TAB key to move to the next control or SHIFT+TAB to 
move to the previous control. 

To test the different voices options, press ALT+T. This 
activates the Test button, which also tests any voice 
modifications that you apply such as rate, volume, etc. To 
stop the test, press ALT+T again. 

6. If you do not want to use the OpenBook speech, press 
TAB until you hear “Enable Speech check box,” and 
press the SPACEBAR to uncheck this box and turn off 
speech. 
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7. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Synthesizer 

The Synthesizer combo box lists the different speech drivers 
you can choose from. The following choices are available: 

• RealSpeak Solo Voices – OpenBook includes the 
RealSpeak Solo Direct voices which can be installed 
from a separate disc. These voices offer responsive, 
high-quality, human-like speech and will appear in the 
Voice Name combo box when you select this option. 
This selection is not available until you have installed at 
least one RealSpeak Solo Direct voice. 

• SAPI 5 – Selecting this option lets you use any SAPI 5 
compatible voice installed on your computer. This 
includes the Microsoft voices that come with Microsoft 
Windows as well as third-party synthesizers that you 
purchase. Once you select this option, the available 
SAPI 5 voices are listed in the Voice Name combo box. 
Note that other assistive technology products may have 
SAPI 5 synthesizers that are only authorized to operate 
with those products. If such synthesizers are on your 
computer, OpenBook may not work with those specific 
voices. 

• Eloquence Voices – Selected by default, uses the 
Eloquence speech synthesizer which is automatically 
installed with OpenBook. 
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You can only select a synthesizer for the Reading and Menu 
voices. If the Emphasis voice is selected, this combo box is 
not available. When you select the synthesizer for the 
Reading voice, the same selection is also used for the 
Emphasis voice. 

If you attempt to select a synthesizer that has no voices 
available, you will receive a message, which is spoken by 
the previously selected synthesizer, informing you that no 
voices are installed for the current synthesizer and to select 
a different one. For example, if you change from Eloquence 
to SAPI 5 and there are no SAPI 5 voices on your computer, 
Eloquence will speak the message and will continue to 
provide speech so you can select a different synthesizer. In 
addition, you will not be able to change settings like the rate, 
volume, pitch, inflection, punctuation level, voice name, or 
language until you select a synthesizer with available voices. 
The OK and Apply buttons will also be unavailable. 

To change synthesizers: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Synthesizer.” 

4. Use your UP and DOWN ARROW keys or point and 
click with your mouse to select a different synthesizer. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Note:  With some speech synthesizers, pitch, punctuation, and 
multi-language options may not be available. 
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Language 

The Voice Language combo box lists the available 
languages depending on whether you are using Eloquence, 
RealSpeak Solo Direct, or SAPI5. The available languages 
will also vary depending on what synthesizers are installed. 
The default Eloquence synthesizer offers eight languages. 

To change the voice language: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Voice Language.” 

4. Use your UP and DOWN ARROW keys or point and 
click with your mouse to select a different language. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Note:  Some speech synthesizers allow you to select multiple 
as a choice in the Language combo box. Selecting 
multiple lets you choose any voice style from all of the 
languages available for the synthesizer.  

Voice Name 

The Voice Name combo box allows you to select which 
voice is used. It is helpful to have different voices selected 
for the Reading, Menu, and Emphasis voices. You then 
immediately know the source of information spoken by 
OpenBook. 
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The voices available in this combo box will depend on 
whether you are using Eloquence, RealSpeak Solo Direct, or 
SAPI 5 and what synthesizers are installed on your 
computer. The default Eloquence synthesizer offers 14 
voices including Reed, Shelly, Grandma, Grandpa, etc. 

To change the voice name: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Voice Name.” 

4. Use your UP and DOWN ARROW keys or point and 
click with your mouse to select a different voice. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Voice Rate 

To adjust the rate of the currently selected synthesizer: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Voice Rate.” 

4. Use UP ARROW to increase and DOWN ARROW to 
decrease the voice rate or point and click with your 
mouse to adjust the rate of speech. Use the PAGE UP 
and PAGE DOWN keys to adjust the rate in larger 
increments. 
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5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Voice Volume 

To adjust the volume of the currently selected synthesizer: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Voice Volume.” 

4. Use UP ARROW to increase and DOWN ARROW to 
decrease the volume or point and click with your mouse 
to adjust the volume of speech. Use the PAGE UP and 
PAGE DOWN keys to adjust the volume in larger 
increments. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Voice Pitch 

To adjust the pitch of the currently selected synthesizer: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Voice Pitch.” 
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4. Use UP ARROW to increase and DOWN ARROW to 
decrease the pitch or point and click with your mouse to 
adjust the speech pitch. Use the PAGE UP and PAGE 
DOWN keys to adjust the pitch in larger increments. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Note:   Pitch adjustment is not supported in all 
synthesizers. This includes the RealSpeak Solo Direct 
synthesizer that is distributed with OpenBook. 

Voice Punctuation 

To determine how much punctuation OpenBook announces 
while reading, choose an item from the Voice Punctuation 
combo box. Your choices are: 

• All - OpenBook speaks every punctuation symbol. 

• Most - OpenBook speaks the most commonly used 
punctuation such as periods and commas. 

• Some - OpenBook speaks the less common 
punctuation and does not speak periods and commas. 
This setting is the default for the Reading and 
Emphasis voices. 

• None - OpenBook does not speak any punctuation. 
This is the default for the Menu voice. 

Note:  The amount of punctuation you hear is unique to each 
synthesizer.   

To select Reading Voice Punctuation:  

1. Press ALT+G or click on the Settings Menu. 
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2. Press P or select Speech Settings to open the Speech 
Settings Properties page.  

3. Press TAB until you hear, “Reading Voice Punctuation.” 

4. Use your UP and DOWN ARROW keys or point and 
click with your mouse to select your punctuation 
preference. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Key Echo 

Use the Key Echo During Editing combo box to modify what 
feedback you receive while you are typing text into a 
document in Edit mode.  

To change the key echo: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Press TAB until you hear, “Key Echo During Editing” or 
press ALT+T to activate the combo box. Use the UP or 
DOWN ARROW keys to select the echo you want 
during editing.  

Your choices are: 

• Character - Speaks every keystroke as you type. 

• Word - Speaks only completed words; that is, it 
speaks the word you just typed as soon as you 
type punctuation or a space after it. 
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• Both - Speaks both the keystrokes as you type 
and the final completed word after you type it. This 
is useful for beginning typists or with material you 
are proofreading. 

• Off - Does not echo any keystrokes.  

4. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Capital Letters 

If you want OpenBook to announce capital letters while 
typing, you will then need to leave this check box active. 

To turn off the announcement of capital letters while typing: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Press TAB until you hear, “Capital Letters While 
Typing” then press SPACEBAR or press ALT+C to 
uncheck the box.  

4. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Shortcut and Access Keys  

Announces the menu shortcut or access keys (for example, 
CTRL+O for Open in the File Menu) after each menu item is 
spoken. This feature helps you learn these keystrokes so 
you can quickly perform the operations you want. This option 
is disabled by default. 
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To enable the Announcement of Shortcut and Access Keys: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Next, press TAB until you hear, “Shortcut and Access 
Keys check box.” 

4. Press the SPACEBAR to check the box.  

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Dialog Controls 

If you want more feedback on the type of controls you 
encounter while working in OpenBook, then enable this item. 
OpenBook will announce whether an edit box, button, combo 
box, etc., is active. This option is enabled by default. 

To turn off the announcement of dialog box controls: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Next, press TAB until you hear, “Dialog Controls.” 

4. Press the SPACEBAR to check the box.  

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 
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Announce Numbers as Single Digits 

If this option is enabled, OpenBook reads numbers as a 
series of single numbers. For example, 123 is read “one two 
three.” This setting is off by default. 

To have OpenBook announce numbers as single digits: 

1.   Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Next, press TAB until you hear, “Numbers as Single 
Digits.” 

4. Press the SPACEBAR to check the box.  

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Headers and Footers 

Enable this option if you want OpenBook to read the header 
and footer for each page when you use the Say All 
command (INSERT+DOWN ARROW). Uncheck this option if 
you do not want OpenBook to read headers and footers 
when you use the Say All command. You can still use the 
ARROW keys to read the header and footer. This option is 
enabled by default. 

To turn off the Announcement of Headers and Footers: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Press TAB until you hear, “Headers and Footers.” 
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4. Press the SPACEBAR to uncheck the box.  

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER.  

If you want to save your setting changes, open the Settings 
menu (ALT+G) and select Save the Settings (S). With the 
Save Settings dialog box open, type a name for the new 
settings file, then TAB to the Save button and press ENTER. 
For more information, please see the book titled, Using 
Settings Files. 
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Book 5 

Adjusting Visual Settings 

Low Vision Menu 

Although you can change the same settings in the Visual 
Settings Properties page (ALT+G, V), the Low Vision menu 
provides an easy-to-use interface for adjusting some of the 
more common visual aspects of your document, including 
font size and type; text and background colors; text spotlight 
colors; as well as character, word, and line spacing. These 
changes only affect the Text View, which is the recognized 
version of the document. 

Press ALT+L or click on Low Vision from the menu bar. Use 
the ARROW keys to navigate the menu items. When you 
find the item you want to change, press ENTER or click to 
select that item. This launches the Low Vision Settings 
dialog box, which has eight buttons and opens in the center 
of your screen. The button that corresponds with the item 
you selected in the Low Vision Menu will be active. For 
instance, if you selected Size from the menu, the Increase 
Size button will be active. At this time, you can press the 
SPACEBAR to change the setting, or press TAB to move to 
the next button.  

If you want more control over each setting, press TAB to 
move to the Customize button and press ENTER. This 
opens the Visual Settings Properties page found under the 
Settings Menu. This Visual Settings dialog box is the same 
dialog box you would navigate to using ALT+G, then V.   
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For your convenience, there are also shortcut keys that 
control the features available in the Low Vision Menu. You 
can press these commands anytime you need to change the 
way text is displayed on your screen in Text View. These 
changes remain in effect until you exit OpenBook. Below 
lists the description of the shortcut keys.  

Font size -- increase  CTRL+4 

Font size -- decrease CTRL+3 

Font & Background Color CTRL+5 

Font type CTRL+6 

Font spacing -- increase CTRL+8 

Font spacing -- decrease CTRL+7 

Visual Settings Properties page 

For complete control over how your document displays on 
your monitor in Text View, go to the Visual Settings 
Properties page (ALT+G, V). From this page you can select 
your preferred view, font type and size, page margins, and 
the color and spacing for every element on your page. You 
can also change the text and background colors for the text 
spotlight, which highlights words as OpenBook reads. Use 
the preview area near the bottom of the dialog box to see 
how the changes you make affects the text. Text View must 
be active in order to see any changes. 
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When this properties page opens, the Preferred View combo 
box is active. Use your UP or DOWN ARROW keys to select 
the view you want to apply when opening documents. Press 
TAB to move to the Font Name combo box. Again, use your 
UP or DOWN ARROW keys to select the font you want 
displayed then press TAB to move to the next combo box. 
Follow these basic steps to make changes for the document 
displayed on your screen. When you are done, press 
ENTER to exit this properties page. 

If you changed the preferred view, it will be applied to all 
future documents you open. For example, if you select Split 
View as your preferred view, all documents you open will 
open in Split View instead of the default Text View. To apply 
the view to the currently open document you must manually 
change it through the View menu (ALT+V), or close and 
reopen the document. 

If you want to save your setting changes, open the Settings 
Menu (ALT+G) and select Save the Settings (S). With the 
Save Settings dialog box open, type a name for the new 
settings file, then TAB to the Save button and press ENTER. 
For more information, please see the book titled, Using 
Settings Files. 
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Book 6 

Using Settings Files 

Understanding Settings Files 

This book on Using Settings Files discusses the importance 
of Settings Files in their global application with OpenBook 
and explains how they are used.    

In the Settings Menu (ALT+G) there are three important 
items that make working with OpenBook convenient and 
easy, especially if you have multiple needs. These items are:  

• Save the Settings 

• Retrieve Settings 

• Delete Settings 

Save the Settings 

When launched, OpenBook always uses the Default Settings 
file. Therefore, whenever you go into the Settings Menu to 
change a setting you should save that change to the default 
settings file. Otherwise none of your changes will apply the 
next time you launch OpenBook.  

You can save multiple settings files to use for certain 
situations. For example, you may be required to use Arial 
font 14 point in your academic environment, but prefer to 
type your friend’s letter in Batang 16 point. Or, maybe you 
are studying another language and need to change the 
default recognition strategy so you can acquire and read 
documents produced in that particular language. Whatever 
your reasons are, here is how you save your settings so you 
can use them whenever you have to.  
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To save setting changes, do the following: 

1. Use the items in the Settings Menu (ALT+G) to make 
OpenBook work the way you want. 

2. Go back to the Settings Menu (ALT+G) and select 
Save the Settings (S).  

3. With the Save Settings dialog box open, type a name 
for the new settings file or select the default file.  

4. At this point, you can press TAB to move to the Save 
button and press ENTER to save and exit the dialog 
box or you can press TAB to move to the list of check 
boxes.  

5. These check boxes represent each of the menu items 
listed under the Settings Menu. Choose All Settings to 
incorporate all setting changes into one Settings File or 
create individual Settings Files for each settings 
change.  

6. Use TAB to MOVE through the check boxes and press 
the SPACEBAR to check the item you want to save as 
a Settings File. You can make and apply as many 
Settings Files as you need. 

Retrieve Settings 

This item allows you to apply your Settings Files to your 
active document. If you choose not to retrieve any Settings 
Files, then OpenBook will use the default settings.  

To retrieve settings, do the following: 

1. Go to the Settings Menu (ALT+G) and select Retrieve 
Settings (R).  

2. Use your UP or DOWN ARROW key to move to the 
settings file you want to use. 
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3. Press ENTER to select the file and close the dialog 
box.  

4. If you want to apply more than one Settings File, simply 
repeat the steps outlined above. 

Delete Settings 

You can delete an OpenBook settings file that is no longer 
needed by doing the following: 

1. Go to the Settings Menu (ALT+G) and select Delete 
Settings (D).  

2. Use your UP or DOWN ARROW key to move to the 
settings file you want.  

3. Press ENTER to delete the file.  

4. A second dialog box appears asking you to verify the 
deletion. Press ENTER again to confirm and close the 
dialog box. 
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Book 7 
Acquiring and Processing 

Overview of Acquisition and Processing 

With OpenBook’s extensive image acquisition and 
processing features, you can access almost all printed 
documents. OpenBook can acquire an image from either a 
twain-compatible flatbed scanner or the PEARL Portable 
Reading Camera from Freedom Scientific. Once OpenBook 
acquires the image, it processes the image using optical 
character recognition (OCR) and converts the document into 
text. 

Acquisition Device Selection 

Use the Device Selection dialog box to specify the device 
OpenBook will acquire pages from. If both the PEARL and a 
scanner are connected to your computer when OpenBook is 
launched, OpenBook will use the camera by default. 

To change the acquisition device, do the following: 

1. Press ALT+A to open the Advanced Menu. 

2. Use the UP or DOWN ARROW key to navigate to 
Device Selection and press ENTER to open the 
Device Selection dialog box. 

3. In the Acquisition Source combo box, use the ARROW 
keys to select either Scanner or PEARL. If the camera 
is not connected to the computer, Scanner is the only 
choice. 

4. If you selected Scanner as your acquisition source, 
press TAB to move to the Device combo box.  
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5. In the Device combo box, use the UP or DOWN 
ARROW key to select the scanner type you are using. 
The number of driver choices depends on the number 
of scanners installed on your system. OpenBook 
detects each scanner driver installed on your computer 
and automatically selects a default driver. 

Note:  Due to its slow speed, we do not recommend using the 
HP TWAIN driver unless you are using one of the HP 
3200-4300 series scanners.  

6. Press TAB to move to the Ok button and press 
ENTER to close this dialog box. OpenBook will use the 
selected acquisition device until the next time you 
change it. 

Note:  If no acquisition devices are connected to your 
computer, the Device Selection dialog box will be 
unavailable. 

If you selected the PEARL for acquiring pages, you can 
activate the Camera properties button to configure settings 
specific to the camera. 

The Light Frequency Correction combo box allows the 
camera to adjust for the interference caused by the 
frequency of florescent lights. The choices are 50 Hz, 60 Hz, 
or None. The default setting is 60 Hz which is used by the 
United States, while 50 Hz is typically used in Europe. Select 
None if you are in a location with no florescent lighting. 

The Page Size combo box allows you to set the boundaries 
in which the PEARL will use when capturing an image.  You 
can choose from Letter (8.5 inches by 11 inches), A4 (210 
millimeters by 270 millimeters), or Full (9 inches by 12 
inches). The default setting is full. 
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By default, if OpenBook is not currently acquiring images 
from the camera, or Camera View is not active, PEARL will 
power down after five minutes of inactivity. The camera will 
reactivate if you begin an acquisition, switch to camera view, 
change the time out setting, or toggle the camera light. To 
configure how long PEARL waits before it times out, use the 
Timeout slider to choose a value between 1 and 20 minutes. 
If you do not want PEARL to time out, even when it is not 
being used, uncheck the Enable Camera Timeout check 
box.  

Once you have made the necessary changes, select Ok to 
close the Camera Properties dialog box, and once more to 
close the Device Selection dialog box.  

For scanners that are not automatically recognized by 
OpenBook, you may need to activate the Scanner Properties 
button to manually fine-tune the scanner’s twain settings so 
that it will work with OpenBook. This button is only available 
if OpenBook does not recognize the scanner. 

Select the Allow scanner to finish when canceling a scan 
check box if you canceled a scan in the middle of the 
process and you are no longer able to scan.  

Select the Black and white contrast uses Brightness instead 
of Threshold check box when a scanned document with 
Color disabled and Keep Exact View enabled looks identical 
to a scanned document using a contrast setting of 255. This 
should darken the contrast for better visibility. 

If your first scan works, but subsequent scans seem to 
ignore any changes made to the acquisition settings, you 
need to select the Must close TWAIN after each scan check 
box. 
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Once you have made the necessary changes, select Ok to 
close the Scanner Properties dialog box, and once more to 
close the Device Selection dialog box.  

Acquiring a Page 

There are two keys you can use to acquire a page, the 
SPACEBAR or the F4 key. If you are in Edit mode, you can 
only use F4 as pressing the SPACEBAR will insert a space 
into the currently open document. By default, when you 
acquire pages, OpenBook inserts them at the end of your 
document and places the cursor on the new page.  

To acquire a page from a scanner, place the page on the 
scanner bed then press the SPACEBAR or F4 key. For 
small books, such as paperback books, place the book 
sideways so both pages are on the scanner glass. This 
allows you to acquire two pages at once and maintain 
pagination (see Split Facing Pages). For larger books where 
only one page at a time will fit on the scanner, you will need 
to acquire each individual page. 

To acquire a page using the PEARL, position the page under 
the camera so that the top edge is aligned with the page 
guide. Center the page between the outer edges of the page 
guide, or line up a side edge of the document with an outer 
edge of the page guide, then press the SPACEBAR or F4 
key. For small books, such as paperback books, place the 
book sideways with one edge against the page guide, and 
then center the book between the outer edges of the page 
guide. This allows you to acquire two pages at once and 
maintain pagination. For larger books, acquire one page at a 
time, sliding the book to the left or right to capture the next 
page. 
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Note:  When aligning a large book with facing pages, make 
sure that the spine of the book is aligned with the edge 
of the page guide. This prevents needless information 
on the opposite page from being captured. 

OpenBook will play a camera shutter sound when the image 
is acquired. If you are using the camera, you will hear this 
sound immediately after pressing the acquire command. 

If you are using a scanner, OpenBook will announce when 
scanning has begun followed by a series of tones as the 
page is scanned. Once the scanner has finished scanning, 
you will hear the shutter sound as OpenBook acquires the 
image from the scanner. 

During the acquisition and OCR processes, you can 
continue working in your document. The status bar indicates 
the progress of the acquisition and recognition. For instance, 
“5 Unprocessed Images, Processing page 1.” OpenBook 
displays “Processing complete” once all pages have been 
recognized. Press INSERT+PAGE DOWN to hear the status 
bar information. 

If you are using the default Acquire and Read workflow, or 
another workflow that automatically begins reading the new 
page, OpenBook will begin reading as soon as recognized 
text is available – even if it is still processing the current 
page. 

Acquire Menu 

The Acquire Menu, found on the menu bar, contains most of 
the controls you need to acquire your items. To activate a 
menu option, open the Acquire menu, use the ARROW keys 
to locate the option you want, and press ENTER. 
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Workflow 

This submenu lists all factory and custom workflows. When 
you open this submenu, you are placed on the currently 
active workflow which is indicated by a check mark. 

To switch to another workflow, use the UP or DOWN 
ARROW keys to locate the one you want and press ENTER. 
The workflow you selected is now the active workflow. 

To make the current workflow remain active the next time 
you launch OpenBook, open the Settings menu (ALT+S) 
and choose Save the Settings (S). In the Save Settings 
dialog box, press ENTER to make the changes part of the 
default settings. 

For more information on workflows, please see the book, 
Workflows. 

Acquire a Page 

This item lets you acquire the page you have placed on the 
scanner or under the camera. You can also press F4 or the 
SPACEBAR (in Read-only mode) to carry out this function. 

Acquire and Replace Current Page  

Selecting this item acquires a page and replaces the current 
page with the newly acquired one. This feature is useful 
when you have a document with multiple pages and want to 
replace a page while maintaining the page sequence. You 
can also press CTRL+SHIFT+F4 to carry out this function. 

This item is not available if the current workflow is Acquire 
Image Only. 
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Acquire and Insert New Page  

Unlike Acquire and Replace Current Page, Acquire and 
Insert New Page does not remove pages. Instead, this 
submenu lets you choose to insert newly acquired pages 
before or after the current page in the document.   

These items are not available if the active workflow is 
Acquire Image Only. 

Re-recognize  

If you are not satisfied with the quality of the recognized text 
from an acquisition, use the items in this submenu to have 
OpenBook re-recognize the current page or the entire 
document without re-acquiring it. Only pages containing 
Exact View images can be re-recognized. By default, Keep 
Exact View is enabled for all factory workflows except for 
Mail Sorter Preview. If you have turned off this option for the 
current workflow, you must re-enable it and re-acquire the 
pages. You will then be able to perform re-recognition. Refer 
to the book on Workflows for more information on changing 
workflow settings. 

If you attempt to re-recognize pages containing bookmarks, 
comments, or highlights you have added, you are given the 
choice to continue the re-recognition and overwrite any 
mark-ups, or cancel the process. This gives you an 
opportunity to save your marked-up document using a 
different filename and then re-recognize without losing your 
marked-up copy. 
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To re-recognize the current page, open the Acquire menu, 
navigate to the Re-recognize submenu, and choose Page. 
The current page is replaced with the newly recognized text 
and the page begins reading from the top. If the current page 
does not have an Exact View image, this menu item will be 
inactive. 

To re-recognize the entire document, open the Acquire 
menu, navigate to the Re-recognize submenu, and choose 
Document. If none of the pages have exact images, this 
menu item will be inactive. If you attempt to re-recognize a 
document containing pages with and without exact View 
images, you are told that not all pages contain exact View 
images and that these pages can not be re-recognized. You 
are then asked if you wish to continue. If you select Yes, all 
pages with exact View images are re-recognized. Selecting 
No cancels the re-recognition. 

When re-recognizing pages, the settings from the currently 
active workflow are always used with the exception of 
Recognize Columns. For example, if Recognize Columns is 
enabled for the current workflow, and you think you might 
get better results re-recognizing the page with it off, open the 
Acquire menu and press ENTER on Recognize Columns to 
disable it. Then, try re-recognizing the page or document 
again. 
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BuckScan 

BuckScan recognizes both American and Canadian paper 
currency. Denominations supported include $1, $2, $5, $10, 
$20, $50, and $100. In order for BuckScan to correctly 
recognize your currency, you must go to the Settings Menu 
and select General Settings (ALT+G, G), then press TAB to 
move to the BuckScan Currency combo box. From the 
combo box, use the UP or DOWN ARROW keys to select 
U.S. Dollars or Canadian Dollars.  

To use BuckScan, place your bill horizontally along the edge 
of the glass plate’s right rear corner. Press CTRL+M or 
select BuckScan from the Acquire menu.  

If OpenBook fails to recognize the denomination, try placing 
your bill horizontally along the edge of the glass plate’s left 
front corner.  

Note:  BuckScan will only work with older scanners. Newer 
scanners have federally mandated counterfeiting 
protections in place which prevent them from being able 
to scan currency. 

Check Orientation 

Select this option to have OpenBook acquire a page and 
speak its orientation, for example, upside down, sideways, or 
right side up. When checking orientation, no additional 
recognition is performed. This is useful if you want to make 
sure the page you want to read is positioned correctly on the 
scanner or under the camera before it is recognized so you 
can get the most accurate results. 

This item is not available if the active workflow is Acquire 
Image Only. 
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Recognize Columns 

This feature is useful for acquiring pages where the text is 
printed in columns such as a newspaper. Turn this feature 
off when you acquire information that needs to be read 
across a page such as a billing statement. To enable/disable 
this feature, press CTRL+SHIFT+Z or choose Recognize 
Columns from the Acquire menu.  

The default setting for this option depends on the default 
setting of Recognize Columns in the Process page of the 
settings for the currently active workflow. For instance, the 
default Acquire and Read workflow is set to recognize 
columns while the Mail Sorter Preview workflow is set to 
ignore columns. Toggling the menu item is only temporary. It 
will revert back to the default setting if OpenBook is closed 
and restarted, or a different workflow is selected. 

To permanently change the default setting for Recognize 
Columns for the active workflow, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press O or select Workflow Settings to open the Workflow 
Settings properties page. 

3. In the list of workflows, make sure the currently active 
workflow is selected then choose Modify to open the 
Workflow Properties multi-page dialog box. 

4. Press CTRL+TAB to move to the Process page. 

5. Press TAB to move to the group of radio buttons that 
control column recognition and use the ARROW keys to 
select the option you want. 

6. Select OK to close this dialog box and once more to close 
the Workflow Settings properties page. 
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For more information on using workflows, please see the 
book, Workflows. 

Split Facing Pages 

Selecting this menu option splits the pages of a book, whose 
facing pages can both fit on the scanner glass or under the 
camera, into separate pages. This includes splitting the 
Exact View image into two separate images. OpenBook will 
store the pages separately, with separate page numbers. 
This allows the page numbers in your document to match 
the page numbers in the actual book. After recognition, 
OpenBook will automatically read the first page, and then 
read the second page.  

Just like Recognize Columns, The default setting for this 
option depends on the default setting of the Split Facing 
Pages check box in the Process page of the settings for the 
currently active workflow. By default, this option is disabled 
for all factory workflows. Toggling the menu item is only 
temporary. It will revert back to the default setting if 
OpenBook is closed and restarted, or a different workflow is 
selected. 

To permanently change the default setting for Split Facing 
Pages for the active workflow, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press O or select Workflow Settings to open the Workflow 
Settings properties page. 

3. In the list of workflows, make sure the currently active 
workflow is selected then choose Modify to open the 
Workflow Properties multi-page dialog box. 

4. Press CTRL+TAB to move to the Process page. 

5. Press TAB to move to the Split Facing Pages check box 
and use the SPACEBAR to check or uncheck the box. 
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6. Select OK to close this dialog box and once more to close 
the Workflow Settings properties page. 

For more information on using workflows, please see the 
book, Workflows. 

Previewing a Page 

Use CTRL+SHIFT+F3 to open a Preview document and 
quickly acquire and read the first couple of lines of a page. If 
you then want to fully acquire the page, press CTRL+F4 to 
close the Preview file, then press the SPACEBAR. If you 
want to acquire and preview another page, press 
CTRL+SHIFT+F3 again.  

This command uses the Mail Sorter Preview workflow to 
acquire and process the page. If you want to change any 
settings for the preview, such as how much of the page is 
acquired or whether or not OpenBook keeps an Exact View 
of the page, go to the Workflow Settings properties page 
(ALT+G, o) and modify the Mail Sorter Preview workflow. 
For more information on changing workflow settings, please 
see the book, Workflows. 

Note:  Changing the Recognize Columns and Split Facing 
Pages items through the Acquire menu will not apply 
when using the preview command. You must modify 
these settings in the Mail Sorter Preview Workflow in 
order for them to take affect when previewing a page. 

Photocopying Documents 

OpenBook allows you to acquire a document or image and 
immediately send a copy of it to your printer. Perform the 
following to create a photocopy: 
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1. Choose Photocopy from the Launch menu or press 
ALT+C, P. 

2. Press ALT+B and specify how many copies you want 
to make. Then press ALT+N and select the printer you 
want to use to create the copy.  

3. If necessary, activate the Properties button or press 
ALT+P to change the paper size, orientation, and 
margins.  

4. If you are using a scanner, select the Scan Initiated 
check box to have OpenBook announce when scanning 
begins.  

5. Select the Acquisition Tones check box to have 
OpenBook play tones as the image is being acquired. 

6. Select the Image Acquired check box to have 
OpenBook play a camera shutter sound once it has 
acquired the image from the scanner or camera.  

7. Select the Fit Printed Page check box to resize the 
acquired image so the entire document fits within the 
margins of the printed page. For instance, if the 
acquired page has narrow margins, but you are printing 
using wider margins. Clear this check box to print the 
image in its original size, fitting as much text as 
possible in the specified margins. Depending on the 
size of your print margins compared to the dimensions 
of the original acquired image, portions of the document 
may not be printed. 

8. Determine the color mode you want to use when 
acquiring in the Color Mode combo box. Choose from 
color, black and white, black and white fax, or gray 
scale. You must have a color printer and scanner 
capable of scanning in color to create color 
photocopies. 
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9. Leave the Automatic Contrast check box checked to 
have OpenBook automatically adjust the contrast 
depending on the page being photocopied. If you 
uncheck this option, you can then use the contrast 
slider to manually adjust the contrast from 0 to 16. 
Lower numbers produce darker copies while higher 
numbers produce lighter copies. Setting it to 8 is 
considered normal contrast. The contrast settings are 
ignored if the acquisition source is set to use the 
PEARL camera. 

10. Activate the OK button to begin acquiring the image or 
document. When the acquisition is complete, 
OpenBook prints the copy using the designated printer. 

Acquiring from Word 

You can acquire a page with OpenBook while you are 
working in Microsoft Word. When OpenBook finishes 
acquiring and recognizing the page, it displays the text in 
Word. For best results, do not acquire more than one page 
into the currently open Word document. 

To acquire a document from Word 2003 or earlier: 

1. Place the page you want to acquire on your scanner or 
under the camera. 

2. In Microsoft Word, open the File menu and choose 
Acquire Using OpenBook. 

To acquire a document from Word 2007: 

1. Place the page you want to acquire on your scanner or 
under the camera. 
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2. In Microsoft Word, press ALT or click on the ribbon, 
navigate to the Add-ins tab, and choose Acquire Using 
OpenBook. 

OpenBook acquires and recognizes the page. When 
OpenBook is finished processing the page, it displays the 
text of the page in Word. 

Changing the Default Recognition Strategy 

The strategy determines the speed and accuracy with which 
OpenBook recognizes text. This option is located in the 
Workflow Settings properties page and applies to all 
workflows unless specifically configured in the settings for a 
particular workflow. 

To change the default recognition strategy, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press O or select Workflow Settings to open the Workflow 
Settings properties page. 

3. Press TAB or ALT+T to move to the Strategy combo Box 
then use the ARROW keys to select a strategy.  

Your choices are: 

• Most Accurate - This option features the highest 
accuracy, but the longest processing time.  

• Fastest - This option features the shortest processing 
time, but the lowest accuracy. 

• Balanced - This option features an average processing 
time and a high degree of accuracy. This is the default 
setting. 

4. Press ENTER or click OK to apply your changes and 
close this dialog box. 
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5. Open the Settings Menu again (ALT+G) and choose 
Save the Settings (S). 

6. In the Save Settings dialog box, press ENTER to make 
the changes part of the default settings. For more 
information on this feature, please see the book, Using 
Settings Files. 

Primary and Secondary Recognition 
Languages 

These controls, found in the Workflow Settings properties 
page, specifies the language OpenBook identifies during the 
recognition process, not the language for OpenBook speech. 
This option is useful if the document you are acquiring has 
text that contains accent marks, umlauts, or other characters 
unique to a particular language. The primary and secondary 
recognition language settings apply to all workflows unless 
specifically configured in the settings for a particular 
workflow. 

To change the default primary or secondary recognition 
language, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press O or select Workflow Settings to open the Workflow 
Settings properties page. 

3. To move to the Primary Language combo box, press TAB 
or ALT+P. To move to the Secondary Language combo 
box, press TAB or ALT+C. 

4. Use the ARROW keys to make a selection. 

5. Press ENTER or click OK to apply your changes and 
close this dialog box. 
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6. Open the Settings Menu again (ALT+G) and choose Save 
the Settings (S). 

7. In the Save Settings dialog box, press ENTER to make 
the changes part of the default settings. For more 
information on this feature, please see the book, Using 
Settings Files. 

Acquiring Pages in the Background 

If you are working in another application with OpenBook 
running in the background, press CTRL+ALT+S to have 
OpenBook acquire and process an image using the currently 
active workflow without moving focus away from the 
application. This allows you to continue working in your 
application while OpenBook acquires and adds pages to a 
document. Press ALT+TAB to switch to OpenBook when 
you are ready to read the recognized text. 

If you prefer, you can change CTRL+ALT+S to a different 
keystroke. To change the acquisition hotkey, do the 
following: 

1. Press ALT+G or click on the Settings menu. 

2. Press K or select Keyboard Settings, to open the 
Keyboard Settings properties page. 

3. Press TAB to move to the Acquisition Hotkey box and 
press the key combination you want to use. This 
combination must be CTRL+ALT along with a letter or 
number. 

4. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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Book 8 
Workflows  

Introduction to Workflows 

A workflow is a collection of settings that control how 
OpenBook acquires and processes images. You select the 
appropriate workflow depending on how you want OpenBook 
to acquire the image, recognize the text, and then position 
the cursor for reading. Workflows can be as simple as 
acquiring a single page, performing OCR on it, then reading 
it, or more complex, such as acquiring and processing an 
entire book containing tables and other formatting. You can 
choose from one of the default workflows included with 
OpenBook, or create your own custom workflows to meet 
your needs. 

There are three ways to access the list of workflows: 

• Press the APPLICATIONS key to open the context 
menu and choose Workflows. A submenu opens listing 
all available workflows. 

• Open the Acquire menu (ALT+Q) and choose 
Workflows. A submenu opens listing all available 
workflows. 

• Open the Settings menu (ALT+G) and choose 
Workflow Settings to open the Workflow Settings 
properties page. You are placed in a list box containing 
all available workflows. 
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Factory Workflows 

OpenBook provides several pre-configured, or factory 
workflows, to perform the most common acquisition and 
processing tasks. Factory workflows can be modified, 
however, they cannot be renamed or deleted. If a factory 
workflow is modified, OpenBook displays “modified” 
following the workflow name. 

The following workflows are available: 

Acquire and Read 

Acquire and Read acquires and processes a single image. 
The new page is added to the end of the document and the 
cursor is moved to the top of the new page where OpenBook 
automatically begins reading. This workflow is best for 
quickly reading short documents, such as letters and 
recipes, and is the active workflow when you start OpenBook 
for the first time. 

Acquire in Background 

The Acquire in Background workflow allows you to acquire 
one page while you are reading another. The new page is 
added to the end of the document while the cursor remains 
at your current reading position. The document you are 
acquiring may be the same as the document you are 
reading, or you may acquire pages into one document, then 
open and read a different one.  

Acquire Image Only 

This workflow acquires the image and saves it as an image 
file, without performing the recognition process. This 
workflow is useful if you want to create and save an image 
file to be used later as a graphic. 
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Once OpenBook acquires the page from the scanner or 
camera, the Image File Name dialog box opens. This dialog 
box is similar to the Save As dialog box in the File menu and 
allows you to enter a name for the image file, select the 
location where the image is saved, and choose the image 
file format. Acquired images can be saved as TIF LZW 
(default), BMP, JPEG, PCX, PCX Fax, PCX grayscale, PNG, 
TIF Black and White Fax Mode, TIF Black and White, TIF 
RLE, or TIF Uncompressed files. 

To change the default image format used when saving 
images, you must go to the Settings Menu and select 
General Settings (ALT+G, G), then press TAB to move to 
the Image Output File Type combo box. Use the UP or 
DOWN ARROW keys to select the default image file type 
you want to use when acquiring pages using this workflow. 

Mail Sorter Preview 

This workflow replaces the Scan Preview menu item found in 
versions of OpenBook prior to version 9 and offers greater 
flexibility. It allows you to adjust how much of the page is 
acquired and whether or not the current page is overwritten 
with the new one. This makes it possible to keep records 
rather than only being able to access the information until 
the next page is acquired. As the name implies, this 
workflow is most useful for quickly scanning envelopes to 
determine their contents and who they are addressed to so 
you can sort them correctly. 
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This workflow is automatically used to acquire and process a 
page whenever you press CTRL+SHIFT+F3 to open a 
Preview document, even if it is not set as the active 
workflow. If you choose to set Mail Sorter Preview as the 
active workflow and press F4 to acquire a page, the page is 
placed into the current document. 

Multipage Prompt for Pages 

This workflow allows you to continue reading from your 
current location and acquire new pages that are appended to 
the end of the document. After each new page is acquired, 
OpenBook displays a dialog box with the following options: 

• Acquire Another Page: Activating this button causes 
OpenBook to acquire the next page and append it to 
the document. 

• Turn Pages Over: After acquiring one side of each 
page in a double sided document, activating this button 
allows you to acquire the opposite side of each page 
and have it inserted into the document in the correct 
page order during recognition. For instance, if you were 
acquiring three double sided pages, you could acquire 
pages 1, 3, and 5, select Turn Pages Over, and then 
acquire pages 6, 4, and 2. The pages would then be 
placed in the correct order during OCR. In order for 
pages to be sorted correctly in the document, make 
sure you always acquire the opposite side of the last 
page, even if it is blank. This option is not available if 
you have already activated it, or if you have enabled the 
Split Facing Pages setting for the current workflow. 

Note:  This feature is most useful with scanners that have an 
automatic document feeder. 
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• Finished Acquiring Images: Activating this button 
closes the dialog box and stops acquiring images until 
you begin another page acquisition by pressing the F4 
key, or through the Acquire menu. 

Once you select an action, the dialog box closes and you 
can continue reading where you left off in the document. 

Multipage Automatic 

Similar to Multipage Prompt for Pages, this workflow also 
allows you to continue reading from your current location 
and acquire new pages that are appended to the end of the 
document. However, instead of opening a dialog box 
prompting you for an action to perform after each acquisition, 
OpenBook uses the feed from a document feeder, a timer, or 
the motion detection with the PEARL camera to continually 
add pages until commanded to stop. Using the timer lets you 
specify how long OpenBook pauses between acquisitions.  

Pressing ESC will stop the acquisition process and open the 
Multipage Image Acquisition Dialog box (described above), 
where you can select an action. For example, if you are 
using PEARL to acquire a book whose facing pages are too 
large to both fit under the camera, you could capture all the 
odd numbered pages first by going front to back, press ESC 
to bring up the Multipage Image Acquisition dialog box, slide 
the book so the even numberd pages are under the camera, 
choose Turn Pages Over, then capture the even pages 
going back to front. If you are using a scanner as the 
acquisition source and the Allow scanner to finish when 
canceling a scan check box is checked (see Acquiring and 
Processing, Setting the Acquisition Device), the Multipage 
Image Acquisition dialog box will not open until the scanner 
has completed the scan.  
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Poetry and Recipe 

This workflow is similar to the Acquire and Read workflow in 
that it acquires a single page and automatically begins 
reading. However, this workflow retains all line-breaks where 
they appear in the actual text so it reads more like the 
original document. 

Specialty Workflows 

A specialty workflow is a workflow that is only used when 
you perform a specific task, such as when opening a PDF 
file, or acquiring a page into Microsoft Word. When you 
choose to perform one of these specialized tasks, OpenBook 
will use the settings from the specific specialty workflow 
instead of the currently active factory or custom workflow. In 
the list of workflows, specialty workflows are indicated by 
“(specialty)” following the workflow name. 

Specialty workflows cannot be renamed or deleted, however, 
they can be modified to suit your needs. 

The following Specialty Workflows are available: 

Acquire from Word 

When OpenBook is installed, it adds an Acquire Using 
OpenBook option to the File menu in Microsoft Word. 
Selecting this option causes OpenBook to acquire a page 
from the scanner or camera, OCR the text, and display the 
resulting text in Word. 

Freedom Import Printer 
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The Freedom Import Printer is used in OpenBook to provide 
OCR access to documents which either consist of images 
only or cannot be read by a screen reader in their native 
application. You can initiate the Freedom Import Printer by 
opening a document through the Select a File to Open dialog 
box which is not natively supported in OpenBook, or by 
printing the document from its native application and 
choosing Freedom Import Printer as the printer. You can 
only modify process settings for this specialty workflow. For 
more information, refer to Managing Files, Opening Files 
with the Freedom Import Printer.    

Recognize Image File 

This specialty workflow attempts to OCR image files opened 
from the Select a File to Open dialog box. If OpenBook is 
unable to process the particular image file, you are asked if 
you want to use the Freedom Import Printer instead. If you 
choose Yes, OpenBook switches to the Freedom Import 
Printer specialty workflow and resumes processing. 
Selecting No cancels the recognition and the file is not 
opened. You can only modify process settings for this 
specialty workflow. 

PDF File 

This specialty workflow is used when you choose to open a 
PDF file through the Select a File to Open dialog box. If 
OpenBook is unable to process the particular file, you are 
asked if you want to use the Freedom Import Printer instead. 
If you choose Yes, OpenBook switches to the Freedom 
Import Printer specialty workflow and resumes processing. 
Selecting No cancels the recognition and the PDF file is not 
opened. You can only modify process settings for this 
specialty workflow. 
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Workflow Settings 

Workflows consist of two types of settings, acquisition and 
processing.  

You can access the settings for a workflow by opening the 
Workflow Settings properties page (ALT+G, O), choosing a 
workflow from the list, and then selecting the Modify or 
Create New button. If you choose Modify, the Workflow 
Multipage dialog box opens. Otherwise, selecting Create 
New opens the Create New Workflow wizard which guides 
you through creating a custom workflow using the settings 
from the currently selected workflow as a starting point. 

Acquire Page 

The settings on the acquire page control how the workflow 
acquires images and where the page is placed in the 
document. These options are described below. 

Acquisition Mode 

This combo box lets you specify whether OpenBook 
acquires one or more pages when you press the acquire 
keystroke. 

Your choices are: 

• Single - OpenBook acquires one page from the 
scanner or camera, processes it, and begins reading. 
To acquire another page, you will need to press the 
acquire keystroke again. 

• Multiple - Lets you acquire a batch of pages for later 
processing. Some additional options become available 
when this mode is selected. 
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Single page acquisition mode is the default setting for all 
workflows except Multipage Prompt for Pages and Multipage 
Automatic. 

If you are modifying the Acquire from Word specialty 
workflow, this option is not available. You can only acquire 
pages one at a time into Microsoft Word. 

Color Mode 

This combo box contains the following color modes: 

• Color - Acquires and recognizes pages of colored text, 
art, and photographs in color. The results of Color 
Scanning are only apparent while you are in Exact View  
(CTRL+SHIFT+V). For this reason you must have Keep 
Exact View enabled in the workflow you want to use for 
acquiring pages in color. If you do not have a color 
scanner installed, OpenBook will tell you that acquiring 
in color is not possible and will acquire in black and 
white. 

• Gray Scale - Select this item if you do not need to have 
the Exact View image in color, or you do not intend to 
keep the Exact View image after OCR. 

Resolution 

Resolution is measured in dots per inch (dpi). The higher the 
resolution, the more dots per inch resulting in larger image 
files. The Resolution combo box allows you to select from 
200, 300, 400, 500, or 600 dpi. 
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Many scanners have a standard setting of 300 dots per inch 
(dpi). However, if you are reading pages printed in very small 
type and have a scanner that can resolve as finely as 400 
dpi, you may see improved recognition accuracy. For 400 
dpi to be effective, your scanner must have an optical 
resolution of at least 400 by 400 dpi. An optical resolution of 
300 by 600 dpi is not adequate.  

This setting is ignored if the acquisition source is the PEARL 
camera. 

Full Device Length 

When this check box is checked, OpenBook acquires the full 
length of the scanner bed, or the entire field of view under 
the PEARL camera (9 inches by 12 inches). If you uncheck 
this option, you can then specify how much of the scanner 
bed is scanned or how much of the area under the camera is 
captured. This item is checked by default in all factory 
workflows except the Mail Sorter Preview.  

Partial Acquisition 

Available only when the Full Device Length check box is 
unchecked, this slider control allows you to specify how 
much of the scanner bed, or how much of the area under the 
PEARL, is acquired starting from the top. You can set it any 
where between 10 and 90 percent. This setting is useful if 
you want a preview – OpenBook will acquire just enough of 
the page for you to get an idea of the content. 

Contrast 

If you are using a scanner to acquire images, these options 
control the light-to-dark contrast ratio in the acquired 
document. 
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Select the Automatic Contrast check box to have OpenBook 
automatically adjust the contrast accordingly depending on 
the type of page being acquired. If this option is unchecked, 
you can then use the contrast slider to manually adjust the 
contrast from 0 to 16. Lower numbers make it darker while 
higher numbers make it lighter. Setting it to 8 is considered 
normal contrast. You should only manually change the 
contrast if a particular page is not being recognized correctly 
on automatic contrast. 

If the acquisition source is the PEARL camera, the contrast 
settings are ignored. 

Scan Initiated 

If you are using a scanner to acquire pages and this check 
box is checked, OpenBook will announce “scan initiated” 
when you start a scan. Uncheck this option if you do not 
want to hear this message in a particular workflow. This 
option is ignored if the PEARL camera is selected as the 
acquisition source. 

Acquisition Tones 

When this check box is checked, OpenBook plays tones 
during the acquisition process. Uncheck this option if you do 
not want to hear acquisition tones in a particular workflow. 

Image Acquired 

When this check box is checked, OpenBook plays a camera 
shutter sound when an image is acquired. Uncheck this 
option if you do not want to hear this sound in a particular 
workflow. 
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Page Placement 

Use this combo box to specify where in the document 
OpenBook places the acquired page. Your  

choices are: 

• Append to Document – New page(s) are placed at the 
end of the document. 

• Insert After Current Page - New page(s) are inserted 
consecutively after the current page. 

• Insert Before Current Page - New page(s) are 
inserted before the current page. 

• Replace Current Page - The current page is replaced 
with the newly acquired page. 

Multipage Acquisition 

If you set the Acquisition mode to Multiple, several options 
become available which allow you to specify how OpenBook 
acquires multiple pages. 

Selecting the Prompt for Pages radio button opens a dialog 
box after each image acquisition. You can choose to acquire 
another page, turn pages over to acquire odd/even pages, or 
finish acquiring. For more information on this dialog box, see 
the description of the Multipage Prompt for Pages factory 
workflow. 

Select the Automatic radio button to have OpenBook acquire 
new pages after a certain period of time, automatically 
through a document feeder attached to a scanner, or as 
soon as PEARL detects the page has been turned and there 
is no more movement from the item under the camera. 
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Once automatic acquisition is enabled, use the Page 
Acquisition Delay spin box to set a time delay from 0 to 25 
seconds. This delay is from the time the image is acquired 
until the next acquisition begins. For example, if you do not 
use a document feeder with your scanner and you need to 
manually change pages, you might set the delay to 10, 
which would give you 10 seconds to place the new page on 
the scanner before OpenBook attempts to acquire the next 
image. 

If you are using the camera and the delay is set to 0, the 
camera uses motion detection to determine when the page 
is perfectly still before capturing an image. This means that if 
you are trying to position a page under the camera, or 
flipping pages in a book, the camera will not take a picture 
until it detects no movement from the item placed under it. 
Make sure to move slowly but purposefully when positioning 
a page under the camera. This helps to prevent PEARL from 
inadvertently taking a picture before the page is properly 
positioned. Do not make any sudden, abrupt movements 
once the page is in place. 

If your scanner has a duplexer, you can Enable the Duplex 
Mode check box to use this feature. This option is 
unchecked by default in all factory workflows. 

Process Page 

The settings on the Process page control how text is 
recognized and where the reading cursor is positioned. 
These options are described below. 
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Use Default Recognition 

When this check box is checked, the workflow will use the 
default recognition strategy, primary language, and 
secondary language options that are selected in the main 
Workflow Settings properties page. This is the default setting 
for all workflows. If you uncheck this item, you can then 
configure a different recognition strategy, primary language, 
or secondary language for the currently selected workflow. 

For example, if the default recognition strategy is set to 
Balanced, all workflows will use this strategy when 
recognizing text. However, you might want to configure a 
particular workflow to use the Most Accurate strategy 
instead. To do this, you would either create a new workflow, 
or modify an existing workflow, uncheck the Use Default 
Recognition check box from the Process page, then choose 
the Most Accurate strategy. This change would only affect 
the current workflow. 

Keep Exact View 

When this check box is checked, the original image is kept 
as part of each page after recognition. Unchecking this 
option discards the original image once recognition is 
complete. Keep Exact View must be enabled if you want to 
use the Re-recognize feature. 

To see the original document image, press CTRL+SHIFT+V 
to switch to Exact View or Split View. 
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Announce Orientation 

Enable this check box to have OpenBook announce the 
orientation of the page being acquired. The orientation is 
only announced as long as OpenBook is not currently 
reading. While OpenBook will automatically orient the page 
correctly during processing, announcing the orientation is 
helpful if you are sorting pages and you want to make sure 
they are all oriented correctly. You would not want to have 
some pages right side up and others upside down. 

Despeckle 

Select this check box to correct a page that does not have a 
clean, clear background, such as paper that has been 
photocopied several times, newspapers, or paper with 
speckled shading on it. 

Discard Blank Pages 

Enable this check box if you want OpenBook to throw away 
acquired pages that are blank. Note that sometimes you will 
want to keep blank pages so that you can maintain the 
original page numbering and order. When using the Re-
recognize feature, blank pages are included even when this 
option is enabled. Blank pages are only discarded during 
page acquisition. 

Apply OCR Corrections 

When this check box is enabled, OpenBook automatically 
applies OCR corrections to words that are not recognized 
properly by the recognition engine. For more information, 
see Editing, OCR Correction. 
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Keep Text Emphasis 

When this check box is enabled, OpenBook keeps attributes 
such as bold and italics, during OCR. 

Replace Uncertain Text 

This check box determines whether or not OpenBook 
identifies text that is not recognized correctly. If you check 
the box, you can then enter one or more characters into the 
Uncertain Text Marker edit field which OpenBook will insert 
into the document in place of the unrecognized text. By 
default, OpenBook will use the asterisk (*) symbol to identify 
uncertain text. 

Preserve Line Breaks 

This check box allows you to specify if OpenBook keeps line 
breaks or not during recognition. You may want to enable 
this option if you are acquiring a document where retaining 
the line breaks where they actually appear in the original text 
can improve the flow when reading. This setting is off by 
default in all workflows except for the Poetry and Recipe 
workflow. 

Recognizing Columns 

This group of radio buttons allows you to enable or disable 
column recognition. 

Select the Recognize Columns radio button if you are 
acquiring documents where the text is laid out in columns, 
such as a magazine or newspaper article, and you want to 
preserve the column information. 

Select Ignore Columns if you do not care about preserving 
the column layout, or the information in the document is not 
presented in columns. 
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You can also temporarily change this setting by opening the 
Acquire menu and choosing Recognize Columns. 

If the Preserve Line Breaks check box is checked in the 
current workflow and you are acquiring a page containing 
columns, if Recognize Columns is enabled, line breaks are 
preserved for each column. If OpenBook is set to ignore 
columns, line breaks are only preserved after the right most 
column. 

Split Facing Pages 

Enabling this check box splits the pages of a folded out book 
into two separate pages. This also splits the exact view into 
two separate images. When this option is checked, the Turn 
Pages Over item is not available when acquiring multiple 
pages. 

You can also change this setting temporarily by opening the 
Acquire menu and choosing Split Facing Pages. 

Table Processing 

This group of radio buttons configures how OpenBook 
processes documents containing tables, such as financial or 
statistical information. Tables can be organized either by row 
or column. 

Select Organize by Row to have OpenBook lay the text of 
the table out as rows with space between the column items. 

Select Organize by Column to have OpenBook lay the text of 
the table out as columns with space between the row items. 

Action When Pages are Recognized 

This group of radio buttons controls where the reading 
cursor is positioned after a new page is recognized. 
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Selecting Move to New Page moves the cursor to the top of 
the newly recognized page and begins reading. If you want 
to be able to continue reading at your current position in the 
document even after the new page is added, select Remain 
at Current Reading Position. 

Start Speaking Automatically 

This check box specifies whether OpenBook automatically 
begins speaking or not when the first acquired image is 
recognized. When checked, OpenBook automatically begins 
reading from the top of the newly acquired page as soon as 
text becomes available. If OpenBook is currently not reading 
when the first page of a new acquisition is added to a 
document, and the particular workflow is configured to 
remain at the current position, you will be moved to the top 
of the newly acquired page where OpenBook will 
automatically begin reading. Uncheck this option if you do 
not want OpenBook to automatically begin reading when a 
new image is recognized. In this case, you will need to use 
OpenBook’s reading commands or begin a Say All 
(INSERT+DOWN ARROW) in order to read the text. 

By default, this check box is enabled for all workflows except 
for Acquire in Background and Multipage – Prompt for 
Pages.  
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Creating a Workflow 

While many users may be satisfied using the workflows 
included with OpenBook, you can create your own custom 
workflows to achieve the best results possible when 
processing the material you need to access. You can create 
as many workflows as you want using any combination of 
settings. For example, you may like the settings in the 
Acquire and Read workflow, but you need to recognize text 
in another language. Or, when acquiring a book, you may 
want to change the delay for automatic page acquisition, 
keep any blank pages, and turn off column recognition. The 
possibilities are endless. 

To create a new workflow, do the following: 

1. Press ALT+G or click on the Settings Menu. Then 
press O or select Workflow Settings to open the 
Workflow Settings Properties page. 

2. Navigate through the Workflow Name list to any factory 
or custom workflow on which you want to base your 
new customized workflow. 

3. Press TAB or ALT+N to move to the Create New 
button and press ENTER. This button is not available if 
the workflow selected in the list is a specialty workflow. 

4. The Create New Workflow wizard opens on the Acquire 
page which contains the settings that determine how 
the workflow acquires images from the scanner or 
camera. By default, this page uses the settings from the 
currently selected workflow. Press TAB to move 
through the various controls on this page and select the 
acquisition settings you want to change for your custom 
workflow. When finished, choose Next to go to the 
Process page. 
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5. On the Process page, configure the settings this 
workflow will use when recognizing text and where the 
reading cursor is positioned after the new page is 
added to the document. As with the Acquire page, this 
page uses the settings from the currently selected 
workflow.  

6. Choose Finish and the Workflow Name dialog box 
opens. Type a name for your new workflow then press 
ENTER. The new workflow will now appear in the list of 
workflows. 

7. If you are done, select OK to close the Workflow 
Settings properties page. 

Each custom workflow you create is saved in the OpenBook 
9.0\Users\Default\Settings\Workflows folder as an INI file 
which can be copied and shared with other OpenBook 9 
users if desired. For example, if you created a custom 
workflow called Book-SplitPage, it would be saved as 
c:\program files\Freedom Scientific\OpenBook 
9.0\Users\Default\settings\Workflows\Book-SplitPage.ini. If 
you are in an environment where OpenBook is installed on 
more than one computer and you want other users to have 
access to this workflow, instead of manually configuring the 
workflow on each computer, you could simply copy Book-
SplitPage.ini, or any other custom workflows you want to 
share to a USB flash drive, then drop them into the 
Workflows folder on each computer running OpenBook. 
When you open the Workflow Settings properties page, the 
custom workflow you just copied will appear in the list of 
workflows. Custom workflow INI files can even be added 
while OpenBook is currently running. 
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Setting the Active Workflow 

When ever you begin a new image acquisition, either 
through the Acquire menu (ALT+Q), or by pressing the 
acquire hotkey, OpenBook uses the settings from the 
currently active workflow to acquire the image and recognize 
the text. You can use one of the two procedures below to set 
the active workflow. 

To set the active workflow using the menus, do the following: 

1. Press ALT+Q to open the Acquire menu, or press the 
APPLICATIONS key to open the context menu. 

2. Select Workflow to open the Workflow submenu. 

3. Press UP or DOWN ARROW to select the workflow you 
want to use and press ENTER. The active workflow is 
always indicated by a check mark. 

4. If you want to make this workflow the active workflow 
each time you start OpenBook, open the Settings menu 
(ALT+G) and choose Save the Settings (S). When the 
Save Settings dialog box opens, press ENTER to make 
this change part of the default settings. For more 
information on this feature, please see the book, Using 
Settings Files. 

To set the active workflow through the Workflow Settings 
properties page, do the following: 

1. Press ALT+G or click on the Settings menu. Then 
press O or select Workflow Settings to open the 
Workflow Settings properties page. 
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2. From the list of workflows, choose the workflow you 
want to use then activate the Set as Current button. 
This button is not available if the workflow selected in 
the list is a specialty workflow, or is already set as the 
active workflow. 

Note:  The workflow that is currently active will be selected 
when the Workflow list box first opens and is indicated 
by “current” following the workflow name. 

3. Select OK to close the Workflow Settings properties 
page. 

Now, the next time you acquire an image, the settings for the 
workflow you selected are used. 

Modifying a Workflow 

To change the settings for a factory, specialty, or custom 
workflow, do the following: 

1. Press ALT+G or click on the Settings menu. Then 
press O or select Workflow Settings to open the 
Workflow Settings properties page. 

2. From the list of workflows, select the workflow whose 
settings you want to modify, then activate the Modify 
button. 

Note:  The workflow that is currently active will be selected 
when the Workflow list box first opens and is indicated 
by “current” following the workflow name. 

3. Once the Workflow Properties multipage dialog box 
opens, make any desired changes, then choose OK. 
Use CTRL+TAB to move between the Acquire and 
Process pages, and use TAB to move through the 
controls on each page.  
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4. Select OK to close the Workflow Settings properties 
page. 

If you made changes to the currently active workflow, the 
new settings will be used the next time you acquire an 
image. 

If you modified a factory workflow, OpenBook displays 
“modified” after the workflow name in the list. For instance, 
“Acquire and Read – modified.” A modified specialty 
workflow will display “(specialty) – modified” after the 
workflow name, such as “PDF File (specialty) – modified.” 

Note:  If you choose to modify one of the specialty workflows, 
you can only change acquisition settings for the Acquire 
from Word specialty workflow. For the Freedom Import 
Printer, Image File, and PDF File specialty workflows, 
only the Process page is available. 

Renaming a Custom Workflow 

If you would like to rename a custom workflow you created, 
do the following: 

1. Press ALT+G or click on the Settings menu. Then 
press O or select Workflow Settings to open the 
Workflow Settings properties page. 

2. From the list of workflows, select the workflow you want 
to rename, then activate the Rename button. This 
button is not available if the workflow selected in the list 
is a factory or specialty workflow. 

Note:  The workflow that is currently active will be selected 
when the Workflow list box first opens and is indicated 
by “current” following the workflow name. 
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3. When the Workflow Name dialog box opens, type a 
new name for the Workflow and press ENTER. 

4. Select OK to close the Workflow Settings properties 
page. 

Deleting a Custom Workflow 

To delete a workflow you created, do the following: 

1. Press ALT+G or click on the Settings menu. Then 
press O or select Workflow Settings to open the 
Workflow Settings properties page. 

2. From the list of workflows, select the workflow you want 
to delete, then activate the Remove button. This button 
is not available if the workflow selected in the list is a 
factory or specialty workflow, or if the custom workflow 
you want to delete is still set as the active workflow. If 
the custom workflow you want to delete is active, set a 
different workflow as the active workflow and you will 
then be able to delete the particular custom workflow. 

Note:  The workflow that is currently active will be selected 
when the Workflow list box first opens and is indicated 
by “current” following the workflow name. 

3. A dialog box opens asking if you are sure you want to 
delete the workflow. Choose OK if you are sure you 
want to delete the selected workflow. Otherwise, 
choose Cancel. 

4. Select OK to close the Workflow Settings properties 
page. 

Note:  Never attempt to remove a custom workflow by deleting 
the INI file. To delete a custom workflow, always use 
the Remove button on the Workflow Settings properties 
page. 
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Resetting a Factory Workflow 

To restore a modified factory workflow to its default settings, 
do the following: 

1. Press ALT+G or click on the Settings menu. Then 
press O or select Workflow Settings to open the 
Workflow Settings properties page. 

2. From the list of workflows, select the workflow you want 
to reset, then activate the Restore Factory Values 
button. This button is only available if the selected 
workflow has “modified” following the workflow name. 

Note:  The workflow that is currently active will be selected 
when the Workflow list box first opens and is indicated 
by “current” following the workflow name. 

3. Select OK to close the Workflow Settings properties 
page. 
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Book 9 

Reading  

Reading with OpenBook 

Whenever you acquire a document, if the currently active 
workflow is configured to start speaking automatically, 
OpenBook immediately begins reading aloud as soon as 
there is recognized text. When you open a saved document, 
the cursor is placed at the beginning of the file or at the last 
position if the file is an OBX or ARK document, and you must 
use OpenBook’s extensive selection of reading commands 
to read the text. 

When reading a document, you can choose to read by 
character, word, line, sentence, paragraph, or the entire 
document at once. As OpenBook reads, it highlights each 
word on the screen. This highlighting, referred to as the text 
spotlight, helps partially sighted users visually track cursor 
movement while OpenBook reads the text. All reading 
commands with exception of reading the next or previous 
character work whether you are in Read-only or Edit mode. 

To read by character, press LEFT or RIGHT ARROW for the 
previous or next character or NUM PAD 5 to read the current 
character. 

Note:   You can only read by character when in Edit mode 
(CTRL+E). Pressing LEFT or RIGHT ARROW in Read-
only mode reads by word instead. 
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To read by word, press CTRL+LEFT or CTRL+RIGHT 
ARROW for the previous or next word or INSERT+NUM 
PAD 5 to read the current word. Press INSERT+NUM PAD 5 
twice to have OpenBook spell the current word or three 
times to spell the word phonetically. For example, the word 
cab is spelled as Charlie, Alpha, Bravo, etc. You can also 
use INSERT+NUM PAD 5 in menus or dialog boxes to read 
the current dialog box control or menu item. 

To read by line, press UP or DOWN ARROW for the 
previous or next line or press INSERT+UP ARROW to read 
the current line. You can also use INSERT+UP ARROW in 
menus and dialog boxes to read the current menu item or 
dialog box control. 

To read by sentence, press ALT+UP or ALT+DOWN 
ARROW for the previous or next sentence or press 
ALT+NUM PAD 5 to read the current sentence. 

To read by paragraph, press CTRL+UP or CTRL+DOWN 
ARROW for the previous or next paragraph or press 
CTRL+NUM PAD 5 to read the current paragraph. 

Note: When using CTRL+NUM PAD 5, the spotlight remains on 
the current word and does not highlight each word as 
OpenBook reads the current paragraph. 

As you navigate through documents using the various 
reading commands, press CTRL+SHIFT+F12 to obtain 
Where Am I information. OpenBook speaks the name of the 
currently open document as well as the line number of the 
current page where the cursor is located. This command 
also works in dialog boxes and tells you the name of the 
open dialog box and the currently selected control. 
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For a complete list of keystrokes, refer to the keystroke lists 
at the end of this manual. 

Reading Using Say All 

In a Say All, OpenBook begins reading at the cursor location 
and continues through the rest of the document. If you want 
OpenBook to read an entire document, make sure you 
position the cursor at the top of the file before starting the 
Say All. 

When you acquire a document and the currently active 
workflow is configured to start speaking automatically, 
OpenBook begins reading using Say All. To start a Say All in 
a document you have opened, or if the currently active 
workflow is not set to speak automatically when a page is 
acquired, press INSERT+DOWN ARROW. Use 
ALT+CTRL+PAGE DOWN to decrease the reading speed 
or ALT+CTRL+PAGE UP to increase the reading speed. To 
stop reading, press CTRL or ESC. 

Fast Forward and Rewind 

With OpenBook, you can move quickly through a document 
using the Fast Forward or Rewind functions. To fast forward 
or rewind, you must be reading with the Say All command 
(INSERT+DOWN ARROW) or be skim reading using the 
CTRL+INSERT+DOWN ARROW command. To fast 
forward, press the RIGHT SHIFT or the RIGHT ARROW 
key. To rewind, press the LEFT SHIFT or the LEFT ARROW 
key. If you press the rewind command continuously to move 
backwards through a document, you are moved to the prior 
sentence. 
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Both sets of commands work equally well. However, if you 
use Windows Sticky Keys, then you should use the ARROW 
keys. Otherwise, you must uncheck the Disable Sticky Key 
Hotkey Toggle check box and check the Enable Shift Keys 
For Fast Forward and Rewind check box in the Keyboard 
Settings Properties page in order to use the SHIFT keys.  

To disable Sticky Keys and enable Shift keys for fast forward 
and rewind. 

1. Press ALT+G or click on the Settings Menu. 

2. Press K or select Keyboard Settings to open the 
Keyboard Settings properties page.  

3. Next, press TAB until you hear, “Disable Sticky Key 
Hotkey Toggle check box.” 

4. Press the SPACEBAR to uncheck the box.  

5. Press TAB to move to the Enable Shift Keys For Fast 
Forward and Rewind check box. 

6. Press the SPACEBAR to check the box.   

7. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Skim Read 

If you need to quickly understand the main idea of a 
paragraph, you will find the Skim Read feature useful. Skim 
Read lets you read the first and/or last sentence of each 
paragraph in the document. To use the Skim Read feature, 
press CTRL+INSERT+DOWN ARROW. To stop Skim Read, 
press CTRL or ESC. 
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To change what is read when you use the Skim Read 
feature, follow these steps. 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Next, press TAB until you hear, “Skim Read Speaks 
Paragraph combo box” or press ALT+M. 

4. Use the UP or DOWN ARROW keys to make your 
selection.  

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Movement Unit  

You can determine how much text is spotlighted by changing 
the spotlight movement unit. Your choices are word, 
sentence, line, or paragraph.  

To change the Movement Unit for the spotlight: 

1. Press ALT+G or click on the Settings Menu. 

2. Press V or select Visual Settings to open the Visual 
Settings Properties page.  

3. Press ALT+O or click in the Spotlight Movement Unit 
combo box. 

4. When you choose the unit you want to read with, 
OpenBook displays the spotlight in the sample text near 
the bottom of the properties page. 

5. Press the Ok button to exit this properties page. 
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Dictionary 

You can look up a word’s definition by selecting the word 
with either the mouse or the SHIFT+ARROW keys, then 
pressing CTRL+D or F8. When you select Dictionary, the 
Dictionary dialog box opens, announces the selected word to 
be defined, and begins reading the definition. At this point, 
you have several controls from which to choose. Use the 
TAB key to move to the particular option you want.  

The Definition view displays the definition of the selected 
word. You can use the ARROW keys to read the contents. 
This field cannot be modified. While reading the definition, 
press ENTER or use the mouse to click on any word in the 
main definition to bring up the definition for that particular 
word. 

Select the Show Expanded Definition check box to show the 
full definition of the word, including unusual definitions. For 
example, try the word “skin.” When the Show Expanded 
Definition check box is checked, the expressions “by the skin 
of one’s teeth” and “have a thin skin” are included in the 
definition view. When unchecked, which is the default 
setting, this additional information is not displayed. 

Selecting the Switch to Thesaurus button opens the 
Thesaurus and displays any synonyms for the selected 
word. 

If you have displayed additional definitions by selecting 
words from the definition view or entering words into the 
Word edit field, select the Previous Look-up button to return 
to the prior definition or the Next Look-up button to go to the 
next definition.  
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The Word edit field displays the currently selected word. You 
can view the definition for another word by typing it into this 
field and pressing ENTER. The definition of the new word is 
displayed in the Definition view. 

Select the Read Word button to have OpenBook announce 
the word currently being defined. 

When you are finished, select the Close button to close the 
Dictionary and return to your document. 

Pronunciation Dictionary 

The Pronunciation Dictionary lets you correct how 
OpenBook pronounces a particular word or combination of 
letters. 

Using the Pronunciation Dictionary: 

1. From the Advanced Menu, select Pronunciation 
Dictionary (ALT+A, N).  

2. When the Pronunciation Dictionary dialog box opens, 
your cursor is in an edit field. Type the word that is mis-
pronounced. Do not use any spaces and/or punctuation 
as you type.  

3. Press TAB to move to the Pronunciation edit box. Type 
how the word is pronounced. Pronunciations can 
include spaces as this helps with stressing the correct 
syllable and with the pronunciation of vowels.  

4. Next, press ALT+L to move to the field containing the 
list of all the words in the pronunciation dictionary. 
Press the DOWN ARROW key or the first letter of the 
mispronounced word to move to the word in the list.  



 

 

104 

5. If the word is case sensitive, TAB to the Case Sensitive 
check box and press the SPACEBAR to place a check 
in the box. For example, you might want OpenBook to 
pronounce the text string "pa" as the word "pa" when 
the letters are not capitalized, but to say the individual 
letters, "P" "A", when they are capitalized. You would 
type the upper-case letters "PA" in the Word field, type 
the letters "P" and "A" (upper- or lower-case) in the 
Pronunciation field, and check the Case Sensitive box. 

6. Press ALT+T to hear the original word and the 
replacement word. You can use the Test button to test 
a word and its correction before you add it to the list.  

7. Press ALT+A to add the word and its pronunciation to 
the word list.  

8. Press ALT+D to delete a word and its pronunciation 
from the word list.  

9. Press ALT+P to have OpenBook apply the 
pronunciation to the open document.  

10. Press ALT+C to close the Pronunciation Dictionary 
dialog box and return to your document. 

Thesaurus 

You can look up a word's synonym or antonym by selecting 
a word with either the mouse or the SHIFT+ARROW keys, 
then pressing CTRL+T. When you select Thesaurus, 
OpenBook opens the Thesaurus dialog box, announces the 
selected word, lists the synonyms, and begins reading the 
list of synonyms in the Synonyms field. At this point, you 
have several controls from which to choose. Use the TAB 
key to move to the particular option you want.  
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Note:  If the selected word has no synonyms available, 
OpenBook will say “no synonyms found: when you 
attempt to open the Thesaurus. Select OK to return to 
the document and select another word. 

The Synonym view displays the Synonyms of the selected 
word. You can use the ARROW keys to read the contents. 
This field cannot be modified. While reading the list of 
synonyms, press ENTER or use the mouse to click on any 
word in the main synonym list to list synonyms for that 
particular word. 

Selecting the Switch to Dictionary button opens the 
Dictionary and displays the definition for the selected word. 

If you have displayed additional lists of synonyms by 
selecting words from the Synonym view or entering words 
into the Word edit field, select the Previous Look-up button 
to return to the prior synonym list or the Next Look-up button 
to go to the next synonym list.  

The Word edit field displays the currently selected word. You 
can view the synonyms for another word by typing it into this 
field and pressing ENTER. The synonyms for the new word 
are displayed in the Synonym view. 

Select the Read Word button to have OpenBook announce 
the currently selected word. 

When you are finished, select the Close button to close the 
Thesaurus and return to your document. 
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Indicate Emphasis Text 

When enabled, the emphasis voice will speak Bold, Italics, 
or Underlined text in a document when reading using the 
Say All function (see Reading, Reading Using Say All). 
Additionally, the chosen emphasis voice will speak rows of 
symbols of four or more (such as ----- or *****, etc) during 
both a Say All and when arrowing through text. 

When disabled, the emphasis voice will only speak rows of 
symbols of four or more (such as ----- or *****, etc) during 
both a Say All and when arrowing through text. This option is 
disabled by default. 

To enable Emphasis Text: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page. 

3. Press TAB until you hear, “Indicate Emphasis Text.” 

4. Press the SPACEBAR to check the box.  

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Extra Pause After Each Line 

If you need extra time to absorb the information that you are 
reading during a Say All with OpenBook, then adding an 
extra pause after each line may be helpful.  

To adjust how long OpenBook pauses at the end of each 
line, do the following:  

1. Press ALT+G or click on the Settings Menu. 
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2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Next, press TAB until you hear, “Extra Pause After 
Each Line combo box” or press ALT+X. 

4. Use the UP or DOWN ARROW keys to make your 
selection. The default setting is No extra pause. 

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Hide Spotlight for Braille Tracking 

For those who read using a refreshable Braille display, this 
item should be activated because the text spotlight 
decreases the responsiveness of refreshable Braille devices.  

To activate Hide Spotlight for Braille Tracking: 

1. Press ALT+G or click on the Settings Menu. 

2. Press V or select Visual Settings to open the Visual 
Settings properties page.  

3. Next, press TAB until you hear, “Hide Spotlight for 
Braille Tracking check box” or press ALT+H. 

4. If necessary, press the SPACEBAR to place a check in 
the box.  

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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Book 10 

Navigating Documents 

Go to Navigation 

The Go To dialog box allows you to move to the next or 
previous page, Bookmark, Highlight, or Comment in a 
document. To open this dialog box, press CTRL+G. 
Alternatively, you can press ALT+E or click on the Edit menu 
and choose Go To. 

In the Go to what list box, choose the element you want to 
navigate by - Page, Bookmark, Highlight, or Comment. Use 
TAB to move through the controls in this dialog box. 

If you choose Page, enter the page number you want to go 
to in the Page Number edit box and then activate the Go To 
button to move to it and close the dialog box. OpenBook will 
announce the page number along with the word that is 
currently spotlighted.  

If you choose Bookmark, in the Bookmark name combo box, 
use the UP or DOWN ARROW to locate the bookmark name 
and then activate the Go to button to move to it. OpenBook 
will announce the bookmark name along with its associated 
word. Activate the Close button to return to the document on 
the current bookmark. 
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If you choose Highlight, in the Highlight type combo box, use 
the UP or DOWN ARROW to select the highlight color and 
then activate the Next or Previous button to go to the text 
highlighted with the specified color. If you do not choose a 
highlight color, the Next and Previous buttons will move 
forward or backward through all highlights in the document. 
As you move to each highlight, OpenBook will announce the 
highlight color and read the highlighted text. OpenBook also 
announces when you reach the first or last highlight in the 
document. When you hear the one you want, activate the 
Close button to return to the document at the beginning of 
the current highlight. 

If you choose Comment, activate the Next or Previous button 
to move to the next or previous comment in the document. 
As you move through comments, OpenBook will speak the 
text of the comment. OpenBook also announces when you 
reach the first or last comment in the document. When you 
hear the one you want, activate the Close button to return to 
your document on the current comment. 

When you close the Go To dialog box, the last element that 
you moved to becomes the default. For example, if you 
moved by highlight, the next time you press CTRL+G to 
open the Go To dialog box, Highlight will be the default. If 
you then choose to move by Page, then Page will become 
the default. To quickly move to the next or previous selected 
element without opening the dialog box, pres F5 or 
SHIFT+F5. This command only works when moving by 
page, highlight, or comment. To go to another bookmark, 
open the Go To dialog box and select the name of the 
bookmark you want to go to. 
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Bookmarks 

OpenBook allows you to insert an unlimited amount of 
bookmarks anywhere in a document. Serving as 
placeholders, bookmarks let you easily locate information 
previously viewed. When you use the Bookmark feature, 
OpenBook inserts a bookmark at the current cursor position 
in the open document. Each bookmark is linked to the word 
at its right.  

Bookmarks are announced with the Emphasis Voice. Please 
refer to Emphasis Voice in the Book, Adjusting the Speech. 

You add, rename, delete, or go to specific bookmarks from 
the Bookmarks dialog box. 

When adding Bookmarks, first place your cursor in your 
document where you want to insert the bookmark. Then 
open the Bookmarks dialog box by pressing F9 and TAB to 
the Add button. Press SPACEBAR to open the Add 
Bookmark dialog box and type a name for your bookmark in 
the Bookmark Name edit box. Press ENTER to activate the 
Ok button and close the dialog box. 

To rename a bookmark, open the Bookmarks dialog box, 
use the UP or DOWN ARROW key to locate the bookmark 
in the list, and TAB to the Rename button. Press 
SPACEBAR to open the Rename Bookmark dialog box and 
type a new name for your bookmark in the Bookmark Name 
edit box. Press ENTER to activate the Ok button and close 
the dialog box. 
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To delete a bookmark, open the Bookmark dialog box, use 
the UP or DOWN ARROW key to locate the bookmark in the 
list, and TAB to the Delete button. Press SPACEBAR to 
open the Delete Bookmark dialog box. When asked to 
confirm the deletion, press ENTER to activate the Yes button 
or press TAB, then ENTER to activate the No button.  

Tip: Rather than use the delete button in the Bookmark 
dialog box, it is easier to place your cursor to the right 
of the Bookmark and press the BACKSPACE key or 
CTRL+SHIFT+F9.  

There are two ways to go to a specific bookmark. 

The first option is to press CTRL+G to open the Go To 
dialog box and select Bookmark from the Go to what list box. 
In the Bookmark name combo box, select the name of the 
bookmark you want to go to and activate the Go to button to 
move to it.  

The second option is to open the Bookmarks dialog box, use 
the UP or DOWN ARROW key to locate the bookmark in the 
list, and press ENTER to activate the Go To button.  

You may also change how your bookmarks are sorted. To 
do this, press the TAB key until you hear Sort by Name radio 
button. Next, use your UP or DOWN ARROW key to make 
your selection. Your choices are Sort by Name or Sort by 
Location. The Sort by Name radio button is selected by 
default each time you open the Bookmark dialog box. 

To have OpenBook announce each Bookmark while it is 
reading the document, you must go to the Speech Settings 
Properties page and place a check in the Announce 
Bookmarks check box.  

1. Press ALT+G or click on the Settings Menu. 
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2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Press TAB until you hear, “Announce Bookmarks check 
box.” 

4. Press the SPACEBAR to check the box.  

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Highlights 

OpenBook allows you to indicate important passages or key 
words in your document just as you would highlight text in a 
book.  

To highlight text in your document:  

1. Place your cursor at the beginning of the text you want 
to highlight or use the mouse or the standard text 
selection commands to select the text you want to 
highlight.  

2. Press ALT+T or click on the Tools menu. Then, select 
the Highlighter Color submenu and press ENTER or 
double click the color you want to use. 

3. Open the Tools menu again and choose Start Highlight. 
If text is selected, then this option will change to 
Highlight Selection. Alternatively, press CTRL+F11 to 
begin highlighting or ALT+F11 to highlight the selected 
text. 
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If you selected a block of text, then that block is highlighted 
using your chosen highlighter color. Otherwise, after you turn 
on highlighting, use the mouse or the standard navigation 
commands to move through your document. As you 
navigate, the text is highlighted using your chosen 
highlighter color. Additionally, OpenBook will say "highlight" 
as you move through the text so you know highlighting is 
enabled. When you are done highlighting, open the Tools 
menu again (ALT+T) and select Stop Highlight. Alternatively, 
press CTRL+F11 again to turn off highlighting. If you decide 
you do not want to apply the highlight to a particular section 
of text, press the ESC Key to cancel highlighting. 

To erase highlighting, position the cursor anywhere in the 
highlighted text. Then, open the Tools menu (ALT+T) and 
choose Remove Highlight. Alternatively, press 
CTRL+SHIFT+F11 to remove the highlight. 

To move quickly through the highlighted sections of a 
document, press F11 to move to the next highlight or 
SHIFT+F11 to move to the prior highlight. If you have 
chosen to navigate by a particular highlight color using the 
Go To dialog box (CTRL+G), press F5 or SHIF+F5 to move 
to the next or previous highlight. 

When you are located in a section of text that is highlighted, 
press ALT+CTRL+F11 to read the highlighted text. 

To send all highlights to a new blank document, press 
ALT+F or click on the File menu and select the Export 
Highlights submenu. The following choices are available: 
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• Sort by Color - Selecting this option causes all of the 
highlighted text to be sent to a new document based on 
the highlight color. This means that all of the green 
highlighted text appears first in the new document 
followed by the blue highlighted text and finally the 
magenta highlighted text. 

• In Document Order - Selecting this option causes all of 
the highlighted text to be sent to a new document 
exactly the way it appears in the current document. This 
means that if you have a green highlight followed by a 
blue highlight and then green again, this is the order 
they will appear in the new document. 

By default, OpenBook will announce the beginning and end 
of a highlighted section while reading the document. For 
example, when you reach the first word of a green 
highlighted section, you will hear "starting green highlight." 
When you reach the last green highlighted word, you will 
hear "ending green highlight." If you do not want to hear 
highlights while reading, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Press TAB until you hear, "Announce Highlights check 
box." 

4. Press the SPACEBAR to uncheck the box.  

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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Alternatively, press ALT+SHIFT+F11 to toggle the 
announcement of highlights on or off. 

Note:   Highlighting does not work when Masking is 
enabled. If you turn on Masking, all Highlight menu 
options are disabled and if you are currently highlighting 
text, the highlight is canceled and no text is highlighted. 
In addition, when masking is on, OpenBook will not 
announce highlighted text and default display and 
masking colors are displayed instead of the highlight 
colors. 

Comments 

OpenBook allows you to add comments to any location in 
your document. Teachers can create comments containing 
messages, questions, or assignments for students. Students 

can use comments to answer the teacher's questions, create 
reminders, or ask questions about the text they are reading. 

To add a comment to your document: 

1. Navigate to the location in your document where you 
want to insert the comment. 

2. Press ALT+E or click the Edit menu and select Insert 
Comment to open the Add Comment dialog box. 
Alternatively, press ALT+CTRL+M to open this dialog 
box. 

3. Enter the text of your comment into the edit box. You 
can also choose the Paste button or press CTRL+V to 
paste text from the clipboard. 

4. Press the Read button if you want OpenBook to read 
the comment back to you.  

5. When you have finished the comment, select OK. 
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If you have vision, you will see a comment icon where you 
added the comment. Double-click this icon to view or edit the 
comment. 

If you rely on speech feedback, OpenBook will announce 
each comment as you navigate the document with the arrow 
keys. For instance, when you reach the first comment, you 
will hear "comment 1," followed by "comment 2" for the 
second comment, and so on. To have OpenBook speak the 
text of a comment, press ALT+SHIFT+APOSTROPHE. To 
edit a comment, make sure you are first positioned on the 
comment. Then, press ALT+E to open the Edit menu and 
select Edit Comment. Alternatively, press ALT+ENTER. In 
the edit box, make your changes to the comment text and 
then press OK. To delete a comment, place your cursor on 
the comment and press SHIFT+DELETE. 

To move quickly through the comments in a document, 
press CTRL+G to open the Go To dialog box. In the Go to 
what list box, select Comments and then activate the Next or 
Previous button to move through your comments. When you 
hear the comment you want, activate the Close button to 
return to your document on the current comment. If 
comments is already the selected navigation option, press 
F5 or SHIFT+F5 from within the document to move to the 
next or previous comment. 

To send all comments to a new blank document, press 
ALT+F or click on the File menu and select Export 
Comments. All comments in the current document are 
pasted into a new untitled document which you can then 
save. Each comment is proceeded by a number and is 
separated by a blank line for easy navigation. 
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By default, OpenBook will announce comments while 
reading the document. If you do not want to hear comments 
while reading, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press P or select Speech Settings to open the Speech 
Settings properties page.  

3. Press TAB until you hear, "Announce Comments check 
box." 

4. Press the SPACEBAR to uncheck the box.  

5. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Find 

The Find feature is a very handy tool that lets you search for 
a word or phrase within an open document quickly. When 
you press CTRL+F, OpenBook launches the Find dialog box 
with the cursor in the Find What edit box. Type in the word or 
phrase you want to find. Use the TAB key to navigate the 
dialog box. Other controls in this dialog box that are 
available are Find Whole Words Only, Match Case, and 
Search Direction.  

When you are ready, press ENTER on the Find Next button. 
When OpenBook has found the word or phrase, press 
ENTER on the Read Sentence button. This reads the 
sentence that contains the words you are seeking.  
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Find and Replace Text  

The Find, Replace menu item (CTRL+H) is similar to the 
Find feature in that it searches for words or phrases within a 
document, but it has the additional feature of replacing 
words or phrases with alternative text. Its dialog box is 
similar to the Find dialog box but has two additional buttons. 
The Replace button, which replaces one instance of the 
word or phrase and the Replace All button, which replaces 
all instances of the word or phrase in the document.  
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Editing 

When you start OpenBook, you are in Read-only Mode by 
default. All of OpenBook’s editing features are only available 
in Edit Mode. To switch to Edit Mode press CTRL+E or if you 
prefer, change the default setting so that OpenBook always 
starts in Edit Mode. In Edit Mode you still retain all of your 
acquisition and processing features. 

To always start in Edit Mode: 

1. Press ALT+G or click on the Settings Menu. 

2. Press G or select General Settings to open the General 
Settings properties page.  

3. Press ALT+E or click on Always Start In Edit Mode to 
place a check in the box. 

4. Press ENTER or click OK to apply your changes and 
close this dialog box. 

5. Open the Settings Menu again (ALT+G) and choose 
Save the Settings (S). 

6. In the Save Settings dialog box, press ENTER to make 
the changes part of the default settings. For more 
information on this feature, please see the book, Using 
Settings Files. 

Note:  Edit Mode is only available in the Text View. To switch 
to Text View, press CTRL+SHIFT+V. 
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Basic Editing Commands 

While OpenBook is primarily used for acquiring and reading 
text, it does include most of the commonly used editing 
features associated with other popular word processing 
applications. You can find many of these features in the Edit 
Menu. 

Undo  

The Undo feature (CTRL+Z) is very handy for undoing the 
last command you performed. Unlike many word processing 
applications, this feature only reverts one command at a 
time. 

Cut  

To cut selected text from a document and copy it to the 
Microsoft Windows clipboard, press CTRL+X. To select text, 
hold the SHIFT key down while pressing the ARROW keys, 
or use the mouse to highlight the text.  

Copy 

Copying selected text places it on the clipboard without 
removing it from the document. Once you have selected the 
text you want to copy, press CTRL+C. You can then paste 
the text into another part of the open document, into a new 
OpenBook document, or into another application such as 
Microsoft Word.  
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Paste 

Choose Paste when you want to insert text from the 
Microsoft Windows clipboard into your document. Find the 
location where you want the text inserted, then press 
CTRL+V. The text is then inserted into the document.  

Delete 

Unlike cutting selected text from a document, deleting does 
not copy the text to the Microsoft Windows clipboard. Once 
you use the DEL key, the selected text is permanently 
deleted and cannot be pasted. Press CTRL+Z to undo the 
delete. 

Select All on Current Page  

This item selects all text in Read-only Mode and in Edit 
Mode. The shortcut key for Select All is CTRL+A.  

Renumber Pages  

This feature allows you to change the page numbers of an 
open document, as well as, maintain the original page 
numbering in an acquired document. 

To renumber pages: 

1. From the Edit Menu, select Renumber Pages or press 
ALT+E, A.  

2. OpenBook brings up the Renumber Pages dialog box 
and places your cursor in an edit field.  

3. OpenBook prompts you with the current page number 
and asks you for the new number you want to assign to 
that page. Type in a number, then press ENTER, or 
TAB to the Ok button.  
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4. You can cancel the operation at any time by going to 
the Cancel button or by pressing the ESC key. 

Be sure to give each succeeding page a new number larger 
than the page numbers before it. For example, you could 
have a 3-page document that you renumber as pages 10, 
20, and 30, but you can't renumber the pages as 20, 30, and 
10. If you type in a number that breaks this rule, OpenBook 
will prompt you to enter a valid number. 

You can revert back to OpenBook's original page numbering 
sequence at any time by checking the box called Revert to 
original page numbers. Press the SPACEBAR to check this 
box, then press ENTER.  

Insert Page Break  

When you need to insert a page break in your document, 
place your cursor on the line where you want the break to 
occur then press CTRL+ENTER. OpenBook inserts a page 
break immediately before the current line of the document. 
The text after the inserted page break becomes the 
beginning of the new page; the text before the inserted page 
break becomes the end of the previous page.  

Delete Page Break 

To use this feature, move your cursor to the bottom of the 
first of the two pages. Go to the Edit Menu (ALT+E). Use 
your UP or DOWN ARROW keys to move to the Delete 
Page Break menu item and press ENTER. Or you can 
simply press CTRL+SHIFT+DELETE from within the 
document.  
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Move Page  

When you need to move the current page to another location 
in a document select Move Page from the Edit Menu. 

To move a page: 

1. Press ALT+E, M to select the Move Page item. 

2. In the Move Page dialog box, use the TAB key to move 
about the different controls in the dialog box.  

3. To activate the button controls press the SPACEBAR. 
You can choose to move the current page up or down 
one page position, or to the top or bottom of the 
document. 

4. In the edit box, type the page number that you want to 
move the current page to. Or, type +2 or –2 to move 
forward or back 2 pages. Once OpenBook moves the 
page, it tells you the current page's new page number 
and the other pages in the document are renumbered 
to accommodate the moved page. 

Delete Current Page  

Select this menu item to delete the page your cursor is on. 
When you delete the current page, OpenBook opens a 
dialog box warning you that page deletion cannot be 
undone, and asks you to confirm the deletion. Alternatively, 
press CTRL+DELETE. 

Remove Headers and Footers  

Sometimes, it maybe helpful to remove the header and/or 
footers from your acquired documents especially when you 
are reading. 
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After you acquire a document containing headers and 
footers, you can then remove the headers, footers, or both. 
From the Edit Menu (ALT+E), choose Hide or Show 
Headers/Footers. Choose whether to remove the header, 
footer, or both by selecting the appropriate check boxes. 
Press ENTER to remove the headers/footers from the Text 
View and close the dialog box. This does not remove the 
headers/footers from the Exact View image. 

Spell Check  

You can check the spelling of a specific word, or of all the 
words in a document. If a word is spelled correctly, but not 
recognized, you can add the word(s) to OpenBook’s 
dictionary. In order for Spell Check to work you must be in 
Text View (CTRL+SHIFT+V). To check the spelling in a 
document, press F7. OpenBook verifies the spelling of each 
word by comparing them to its dictionary. 

Once the spell check is done, a dialog box opens and words 
that are not recognized or are identified as misspelled 
appear in the Word Not Found box. At this point, you have 
several options to choose from. Use the TAB key to navigate 
the dialog box and press ENTER on the control that 
performs the particular action you want. When you 
encounter a combo box, use the UP or DOWN ARROW 
keys to make your selection.   

Word Count  

Press ALT+T or click on the Tools menu and select Word 
Count when you want to know the number of words in a 
document. 
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OCR Correction 

Use the OCR Correction feature to correct any words that 
OpenBook's OCR engine does not correctly identify. 

To use OCR Correction follow, these steps:  

1. Press ALT+A, O to launch the OCR Correction dialog 
box.  

2. When the OCR Correction dialog box opens the Word 
list box is active. Type the first letter of the mis-
identified word then use your UP and DOWN ARROW 
keys to find the word.  

3. If the word is not found in the list, press the TAB key to 
move to the mis-identified word edit box and type in the 
word as it appears in the document. OpenBook's OCR 
Correction feature only recognizes for whole words and 
punctuation. Do not use spaces.  

4. Press TAB to move to the next edit box. In this field 
enter the word the way OpenBook should have 
recognized it. Corrections can include spaces.  

5. If the OCR correction is case sensitive, TAB to the 
Case Sensitive check box and press the SPACEBAR 
to place a check in the box. 

6. Press ALT+T to hear the original word and the 
replacement word. You can use the Test button to test 
a word and its correction before you add it to the list 
and for words already in the list.  

7. Press ALT+A to add the word and its correction to the 
word list.  

8. Press ALT+D to delete a word and its correction from 
the word list.  
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9. Press ALT+P to have OpenBook apply corrections from 
its list to the open document.  

10. Press ALT+C to close the OCR Correction dialog box 
and return to your document. 

By default in all workflows, OCR corrections are 
automatically applied to every document that you acquire. If 
you prefer to do this manually, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press O or select Workflow Settings to open the 
Workflow Settings properties page.  

3. When this properties page opens, the currently active 
workflow is selected. Activate the Modify button to open 
the Workflow Properties multi-page dialog box. 

4. Press CTRL+TAB to move to the Process page. 

5. Press TAB to move to the Apply OCR Corrections 
check box and press SPACEBAR to uncheck this 
option. 

6. Select OK to close the Workflow Properties multi-page 
dialog box and once more to close the Workflow 
Settings. 

Note:  You could also create a new custom workflow and turn 
off the Apply OCR Corrections option. You can then 
switch to this custom workflow when ever you do not 
want OCR corrections automatically applied to acquired 
documents. 

For more information on workflows, see the book, 
Workflows. 
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Managing Files  

Most of the routine tasks of managing and maintaining your 
document files can be accessed directly from the File Menu 
(ALT+F).  

If you sign in as an individual user, OpenBook uses 
C:\Program Files\Freedom 
Scientific\OpenBook\9.0\Users\default\Library as the default 
file location. 

If you have signed in using the Multi-user feature, OpenBook 
creates an individual subfolder in your name. In this case, 
the location that your files are saved in is: C:\Program 
Files\Freedom 
Scientific\OpenBook\9.0\Users\username\Library. 

If it is more convenient for you to save or open your files in a 
location other than the Library, follow these steps: 

1. Press ALT+G or click on the Settings Menu. 

2. Press G or select General Settings to open the General 
Settings properties page.  

3. Press ALT+C or click on Default File Location to place 
your cursor in the edit box.  

4. Type the new default location.  

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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OpenBook has its own file format called OBX, which is the 
default file format whenever you open or save a file. Files 
saved in this format are not compatible with versions of 
OpenBook prior to 8.0, however, the ark format is still 
supported so you can open saved files from a previous 
version. If you want a different file format set as the default 
file type, you must change the setting in the General Settings 
properties page.  

To change the default file format setting: 

1. Press ALT+G or click on the Settings Menu. 

2. Press G or select General Settings to open the General 
Settings properties page.  

3. Press TAB until you hear Default File Format or press 
ALT+F to activate the combo box. Use the UP or 
DOWN ARROW keys to select the file type you want 
set as the default. 

4. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Basic File Operations 

Creating a New File 

Select this menu item to create a new file. When you select 
New, OpenBook creates a new untitled document file. The 
shortcut key for this item is CTRL+N. 
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Opening a File 

When you select Open, the Select a File to Open dialog box 
opens. This dialog box contains a list of available files. Use 
TAB and SHIFT+TAB to move from field to field, and the UP 
and DOWN ARROWS to move from item to item within a 
field. When you locate the file you want to open, press 
ENTER. If the file you are opening contains any 
unprocessed pages, OpenBook immediately begins 
processing these pages using the currently active workflow 
and adding the recognized text to the file. When you open a 
file that is not an OBX or ARK document, such as an RTF or 
TXT document, or an image file, such as a TIF or PDF file, 
OpenBook creates a new untitled document where it places 
the text contained in the file. 

To open a file: 

1. Press CTRL+O to open the Select a File to Open dialog 
box. 

2. When the “Select a File to Open” dialog box opens, the 
File Name edit box is active. Press TAB to move to the 
Files of Type combo box and use the ARROW keys to 
select the format of the file you want to open. 

3. Next, press SHIFT+TAB twice to move to the files list 
view.  

4. Use the UP or DOWN ARROW key to navigate the List 
View to find the file or folder you want to open. When 
you have found it, press ENTER.  

5. If you cannot find the file or folder in the List View, you 
may want to look in the Tree View. Press SHIFT+TAB 
to move to the Look in combo box. 
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6. Use your UP ARROW key to navigate the Tree View. 
As you move to each folder, it opens automatically 
revealing its contents in the List View below.  

7. After you have selected the file format, found the folder, 
and selected the file you want to open, press TAB to 
move to the Open button and press ENTER.  

Note:  If you enter any wildcard characters, such as * or ?, 
when entering a file name, OpenBook updates the Files 
list view and announces “File List Box Updated” instead 
of opening a file after you select Open. For example, if 
you enter “????.txt,” the Files list view updates to show 
only files containing four characters and a TXT 
extension. Or, if you enter “file*,” the Files list view 
updates to show all files that begin with “file” followed 
by zero or more characters. 

Recently Opened Files 

OpenBook lists the last five files you have opened on the 
File menu. The only files that do not appear in this list are 
DAISY audio files opened directly from a CD, music files 
opened from your hard drive or a CD, and image files. To 
access a recently opened file, press ALT+F to display the 
File menu and then press a number between 1 and 5 on the 
numbers row. Pressing 1 opens the most recent file, 
pressing 2 opens the second most recent file, and so on. 
Use the ARROW KEYS to move through the menu if you 
want to hear the names of each recently opened file. 
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Opening Files with the Freedom Import Printer 

OpenBook is capable of opening the most popular file 
formats available for creating text documents. However, you 
may encounter documents where the author has either 
locked out direct access to the text in the document or 
created a graphic which represents text. In either case, 
OpenBook’s document converters are not able to directly 
open the document and provide access to the textual 
content. When you encounter these types of documents, 
utilizing the Freedom Import Printer, which installs with 
OpenBook, may provide you access to the content of the 
document. 

The Freedom Import Printer is a printer driver that sends its 
information to OpenBook instead of an actual printer. The 
information sent from the Freedom Import Printer is 
processed by OpenBook in the same way pages received 
from a scanner or the PEARL camera are processed. This 
optical character recognition (OCR) converts graphic based 
text into digital text, providing you access to read and modify 
the text. 

To utilize the Freedom Import Printer you must have an 
application capable of opening and printing the file installed 
on your computer. There are two methods for opening 
unrecognized files. 

If you have a screen reader such as JAWS installed on your 
computer, the first and preferred method of accessing files 
that may contain text rather than strictly graphics is to open a 
file using an application capable of directly opening the file 
format. If the screen reader provides you access to the file 
content, there is no reason to use the Freedom Import 
Printer to gain access. 
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A popular file format where we recommend you try this direct 
access with is Adobe’s Portable Document Format (PDF). 
When authors create PDF files, they may provide screen 
readers direct access to the text contained in the file and 
eliminate the need to perform OCR. Depending on the age 
of the PDF file or the choices made by the author, direct 
access may or may not be available. Additionally, many PDF 
files are simply pictures of text pages and as such cannot 
provide screen readers direct access. 

When you encounter files which do not provide direct access 
through your screen reader, you will want to use the 
Freedom Import Printer to gain access. To use this printer, 
open the application's Print dialog box, and select Freedom 
Import Printer from the list of printers and initiate printing of 
the document. If OpenBook is not running, it will be launched 
and then the file will be sent to OpenBook for recognition 
using the Freedom Import Printer specialty workflow. If 
OpenBook is already running, the file will immediately be 
sent to OpenBook and recognized. In both cases the 
recognized text will be placed in a new document in 
OpenBook. If OpenBook is currently running when you print 
the file from the specific application, you may need to press 
ALT+TAB to move focus to OpenBook. 

You can also use the Freedom Import printer to open a 
document from within OpenBook. To utilize this method, the 
file format needs to be associated with an application 
installed on your computer that is capable of opening and 
printing the document. 
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To open a graphic file from within OpenBook press CTRL+O 
to open the Select a File to Open dialog box. In the Files of 
Type combo box, you will need to set the file format to “All” 
in order to find the file you want to open. When you open a 
.PDF or image file through this dialog box, OpenBook 
attempts to use the Freedom Import Printer. First, the 
application associated with the document is opened and the 
document is opened in the application. If you receive the 
message “Unknown file type,” then you will be unable to 
open the document from within OpenBook until you install 
the application that is capable of opening the specific file. 
Next, the Freedom Import Printer automatically sends the file 
to OpenBook for the OCR and closes the associated 
application. 

Note:  Image files with a .PDF, .GIF, .JPG, .JPEG, .BMP, .TIF, 
.TIFF, .PCX, or .PNG extension are directly supported 
by OpenBook. If you choose to open one of these 
formats, the Freedom Import Printer will not be used. 
Instead, OpenBook immediately begins to recognize 
the text in the file. However, if OpenBook is unable to 
process the image, you will be asked if you would like 
OpenBook to use the Freedom Import Printer instead. If 
you select Yes, the image is processed using the 
Freedom Import Printer as described above. Otherwise, 
if you select No, the recognition is canceled. 

Once OpenBook begins to recognize the text, it will 
announce each page. As the file is processed, you can read 
the recognized text even as new pages are added to the 
document. You can even continue working in another 
document while OpenBook recognizes text from the 
Freedom Import Printer and places it into a new document. 
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You can change the settings OpenBook uses to recognize 
text received from the Freedom Import Printer by modifying 
the Freedom Import Printer specialty workflow. To do this, 
open the Settings menu, ALT+G, and choose Specialty 
Workflows or press L. When this properties page opens, 
select Freedom Import Printer from the list view then activate 
the Modify button. After you make the necessary changes to 
the process settings for this specialty workflow, select OK to 
save your workflow changes, then once more to close the 
Specialty Workflows properties page. For example, you may 
want to use a different recognition strategy, or you may want 
to have the cursor remain at the current position in the 
document so you can continue reading as new pages are 
added instead of being placed at the beginning of each new 
page. 

Note:  When opening unprotected PDF files, you will find it 
quicker to open these documents directly in OpenBook 
by selecting Adobe Portable Document Format (*.pdf) 
from the Files of type combo box in the Select a file to 
open dialog box. 

By default, the Freedom Import Printer prints in color. This 
means that if Keep Exact View is enabled in the Settings for 
the Freedom Import Printer specialty workflow, and you send 
an image or file to OpenBook via the Freedom Import 
Printer, or you open a color image from within OpenBook 
which is processed using FIP, the Exact View of the image 
will be in color. 



 135 

While color printing can result in a more accurate OCR in the 
Text View, you may wish to disable printing in color and just 
print in black and white as color images do take up more 
space. To turn off color printing, open the print dialog box of 
the application you are printing from and select the Freedom 
Import Printer from the list of printers. Next, Choose 
Properties, navigate to the Additional page, and select 
Advanced. When this dialog box opens, navigate to the Tiff 
page and in the Bits Per Pixel, choose 1 bit – Black and 
White. After you apply this change, the text or images sent to 
OpenBook for OCR and the Exact View will be saved in 
black and white. 

If you open a document or image from within OpenBook and 
the Freedom Import Printer processes the document, color 
printing is always used by default. 

Appending a File 

If you are working in an OBX or ARK document, you can 
append the contents of another file to the end of the 
currently open document. 

To append a file, press ALT+F to open the File menu, use 
the arrow keys to navigate to Append File and press 
ENTER. This opens the Select a File to Append dialog box 
which works exactly like the Select a File to Open Dialog 
box. The only difference is that after you select a file and 
activate the Append button, the selected file is appended to 
the end of the currently open document as a new page. 

Closing a File 

When you close a document, OpenBook prompts you to 
save the document if you have made editorial changes. The 
shortcut keys for this item are CTRL+W or CTRL+F4. 
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If you attempt to close a document that has pending 
pages waiting to be processed, a dialog box opens 
prompting you to select from one of the following 
actions: 

• Save: Selecting this button Saves the entire document 
including unprocessed content. This means that if you 
acquired 100 pages and OpenBook indicates there are 
60 unprocessed pages, the document is saved with the 
40 recognized pages along with the 60 pages that have 
not yet been processed. The next time you open this 
file, OpenBook will automatically resume processing the 
pending pages. 

Note:  If OpenBook is processing a PDF and you choose to 
save before processing is complete, only the pages that 
have already been recognized are saved. This is 
because unlike other image files where all available 
pages are pending and waiting to be processed, 
OpenBook processes PDF files one page at a time with 
one pending page awaiting processing. For example, if 
you open a 500 page PDF document and then save 
after 100 pages are processed, the resulting OBX 
document would contain just the 100 processed pages 
instead of 100 processed pages plus 400 unprocessed 
pages as it would if it was a 500 page TIF image. 

• Discard: Selecting this button Saves only the 
processed portion of the document and discards all 
unprocessed content. This means that if you acquired 
100 pages and OpenBook indicates there are 60 
unprocessed pages, only the 40 pages that have 
already been recognized will be saved. 

• Close: Selecting this button Closes the document 
without saving. 
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• Cancel: Selecting this button Closes the dialog box and 
returns to the currently open document. 

When you close a document, you are placed into the next 
open document. If no other documents are open, OpenBook 
places you in a new untitled document. Each new document 
is named Untitled2, Untitled3, Untitled4, etc. If you want 
OpenBook to begin with Untitled1, you must close and 
restart the program. 

Saving a File  

This menu item saves the current document in the default 
location or in the folder from which you opened the 
document. The shortcut key is CTRL+S.  

Save As  

This menu item allows you to save the current document 
under a new name, in a different file format, and in a 
different folder. Other supported file formats include ark, 
plain text, Word, Rich Text, and HTML. You should only 
save in the ark format if you need to access the file using a 
version of OpenBook prior to 8.0. 

To Save As: 

1. Press ALT+F to open the File Menu. 

2. Use your UP or DOWN ARROW key to navigate to 
Save As and press ENTER to open the Save As dialog 
box.  

3. When the Save As dialog box opens, the File Name 
edit box is active. So if you want to name or rename 
your file, just type in the new name.  

4. If you want to save the file in a different folder, press 
SHIFT+TAB to move to the files List View.  



 

 

138 

5. Use the UP or DOWN ARROW key to navigate the List 
View and press ENTER when you find the folder where 
you want to save the file.  

6. If you cannot find the file or folder in the List View, you 
may want to look in the Tree View. Press SHIFT+TAB 
to move to the Look in combo box. 

7. Use your UP ARROW key to navigate the Tree View. 
As you move to each folder, it opens automatically 
revealing its contents in the List View below. 

8. Press TAB to move to the Files of Type combo box and 
use the ARROW keys to select the file format you want 
to save. 

9. After you have named your file, found the folder, and 
selected the file format you want to save to, press TAB 
to move to the Save button and press ENTER.  

Note:  If you enter any wildcard characters, such as * or ?, 
when entering a file name, OpenBook updates the Files 
list view and announces “File List Box Updated” instead 
of saving a file after you select Save. For example, if 
you enter “????.txt,” the Files list view updates to show 
only files containing four characters and a TXT 
extension. Or, if you enter “file*,” the Files list view 
updates to show all files that begin with “file” followed 
by zero or more characters. 



 139 

When you save a document using the default OBX format 
and the document contains pending pages that have not yet 
been processed, the unprocessed pages are saved along 
with the processed content. This allows you to save and 
close a document that has not yet completed processing 
then open it at a later time and resume processing. If you 
save a document in a format other than OBX, such as TXT 
or RTF, only the recognized text is saved and all pending 
pages are lost. 

Note:  If OpenBook is processing a PDF and you choose to 
save before processing is complete, only the pages that 
have already been recognized are saved. This is 
because unlike other image files where all available 
pages are pending and waiting to be processed, 
OpenBook processes PDF files one page at a time with 
one pending page awaiting processing. For example, if 
you open a 500 page PDF document and then save 
after 100 pages are processed, the resulting OBX 
document would contain just the 100 processed pages 
instead of 100 processed pages plus 400 unprocessed 
pages as it would if it was a 500 page TIF image.  

Creating a New Folder 

Since the Open, Save As, Save Pages, and Save to Audio 
items have the same dialog box features, you can create a 
new folder anytime you select these items. 

To create a new folder: 

1. Press ALT+F to open the File Menu. 

2. Use your UP or DOWN ARROW key to navigate to any 
of the following items: Open, Save As, Save Pages, 
and Save to Audio. 
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3. When the dialog box opens, press ALT+F to activate 
the New Folder button. 

4. A new folder is created in the List View of the dialog 
box. Type the name of the new folder.  

5. Press ENTER twice to open the new folder. 

Save Pages  

CTRL+SHIFT+S is the command that allows you to save 
either the current page or a range of pages in the open 
document. This item is useful when you acquire pages of 
mail or other items to selectively save only the pages you 
want to keep. You can save just the page your cursor is on, 
or you can specify a range of pages to save. 

To save pages: 

1. From the File Menu, choose Save Pages (ALT+F, then 
G).  

2. The Save Pages dialog box opens with Save Current 
Page radio button checked. If you want to save only the 
current page, press ENTER. OpenBook takes you to 
the File Open dialog box and prompts you for a file 
name. 

3. If you want to save a range of pages, press the DOWN 
ARROW once to check the Save Page Range radio 
button and activate the edit box. Type in the range of 
pages you want to save, for example, 2-6 or 2,3,4. 
Once you have entered a valid range, press ENTER or 
press TAB to go to the Ok button, then press ENTER. 
OpenBook will take you to the File Open dialog box and 
prompt you for a file name. You can cancel the 
operation at any time by going to the CANCEL button 
or pressing ESC. 
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Note: If you have used the Renumber Pages function to 
change the number sequence in your document, you 
must specify the revised page numbers in the Save 
Pages dialog box. 

Saving to Audio 

If you own an audio player that will play WAV or MP3 files 
you will want to use this feature. Save to Audio converts 
OpenBook supported files into WAV or MP3 file formats 
using the currently selected reading voice. For example, if 
you use RealSpeak Solo Daniel as your reading voice, this is 
the voice you will hear in the resulting audio file that 
OpenBook creates.  

To save to audio: 

1. Open or acquire the file you want to save as audio. 

2. Press ALT+F to open the File Menu. 

3. Use your UP or DOWN ARROW key to navigate to 
Save to Audio and press ENTER to open the Save to 
Audio dialog box.  

4. If you just want to save the current page, press the TAB 
key to move to the Ok button and press ENTER. 

5. If the document you opened is large and you are saving 
a range of pages, use your DOWN ARROW key to 
select Save Page Range.  

6. Press TAB to move to the Page Range edit box and 
type in the page numbers. You can use dashes or 
commas between each number.  
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7. If you want to save the entire audio file as one file, 
press the TAB key to move to the Save Range as a 
Single File check box and press SPACEBAR to place a 
check in this box. Leaving this box unchecked saves 
each page as a separate file. 

8. Press the TAB key to move to the Ok button and press 
ENTER. 

9. When the Save to Audio dialog box opens, the File 
Name edit box is active. Type a name for the file in this 
edit box. 

10. Press TAB to move to the Files of Type combo box and 
use the arrow keys to select the file format. 

11. If you want to save the file in a different folder, press 
SHIFT+TAB twice to move to the files List View.  

12. Use the UP or DOWN ARROW key to navigate the List 
View and when you find the folder where you want to 
save the file, press ENTER.  

13. If you cannot find the file or folder in the List View, you 
may want to look in the Tree View. Press SHIFT+TAB 
again to move to the Look in combo box. 

14. Use your UP ARROW key to navigate the Tree View. 
As you move to each folder, it opens automatically 
revealing its contents in the List View below. 

15. When you have found the folder where you want to 
save the file, press TAB to move to the Save button 
and press ENTER to begin the text to audio conversion. 
This may take a few minutes depending on the size of 
the file. To cancel the process, press ENTER again. 
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Note:  If you attempt to save an audio file with the same name 
as an existing file, OpenBook adds 01 to the end of the 
filename. OpenBook does not overwrite the existing file. 

Document Properties  

Select this item to view specific information about the open 
document. CTRL+R 

Importing and Exporting Braille Files 

When exporting files to BRF or BRL format OpenBook 
translates in contracted Braille using the same page and line 
break as in the original file. By default, there are 25 lines per 
page and 40 cells per line. Braille files (.brf, .brl) are 
imported as text files. 

Currently, emphasized text (bold, italic, underline) is not 
imported into text files, but is maintained when exporting 
Braille files.  

To import or export Braille files, press ALT+F, B. This opens 
the Braille submenu, which has two options: Import a Braille 
File to Text Format and Export the Current File to Braille 
Format.  

To access files on your notetaker, please see the Book, 
Using Your Notetaker. 

Playing Audio Files 

OpenBook supports several popular audio formats including 
DAISY Audio (XML) and Music Files (MP3, MPG, WAV, and 
WMA file formats). To play an audio file or DAISY audio 
book, press ALT+F or click on the File menu and choose 
Open Audio Directory. Alternatively, press CTRL+R. 
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When this dialog box opens, you are placed into a list view 
which initially shows the available drives on your computer. 
This includes A:\, C:\, your CD or DVD-ROM drive, and any 
external drives that are currently connected such as a USB 
thumb drive. Use the arrow keys to select the drive you want 
then press ENTER to open it and display the list of folders 
and any audio files stored on the root of the drive. If the 
audio files you want to play are stored in a specific folder, 
repeat this process until you have opened the specific folder. 
Before pressing ENTER to open a folder, you can press TAB 
to move to the Audio Files read-only edit field which shows 
how many subfolders and audio files are available in the 
selected drive or folder. For instance, if you have an audio 
CD inserted that contains 10 tracks and the CD-ROM drive 
is selected, OpenBook displays “contains 10 audio files and 
0 subfolders.” Press SHIFT+TAB to move back to the list 
view and press ENTER to open the drive or folder, or 
navigate to a different one. 

Once you open the drive or folder containing the file(s) you 
want to listen to, select a file then activate the OK button. 
You are placed in a tree view containing the audio files in the 
current folder with the file you previously selected as the 
current item ready to be played. If you have opened a DAISY 
book, the tree view displays chapters or topics. To select a 
file or topic, press UP or DOWN ARROW. To expand a topic 
in a DAISY book, pres RIGHT ARROW and to close it, press 
LEFT ARROW. To begin playing the selected item, press 
INSERT+DOWN ARROW. Press CTRL to stop. If you use 
the arrow keys to select a different file while audio is 
currently playing, the audio is automatically stopped and you 
will need to press INSERT+DOWN ARROW again after 
making your selection. 
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During playback, press LEFT ARROW or LEFT SHIFT to 
rewind five seconds, or RIGHT ARROW or RIGHT SHIFT to 
fast forward by five seconds. If you are listening to a DAISY 
book, you can adjust the speed of the narration by using 
ALT+CTRL+PAGE UP to increase the rate and 
ALT+CTRL+PAGE DOWN to decrease the rate. When you 
change the rate, it is saved for the current OpenBook 
session- even if you close and open a different file. If you 
close and restart OpenBook, the rate will revert to the default 
setting. 

Note:  If you are playing audio from a CD or external USB 
drive and you eject the CD or disconnect the drive, you 
will receive a warning and the file will be closed. 
OpenBook will still remain open so you can select a 
different file. 
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Book 13 

Low Vision Features 

Masking 

Available in Read-only Mode with Text View, Masking 
emphasizes the text you are reading by shading the text you 
are not reading. With Masking, you have four options: Line 
Masking, Sentence Masking, Paragraph Masking, and No 
Masking.  

Note:  If you enable Masking while you are highlighting text, 
highlighting is canceled and all highlight menu options 
are disabled. Additionally, when masking is on, 
OpenBook will not announce highlighted text and 
default display and masking colors are displayed 
instead of the highlight colors. 

To use Masking: 

1. Press ALT+G or click on the Settings Menu. 

2. Press V or select Visual Settings to open the Visual 
Settings Properties page.  

3. Press TAB to move to the Masking Increments. Use the 
UP or DOWN ARROW key to select one of the four 
options: No Masking, Sentence, Line, and Paragraph. 

4. If you selected Sentence, Line, or Paragraph, press 
TAB to move to the Text Slider control. Use the 
ARROW keys to lighten or darken the text on the page. 

5. Press TAB again to move to the Background Slider 
control. Use the ARROW keys to lighten or darken the 
background color on the page.  
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6. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Text View 

Text View shows the text of an acquired page after it has 
been recognized by OpenBook. Text View is the primary 
view and is where you perform most editing functions such 
as adding or deleting text and spell checking, as well as 
selecting, copying, cutting, and pasting text. This primary 
view is also where you can employ various OpenBook tools, 
such as highlighting text, adding bookmarks, inserting 
comments, and applying various low vision features such as 
font size, type, character spacing, and text and background 
color. Text View is always active by default after every 
acquisition. 

To change Text View elements:  

1. Press ALT+G or click on the Settings Menu. 

2. Press V or select Visual Settings to open the Visual 
Settings properties page.  

3. Press TAB or click on any of the controls and make the 
changes necessary for reading. 

4. Press the OK button to exit this properties page. 

Note:  To quickly change the Text Size, Color, Spacing, Font, 
or spotlight color of your Text View, you can use the 
quick Low Vision Menu on the Menu Bar.  



 

 

148 

Exact View 

Exact View is the acquired page displayed exactly as the 
original document. You activate Exact View by opening the 
View menu (ALT+V) and choosing Exact View. You can also 
press CTRL+SHIFT+V to cycle between Text View, Exact 
View, Split View, and Camera View. If the current page does 
not have an Exact View image, OpenBook displays an 
image containing the message “No Image Available.” 

Additionally, you can set Exact View as your preferred view 
when opening documents. To do this, open the Visual 
Settings properties page from the Settings menu and choose 
Exact View from the Preferred View combo box. All future 
documents will now open in Exact View. 

In Exact View, you can: read the page, change background 
and text colors, use the dictionary and spelling tools, select 
text then copy it or apply a highlight color, and change the 
zoom level. Show Exact View is available for: 

• Acquired documents if you have Keep Exact View 
enabled in the currently active workflow. By default, 
Keep Exact View is enabled in all workflows except the 
Mail Sorter Preview. 

• Documents you send to OpenBook via the Freedom 
Import Printer, if you have Keep Exact View enabled in 
the Freedom Import Printer specialty workflow. This 
option is enabled by default in this workflow. 

• Image Files (i.e. *.tif, *.TIFF, *.jpg, *.jpeg, *.pcx, *.bmp, 
*.gif, or .png) you open via the CTRL+O option within 
OpenBook. The Exact View is available as an original 
.tif and .pcx image whether the Keep Exact View setting 
is enabled or not.  
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Note:  Selecting text by line in Exact View will not always 
select the same amount of content as in Text View. 
This is because in Text View, a line is determined by 
either a hard line break, which you get by pressing 
ENTER, or when the text wraps at the edge of the 
window. In Exact View, the line is determined by the 
rectangle of the word(s).  

By default, the exact view uses a black background. To 
select a different background color, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press W or select Image View Settings to open the 
Image View Settings properties page.  

3. Press TAB to move to the Exact View Background 
Color combo box and select the color you want to set 
as the background. 

4. Press the OK button to exit this properties page. 

NOTES:  

• To change text or spotlight colors, you must go to the 
Visual Settings Properties page in the Settings Menu.  

• By default, if you have an exact view color or grayscale 
image, you cannot apply any low vision color, such as 
yellow on blue background, to the Exact View. The 
exact view image is saved with the original colors from 
the acquired page, which then prohibits OpenBook from 
being able to display low vision colors. Your chosen 
Low Vision colors, and all other chosen Low Vision 
settings, will only apply to your Text View, or the Text 
View area of Split View. To apply text colors to an Exact 
View color or grayscale image, enable the Two Tone 
setting from the View menu or the Visual Settings 
properties page. 
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Two Tone 

Two Tone allows you to apply text and background colors to 
a color or grayscale image in both Exact View and Split 
View. This setting is not available if the open document does 
not have an Exact View, or the Exact View image is in black 
and white. The default setting for this option is off, which 
means that changes made to the text colors will only apply to 
the Text View, or the Text View area of Split View. 

To enable Two Tone: 

1. Open a document that contains an Exact View color or 
grayscale image.  

2. Press ALT+G or click on the Settings Menu. 

3. Press V or select Visual Settings to open the Visual 
Settings Properties page.  

4. Press TAB to move to the Use Two Tone for Exact 
View check box and use the SPACEBAR to check or 
uncheck this item. 

5. Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Alternatively, you can toggle Two Tone on or off by opening 
the View menu (ALT+V) and choosing Two Tone or by 
pressing CTRL+2. 

Once enabled, you can change the text and background 
colors and have them applied to any open color or grayscale 
documents in both Text View, Exact View, and Split View. 
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Delete Exact View 

Since Exact View makes your files bigger, you may want to 
save hard disk space by deleting the Exact View of the file 
after you are done using it. 

From the Edit Menu, select Delete Exact View (ALT+E, X). 
OpenBook asks you to confirm the deletion as this command 
deletes the Exact View from all pages in the open document, 
not just the current page. 

Split View 

This powerful feature allows you to have access to both the 
exact view and the text view simultaneously, so you don't 
have to toggle back and forth when you are trying to 
compare the recognized text with the original image. You 
activate Split View by opening the View menu (ALT+V) and 
choosing Split View. You can also press CTRL+SHIFT+V to 
cycle between Text View, Exact View, Split view, and 
Camera View. When enabled, the Exact View, or the original 
acquired image, is displayed in the lower part of the screen 
while the Text View, or the recognized text, is displayed in 
the top part of the screen.  

Additionally, you can set Split View as your preferred view 
when opening documents. To do this, open the Visual 
Settings properties page from the Settings menu and choose 
Split View from the Preferred View combo box. All future 
documents will now open in Split View regardless of whether 
they have an exact view available or not. 
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Split View makes it much easier to compare the text in the 
original image with the recognized text to locate errors that 
may have occurred during OCR. If you find a possible error 
in the recognized text, you can quickly compare to the exact 
view of the document and then go into Edit Mode and use 
the standard editing keys to make the correction. Also, in 
Split View both the Exact View and Text View display the 
spotlighted text simultaneously. This feature is very handy 
for reviewing brochures, flyers, etc. where pictures and text 
tell the story, but word recognition might be difficult.  

Split View is available whether you have Keep Exact View 
enabled or not. If a page does not have an Exact View 
image, the bottom portion of the Split View displays an 
image containing the message "No Image Available." This is 
useful if a document has some pages that have an exact 
view, and some that do not. It is possible to have a 
document such as this if portions were acquired using a 
workflow with Keep Exact View On, then later pages were 
acquired and added to that same file, using a workflow with 
Keep Exact View off. 

All the normal editing features and tools you normally use 
while in Text View, such as Dictionary, Highlight, Bookmark, 
Insert Comment, Edit Mode, are available to the Text View 
while you are in Split View.  

Tip:  While primarily a tool for low vision users, Split View is 
also useful when collaborating with sighted co-workers, 
as it allows you to visually compare the original 
document image alongside the recognized text. 

NOTES:  
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• Changing low vision options such as text size, font, 
spacing, and margins only affects the Text View. Since 
the Exact View is simply the original acquired image, 
OpenBook can not modify the actual image. 

• When changing the Spotlight Text Color through the 
Visual Settings properties page on the Settings menu, 
the new color will be applied to both the Text View and 
Exact View areas. This makes it easy for you to keep 
track of where you are in both views as you navigate. 

• By default, if you have an exact view color or grayscale 
image, you cannot apply any low vision color, such as 
yellow on blue background, to the Exact View. The 
exact view image is saved with the original colors from 
the acquired page, which then prohibits OpenBook from 
being able to display low vision colors. Your chosen 
Low Vision colors, and all other chosen Low Vision 
settings, will apply to your Text View, displayed in the 
upper portion of the screen. To apply text colors to an 
Exact View color or grayscale image, enable the Two 
Tone setting from the View menu or the Visual Settings 
properties page. 
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Camera View 

Camera View displays a real-time view from the PEARL 
camera on your monitor; meaning that as you move items 
around under the camera, such as turning pages or 
removing and replacing objects, the image on the screen will 
update accordingly. This is different from Exact View which 
only shows the image once it has been acquired. You 
activate Camera View by opening the View menu (ALT+V) 
and choosing Camera View. You can also press 
CTRL+SHIFT+V to cycle between Text View, Exact View, 
Split view, and Camera View. If the PEARL is not connected, 
or is not configured as the acquisition device, this view is not 
available. Additionally, if the Camera View is active and you 
disconnect the PEARL from the computer, an image 
containing the message “no image available” is displayed. 

Camera View is an excellent tool for low vision users as it 
allows you to use the PEARL as a video magnifier. With the 
live image of the document on your screen, you can change 
the zoom level, rotate the image left or right, or use the 
virtual XY table to navigate the image. You can even perform 
tasks under the camera, such as writing, and see what you 
are doing magnified on the screen. If you are in a room with 
low lighting, press CTRL+L to toggle the built-in LED light. 
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While in the Camera View, you can use the standard 
OpenBook reading and navigation commands to read text in 
the currently open document. However, you can not change 
text elements such as colors, font type, size, and spacing, or 
use any of OpenBook’s text selection or editing features 
while in Camera View. If you choose to acquire the image 
under the camera, OpenBook will use the settings from the 
currently active workflow to process and read the recognized 
text. If you switch back to Text View, Exact View, or Split 
View, the cursor will be located on the word where the 
reading stopped. 

Notes: 

• Since Camera View is basically a live video feed, it is 
possible for the camera to show something different 
from what is being read by OpenBook. This is because 
the Camera View updates with a new image as soon as 
a new object is placed under the camera while 
OpenBook is only reading the text from the last 
acquired image. 

• The Camera View automatically closes if you press 
CTRL+TAB to switch to another open document, close 
the current document, or open an image file which 
creates a new document during OCR. 
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Overlay 

In Camera View, the entire area under the camera (9 inches 
by 12 inches) is displayed. However, you can configure the 
boundaries the camera uses when acquiring the page by 
opening the PEARL Properties located in the Device 
Selection dialog box in the Advanced menu (ALT+A). In the 
Page Size combo box, you can choose from Full (default), 
Letter, or A4. For more information on these settings, see 
Acquiring and Processing, Setting the Acquisition Device. In 
addition, the Mail Sorter Preview workflow only acquires a 
certain portion of the page. 

To distinguish the portion of the image that is to be acquired 
from the rest of the image, OpenBook displays an overlay 
rectangle. An overlay emphasizes a part of an image by 
increasing the difference in brightness/contrast between it 
and the rest of the image. Overlay is to images, as Masking 
is to text. The overlay rectangle is always displayed and 
moves as you pan so the same portion of the image is 
always covered. If you change the page size in the PEARL 
properties, or change how much of the image is acquired in 
the workflows settings, the overlay will also change to reflect 
the new settings. 

To change the Overlay color and transparency, do the 
following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press W or select Image View Settings to open the 
Image View Settings properties page.  

3. Press TAB to move to the Camera View Color combo 
box and select the color you want to use for the overlay. 
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4. Press TAB to move to the Camera View Overlay 
Transparency slider and use the ARROW keys to 
select the level of transparency you want for the overlay 
rectangle. Higher values make the overlay more 
transparent. 

5. Press the OK button to exit this properties page. 

Rotate Camera View 

To rotate the image in the Camera View, press ALT+V or 
click on the View menu. Then, press R to open the Rotate 
Camera View submenu. 

Select Rotate Right, to rotate the view 90 degrees to the 
right. Alternatively, press CTRL+SHIFT+R to carry out this 
function. 

Select Rotate Left to rote the view 90 degrees to the left. 
Alternatively, press CTRL+SHIFT+L to carry out this 
function. 

Zooming the View 

You can change the zoom level of the Exact View image or 
the Camera View by selecting one of the options from the 
Zoom Submenu. To change the zoom level, press ALT+V to 
open the View menu and choose Zoom to open the Zoom 
submenu. Use UP or DOWN ARROW to select the zoom 
item you want then press ENTER. Your choices are: 

• Zoom In – Incrementally increases the zoom level. 

• Zoom Out – Incrementally decreases the zoom level. 

• Page Width – Instantly zooms enough so the width of 
the image is in the window. 

• Page Height – Instantly zooms enough so the height of 
the image is in the window. 
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• Default – Instantly zooms to the default setting. 

The default zoom in Exact View is set to Page Width. To 
change the default zoom level for Exact View, do the 
following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press W or select Image View Settings to open the 
Image View Settings properties page.  

3. In the Exact View Default Zoom combo box, choose the 
zoom level you want to use when an image is displayed 
in the exact view. 

4. Press the OK button to exit this properties page. 

5. Open the Settings Menu again (ALT+G) and choose 
Save the Settings (S). 

6. In the Save Settings dialog box, press ENTER to make 
the changes part of the default settings. For more 
information on this feature, please see the book, Using 
Settings Files. 

The default zoom in Camera View is set to Page Height. To 
change the default zoom level for Camera View, do the 
following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press W or select Image View Settings to open the 
Image View Settings properties page.  

3. Press TAB to move to the Camera View Default Zoom 
combo box and choose the zoom level you want to use 
when images are displayed in Camera View. 

4. Press the OK button to exit this properties page. 

5. Open the Settings Menu again (ALT+G) and choose 
Save the Settings (S). 
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6. In the Save Settings dialog box, press ENTER to make 
the changes part of the default settings. For more 
information on this feature, please see the book, Using 
Settings Files. 

If you have changed the default zoom level through the 
Image View settings after accessing Camera View during the 
current OpenBook session, you must close and restart 
OpenBook before the new default zoom level will take affect. 
Changing the zoom level through the View menu while in 
Camera View will immediately apply the new zoom setting. 

Virtual XY Table 

The virtual XY table allows you to visually read through text 
on the screen in the Exact View and the live Camera View. If 
the view is zoomed to a larger size and the entire image is 
not visible, you can use the mouse or keyboard commands 
to pan the image up, down, left, or right respectively. There 
are two types of panning, smooth and incremental. 

Smooth panning continuously pans an image in a particular 
direction until you press a keystroke to stop, change the 
panning direction, or when you reach the edge of the image. 
Smooth panning simulates the movement of an XY table, 
which is a common component of desktop video magnifiers. 
Use the following keystrokes to control smooth panning: 

• WINDOWS Key+DOWN ARROW – In Exact View and 
Camera View, pans down until the bottom edge of the 
image is reached. 

• WINDOWS Key+UP ARROW – In Exact View and 
Camera View, pans up until the top edge of the image 
is reached. 
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• WINDOWS Key+LEFT ARROW – In Exact View and 
Camera View, pans left until the left edge of the image 
is reached. 

• WINDOWS Key+RIGHT ARROW – In Exact view, 
pans right until the right edge of the image is reached. 
In Camera View, pans right until the right edge of the 
image is reached, pauses, scrolls down to the next line, 
pauses, then continues panning right. 

• NUM PAD PLUS – Increase panning speed while 
panning. 

• NUM PAD MINUS – Decrease panning speed while 
panning. 

To change directions while panning, for example, if you are 
panning forward and you want to pan in reverse, press the 
keystroke that corresponds to the direction you want to pan. 
OpenBook will immediately begin panning in the new 
direction without interrupting the panning. 

While panning right in Camera View, you can also press 
ENTER before the right edge of the image is reach to quickly 
advance a line. OpenBook will scroll down to the beginning 
of the next line and continue panning right. 

Incremental panning instantly jumps to a new position and 
stops. Use the following keystrokes in Exact View or Camera 
View to incrementally pan an image: 

• WINDOWS Key+CTRL+DOWN ARROW – Pan down. 

• WINDOWS Key+CTRL+UP ARROW – Pan up. 

• WINDOWS Key+CTRL+LEFT ARROW – Pan left. 

• WINDOWS Key+CTRL+RIGHT ARROW – Pan right. 

• PAGE UP – Pan up one screen. 
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• PAGE DOWN – Pan down one screen. 

• WINDOWS Key+HOME – Pan to top left. 

• WINDOWS Key+PAGE UP – Pan to top right. 

• WINDOWS Key+PAGE DOWN – Pan to bottom left. 

• WINDOWS Key+END – Pan to bottom right. 

Configuring Exact View Smooth Panning 
Options 

To change the smooth panning speed for Exact View, do the 
following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press W or select Image View Settings to open the 
Image View Settings properties page.  

3. Press TAB to move to the Exact View Panning 
Properties button and press SPACEBAR. 

4. In the Forward Speed spin box, choose a value 
between 1 (fastest) and 20 (slowest) that represents the 
panning speed to use when panning to the right. The 
default setting is 5. 

5. Press TAB to move to the Vertical Speed spin box and 
choose a value between 1 (fastest) and 20 (slowest) 
that represents the panning speed to use when panning 
up or down. The default setting is 5. 

6. Press TAB to move to the Reverse Speed spin box and 
choose a value between 1 (fastest) and 20 (slowest) 
that represents the panning speed to use when panning 
to the left. The default setting is 5. 

7. Press the OK button to exit the Exact View Panning 
properties, and once more to exit the Image View 
Settings properties page.  
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Configuring Camera View Smooth Panning 
Options 

To change the smooth panning speed and line wrap settings 
for Camera View, do the following: 

1. Press ALT+G or click on the Settings Menu. 

2. Press W or select Image View Settings to open the 
Image View Settings properties page.  

3. Press TAB to move to the Camera View Panning 
Properties button and press SPACEBAR. 

4. Uncheck the Line Wrap check box if you do not want 
OpenBook to automatically wrap to the next line when 
you reach the right edge of the image. This item is 
check by default. 

5. Press TAB to move to the Point Size spin box and 
select a point size. The point size indicates the height of 
one line. If Line Wrap is enabled, this setting 
determines how far OpenBook needs to wrap in order 
to get to the next line. The default point size is 10. 

6. Press TAB to move to the Line Delay edit field and 
Enter the number of seconds you want OpenBook to 
pause when wrapping to the next line. The default is 
one second. 

7. Press TAB to move to the Forward Speed spin box, 
and choose a value between 1 (fastest) and 20 
(slowest) that represents the panning speed to use 
when panning to the right. The default setting is 5. 

8. Press TAB to move to the Vertical Speed spin box and 
choose a value between 1 (fastest) and 20 (slowest) 
that represents the panning speed to use when panning 
up or down. The default setting is 5. 
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9. Press TAB to move to the Reverse Speed spin box and 
choose a value between 1 (fastest) and 20 (slowest) 
that represents the panning speed to use when panning 
to the left. The default setting is 5. 

10. Press the OK button to exit the Camera View Panning 
properties, and once more to exit the Image View 
Settings properties page. 

Scrolling the View 

You can use the mouse scroll wheel to scroll the text in the 
Text View, help window, or Exact View. In addition, when in 
Exact View, you can use ALT+CTRL+UP, DOWN, LEFT, or 
RIGHT ARROW to scroll the Exact View up, down, left, or 
right respectively. When in Split view, the mouse scroll wheel 
will scroll the top pane or text view area, while the 
ALT+CTRL+ARROW keys will scroll the bottom pane or 
exact view area. The ability to scroll the view is useful when 
the document on the page is long, the text is large, or when 
the Exact View is zoomed to a larger size. 
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Book 14 

Printing  

The option to print your files is important to your productivity. 
Regardless of your task, having your information in hard 
copy allows for easy access and reference.  

There are two ways to launch the print dialog box. The easy 
way is to press CTRL+P from within any document. The 
other way is to open the File Menu (ALT+F) and select Print 
(P). Unless you want to change print parameters or you have 
more than one printer installed on your computer, you can 
immediately press ENTER or select the Ok button to print a 
single copy of your document.  

Number of Copies 

Unless you specify the number of copies printed, OpenBook 
will only print one copy of a document.  

To print more than one copy of a document: 

1. Press CTRL+P to open the Print dialog box.  

2. Press TAB until you hear “Number of copies one.”  

3. Use your UP or DOWN ARROW keys to increase or 
decrease the number of copies to be printed. 

4. Once you have selected your number, you can change 
more print parameters or press TAB to move to the Ok 
button, then press ENTER to print your document. 
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Selecting a Print Range 

The Print Range area of the Print dialog box is composed of 
three radio buttons: All Pages, Selected Text Only, and 
Pages from:_ to:_. Unless you specify a print range, 
OpenBook will print all pages contained with in a document.  

To specify a Print Range: 

1. Press CTRL+P to open the Print dialog box.  

2. Press TAB until you hear “All Pages checked.”  

3. Use your UP or DOWN ARROW keys to make your 
selection. If you choose Pages from:_ to:_, be sure to 
TAB to the Edit boxes and type in a number. 

4. Once you have selected your new page range, you can 
change more print parameters or press TAB to move to 
the Ok button, then press ENTER to print your 
document. 

Changing Print Font 

In the Print dialog box there is a Print Font area, which has 
two radio buttons: Print using default font, and Print as 
displayed. When installed OpenBook’s default font is Arial 14 
point. 

To change the print font from default to as displayed: 

1. Press CTRL+P to open the Print dialog box.  

2. Press TAB until you hear “Print using default font.”  

3. Use your UP or DOWN ARROW keys to move between 
each radio button.  

4. Once you have selected how you want your document 
to print, you can change more print parameters or press 
TAB to move to the Ok button, then press ENTER to 
print your document. 
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To change the default print font: 

1. Press ALT+G or click on the Settings Menu. 

2. Press G or select General Settings to open the General 
Settings Properties page.  

3. Press TAB until you hear, “Default Print Font Name.”  

4. Use your UP or DOWN ARROW keys to select your 
new default printer font. 

5. Press TAB to move to the Default Print Font Size 
combo box. 

6. Use your UP or DOWN ARROW keys to select your 
new default font size. 

7. Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

To change the display font: 

1. Press ALT+G or click on the Settings Menu. 

2. Press V or select Visual Settings to open the Visual 
Settings Properties page.  

3. Press TAB or click on any of the controls and make the 
changes necessary to the display font. 

4. Press the Ok button to exit this properties page. 

Changing Printers 

If multiple printers are installed on your computer, then 
OpenBook uses the same default printer designated in 
Windows.  
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While OpenBook’s Print dialog box allows you to change 
printers, it does not allow you to change the default printer.  

To change printers: 

1. Press CTRL+P to open the Print dialog box.  

2. Press ALT+N to move to the Name combo box. This 
edit box lets you select a different printer. Use your UP 
or DOWN ARROW keys to select another printer. 

3. Press ENTER or select the Ok button to print your 
document. 

Page Orientation 

The Orientation area of the Print Setup dialog box is 
composed of two radio buttons: Portrait and Landscape. 

To change the page orientation: 

1. Press CTRL+P to open the Print dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the Print Setup dialog box. 

3. Next, press TAB until you hear “Page Orientation.” Use 
your UP or DOWN ARROW keys to make your 
selection. 

4. Once you have selected the page orientation, you can 
change more print parameters or press ENTER to 
return to the Print dialog box. 

5. To print your document, press TAB to move to the Ok 
button, then press ENTER to start the print job. 

Choosing Paper Size 

The default paper size setting for OpenBook is 8.5 x 11 
inches.  

To choose another paper size:  
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1. Press CTRL+P to open the Print dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the Print Setup dialog box. 

3. When this dialog box opens, your cursor is in the Paper 
Size edit box. This edit box lets you select a different 
paper size. Use your UP or DOWN ARROW keys to 
make your selection. 

4. Once you have selected your new page size you can 
change more print parameters or press ENTER to 
return to the Print dialog box. 

5. To print your document, press TAB to move to the Ok 
button, then press ENTER to start your print job. 

Selecting a Paper Source 

If your printer has more than one paper tray or a manual 
feed, use this combo box to select the tray you want your 
printer to use when you print your document. 

To select a paper source: 

1. Press CTRL+P to open the Print dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the Print Setup dialog box. 

3. Next, press TAB until you hear “Paper Source.” Use 
your UP or DOWN ARROW keys to make your 
selection. 

4. Once you have selected the paper source, you can 
change more print parameters or press ENTER to 
return to the Print dialog box. 

5. To print your document, press TAB to move to the Ok 
button, then press ENTER to start your print job. 
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Setting Page Margins 

Page margins can only be set using inches. When you install 
OpenBook, the default margin set for the top, bottom, left, 
and right page edge is 1 inch.  

To set page margins:  

1. Press CTRL+P to open the Print dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the Print Setup dialog box. 

3. Next, press TAB until you hear “Left Margin.” In the edit 
box, type in the number you want to set for the left 
margin.  

4. Press TAB to move to the Right Margin edit box and 
type the number you want set for the right margin. 
Repeat this step if you want to set the top and bottom 
margins.  

5. Once the margins are set, you can change more print 
parameters or press ENTER to return to the Print dialog 
box. 

6. To print your document, press TAB to move to the Ok 
button and press ENTER to start the print job. 
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Book 15 

Embossing 

Before you can emboss a document, you must first select 
your embosser type in the Properties dialog box, which is 
accessed from the Emboss dialog box (ALT+F, E).  

Setting Up Your Embosser 

When you select your embosser, many of the fields in the 
Properties dialog box automatically populate with your 
embosser’s default settings. This means you can 
immediately begin embossing your document or you can 
change the embossing settings.  

1. Press ALT+F, E to open the Emboss dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the dialog box. 

3. When this dialog box opens, your cursor is in the 
Embosser combo box. This combo box lists embossers 
that are compatible with OpenBook. Use your UP or 
DOWN ARROW keys to select your embosser. 

4. Press TAB until you hear, “Connection combo box.” 

5. Use your UP or DOWN ARROW keys to select the port 
connecting your embosser.  

6. If you select Windows Device, press TAB to move to 
the Windows Device combo box. This combo box lists 
all the printers and embossers available to your 
computer. 

7. Use your UP or DOWN ARROW keys to select an 
embosser.  
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8. Press ENTER or select the Ok button to return to the 
Emboss dialog box. 

Embossing a Document 

Embossing a document is initiated from the Emboss dialog 
box. To launch the Emboss dialog box you must open the 
File Menu (ALT+F) and select Emboss (E). With the Emboss 
dialog box open, you have several controls that allow you to 
change the way your document is embossed. If you do not 
want to change any of the parameters and are ready to 
emboss, press TAB until you reach the Ok button and then 
press ENTER. 

Number of Copies 

Unless you specify the number of copies you want 
embossed, OpenBook will only emboss one copy of a 
document.  

To emboss more than one copy of a document: 

1. Press ALT+F, E to open the Emboss dialog box.  

2. Press TAB until you hear “Number of copies one.”  

3. Use your UP or DOWN ARROW keys to increase or 
decrease the number of copies to be embossed. 

4. Once you have selected your number, you can change 
more emboss parameters or press TAB to move to the 
Ok button. Press ENTER to emboss your document. 

Changing Emboss Settings 

Depending on your needs, you may want to emboss on 
different size paper. Changes made to the embossing 
settings are retained until you change them or reset them to 
their defaults. 
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For 8.5 x 11 inch paper, use the following settings:  

Cell Per Line: 34 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 34 
Max Lines Per Page of Embosser: 27 

For 11.5 x 11 inch paper, use the following settings:  

Cell Per Line: 40 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 42 
Max Lines Per Page of Embosser: 27 

To change embossing settings: 

1. Press ALT+F, E to open the Emboss dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the dialog box. 

3. Press TAB to move to the Set Cell Per Line To edit 
box. Type the number of Braille cells you want in each 
line. 

4. Press TAB to move to the Set Lines Per Page To edit 
box. Type the number of lines you want on each page.  

5. Press TAB to move to the Set Top Margin in lines to 
edit box. Type the number of lines you want to set for 
your top margin.  

6. Press TAB until you hear, “Max Cells Per Line of 
Embosser edit box.” Type the absolute maximum 
number of cells you want on each line.  



 173 

7. Press TAB to move to the Max Lines Per Page of 
Embosser edit box. Type the absolute maximum 
number of lines you want on each page.  

8. Press ENTER or select the Ok button to print your 
document. 

To reset your embosser’s default settings: 

1. Press ALT+F, E to open the Emboss dialog box.  

2. Use TAB to move to the Properties button and press 
SPACEBAR to open the dialog box. 

3. When this dialog box opens, your cursor is in the 
Embosser combo box. Use your UP or DOWN ARROW 
keys to select another embosser. 

4. Reselect your embosser. The default settings will 
repopulate each field. 

5. Press ENTER or select the Ok button to return to the 
Emboss dialog box. 

Computer Braille vs. Contracted Braille 

By default, OpenBook will send text to your embosser in 
contracted Braille. However it can be set to emboss in 
computer Braille if necessary. 

To change between computer Braille and contracted Braille: 

1. Press ALT+F, E to open the Emboss dialog box.  

2. Press TAB until you hear, “Contracted Braille checked.” 

3. A check in this box means the document will emboss in 
contracted Braille. To emboss in computer Braille, 
press SPACEBAR to uncheck this box. 
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4. Once you have selected the Braille translation mode, 
you can change more emboss parameters or press 
TAB to move to the Ok button and then press ENTER 
to emboss your document. 

Selecting an Emboss Range 

The Emboss Range area of the Emboss dialog box is 
composed of 2 radio buttons: All Pages and Pages from:_ 
to:_. Unless you specify a range, OpenBook will emboss all 
pages contained within a document.  

To specify an Emboss Range: 

1. Press ALT+F, E to open the Emboss dialog box.  

2. Press TAB until you hear “All Pages checked.”  

3. Use your UP or DOWN ARROW keys to make your 
selection. If you choose Pages from:_ to:_, be sure to 
TAB to the Edit boxes and type in a number. 

4. Once you have selected your new page range, you can 
change more emboss parameters or press TAB to 
move to the Ok button and then press ENTER to 
emboss your document. 

Mark Emphasis Text 

Emphasis text is text that is bold, underlined and/or in italics. 
This item (enabled by default and only available when 
embossing in contracted Braille) indicates when text has 
emphasis.  

To disable Mark Emphasis Text: 

1. Press ALT+F, E to open the Emboss dialog box.  

2. Press TAB until you hear, “Mark Emphasis Text.” 
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3. A check in this box means bold, underline and/or italic 
text is marked.  

4. If you want to emboss without marking Emphasis Text, 
press SPACEBAR to uncheck this box. 

5. To emboss your document, press TAB to move to the 
Ok button and then press ENTER.  
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Book 16 

Book Search 

Quick Book Search 

OpenBook helps you quickly search a variety of sources for 
books in electronic format. Use the Book Search feature to 
download your favorite books from the Baen Free Library, 
Bookshare.org, and Project Gutenberg. 

To search for a book: 

1. From the Launch menu, choose Book Search. Select 
Quick Search… from the submenu. Alternatively, you 
can press ALT+C, B, Q. 

2. Enter the title and/or author of the book you are 
searching for.  

3. Press ALT+S. Choose the online book providers you 
want to include in the search by selecting the 
corresponding check boxes. Clear the check boxes 
next to the providers you do not want to include in the 
search.  

Note:  In order to download copyrighted books from 
BookShare.org, you must establish a Bookshare.org 
user account. If you have an account, press ALT+L to 
select the Login to Bookshare.org check box. When 
you begin the book search, OpenBook will ask you to 
enter the e-mail address and password for your 
Bookshare.org account. If you do not select the Login 
to Bookshare.org check box, OpenBook will only 
search Bookshare.org for books that are not 
copyrighted.  
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4. Activate the Begin Search button or press ALT+B to 
search for books. OpenBook displays a list of books 
that match your criteria.  

Note:  If you cannot find the book(s) you want to download, 
you can revise your search. Activate the Revise 
Search button (or press ALT+R) and then enter a 
different title and/or author. Additionally, when 
searching Bookshare.org, books that are only available 
remotely are not included in the results list. 

5. When the search is complete, use the UP and DOWN 
ARROW keys to scroll through the list. Press 
SPACEBAR to select the check boxes next to the 
books you want to download.  

6. Activate the Download button or press ALT+D to begin 
downloading the books. The file(s) are saved in the 
Books folder of your Library. Even if you have changed 
the default file location in the General Settings dialog 
box, downloaded books are always saved in this folder. 

7. When the download is complete, activate the Open 
Files Now button to view your downloaded books. 
Activate the Done button to view the file(s) at a later 
time.  

Advanced Book Search 

The Advanced Book Search feature provides you with 
additional search options.  

To perform an advanced search: 

1. From the Launch menu, choose Book Search. Select 
Advanced Search… from the submenu. Alternatively, 
you can press ALT+C, B, A. 
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Note:  You can also activate the Advanced Search button in 
any dialog box. 

2. Enter keywords to search for in the Contains edit box.  

3. In the Search combo box, choose whether to search for 
these keywords in the titles or author names. Repeat 
this process for the second edit box.  

4. Choose one of the following options: 

• Ignore – Ignore books with titles or authors 
containing the keyword specified in the second edit 
box.  

• And – Search for all keywords you enter in both edit 
boxes. 

• Or – Search for books with titles or authors 
containing keywords in either the first edit box OR 
the second edit box. 

5. Press ALT+S. Choose the online book providers you 
want to include in the search by selecting the 
corresponding check boxes. Clear the check boxes 
next to the providers you do not want to include in the 
search. 
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Note:  In order to download copyrighted books from 
BookShare.org, you must establish a Bookshare.org 
user account. If you have an account, press ALT+L to 
select the Login to Bookshare.org check box. When 
you begin the book search, OpenBook will ask you to 
enter the e-mail address and password for your 
Bookshare.org account. If you do not select the Login 
to Bookshare.org check box, OpenBook will only 
search Bookshare.org for books that are not 
copyrighted. 

Activate the Begin Search button or press ALT+B to search 
for books. Choose and download books just as you would 
during a Quick Search. 
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Book 17 

Using Your Notetaker 

Supported Notetakers 

You can access your notetaker files using OpenBook as the 
interface. Currently, Braille Lite, Type Lite, Braille ‘n Speak, 
Type ‘n Speak, Braille Note, and Voice Note notetakers are 
supported. You can also use your PAC Mate with 
OpenBook. 

Preparing Your Notetaker 

If you are using your notetaker as a Braille display with a 
screen reader, you will need to disable your Braille display 
settings in both your notetaker and screen reader before 
transferring any files.  

Freedom Scientific Notetakers 

First, you must connect your notetaker to your computer with 
the serial cable supplied. Next, press O-CHORD, W-CHORD 
(DOTS 1-3-5 CHORD, DOTS 2-4-5-6 CHORD) to prepare 
your notetaker to communicate with your PC.  

Freedom Scientific's PAC Mate 

Freedom Scientific's PAC Mate with Pocket PC uses 
ActiveSync to communicate with OpenBook. To move files 
between OpenBook and your PAC Mate, perform the 
following: 

1. Ensure that ActiveSync is installed on your computer. 
ActiveSync is included on your PAC Mate Companion 
CD. 
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2. Connect your PAC Mate to your computer using the 
supplied USB cable. 

3. ActiveSync detects the connection and starts 
automatically. If you have not already done so, you 
must establish a partnership between ActiveSync and 
your PAC Mate. 

Note:  If ActiveSync does not automatically detect the PAC 
Mate, start ActiveSync on your computer. Open the File 
menu and choose Get Connected.  

4. OpenBook and PAC Mate are now ready to exchange 
files. 

Pulse Data HumanWare Products 

Pulse Data/HumanWare Notetakers use Microsoft 
ActiveSync to communicate with a PC.  

1. Connect your notetaker to your computer using the 
serial cable supplied.   

2. Launch ActiveSync from your computer.  

3. On your BrailleNote, press U (DOTS 1-3-6) to open the 
Utilities Menu. 

4. From the ActiveSync File Menu (ALT+F), select Get 
Connected (G).  

5. Then on your notetaker press C (DOTS 1-4) to connect 
to ActiveSync.  

Setting Up OpenBook 

Before using OpenBook with your notetaker, you must first 
define your notetaker communication parameters with 
OpenBook.  
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1. From the File Menu (ALT+F) select Notetaker (T). This 
opens the Notetaker submenu, which has two items: 
Open from and Save to.  

2. Use your UP or DOWN ARROW key to select a menu 
item, then press ENTER.   

3. This launches the “Setup your Notetaker dialog box.”  

4. With the Notetaker combo box active, use your UP or 
DOWN ARROW key to select your notetaker. 

5. Then press ENTER on the Setup your Notetaker dialog 
box to complete the connection. 

If you own a Pulse Data HumanWare Product, be sure to 
complete the steps outlined above. 

Using Auto-Detect 

If you own a Freedom Scientific Product, you can use the 
Auto-Detect Freedom Scientific Notetaker button (ALT+A). 
This button automatically detects your notetaker type and 
communication parameters.  

Manually Setting Up OpenBook 

Or if you prefer, follow the rest of these steps to manually set 
up your communication parameters.  

1. Press TAB to move to the Connection combo box. 

2. Use your UP or DOWN ARROW key to select the Com 
Port to which your notetaker is connected to your 
computer. 

3. Press TAB to move to the Baud Rate control. Select 
the baud rate that matches the one set on your 
notetaker. 
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4. Press TAB again to move to the Always Prompt for 
Notetaker check box. Place a check in this box if you 
use more than one notetaker with OpenBook.  

Note:  Any communication parameter changes that need to be 
made should be done from the Notetaker Properties 
page, which is accessed from the Settings Menu.  

5. Press ENTER to activate the Ok button. 

Changing Settings 
1. Press ALT+G or click on the Settings Menu. 

2. Press N or select Notetaker Settings to open the 
Notetaker Settings Properties page.  

3. With the Notetaker combo box active, use your UP or 
DOWN ARROW key to select your notetaker. 

4. Press TAB to move to the Connection combo box and 
select the Com Port to which your notetaker is 
connected to your computer. 

5. Press TAB to move to the Baud Rate control. Select 
the baud rate that matches the one set on your 
notetaker. 

6. Press TAB again to move to the Always Prompt for 
Notetaker check box. Place a check in this box if you 
use more than one notetaker with OpenBook.  

7. Press TAB to move to the Apply button, then press 
SPACEBAR to activate the button. 

8. Press ENTER to activate the Ok button. This exits the 
properties page. 

Opening Files 

To open files from your notetaker: 
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1. From the File Menu (ALT+F) select Notetaker (T). This 
opens the Notetaker submenu, which has two items: 
Open from and Save to.  

2. Use your UP or DOWN ARROW key to select, Open 
from, then press ENTER.    

3. From the Select a file to open dialog box, press 
SHIFT+TAB to move into the files list.  

4. Use your UP or DOWN ARROW key to select a file, 
then press ENTER.    

Saving Files  

To save files to your notetaker: 

1. From the File Menu (ALT+F) select Notetaker (T). This 
opens the Notetaker submenu, which has two items: 
Open from and Save to.  

2. Use your UP or DOWN ARROW key to select, Save to, 
then press ENTER.    

3. Type a name for the file you want to save.  

4. Press SHIFT+TAB to move into the files list.  

5. Use your UP or DOWN ARROW key to select a folder 
in which you want to save your file, then press ENTER. 
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Book 18 
Launchable Applications 

Launchable Applications are word processing or Braille 
transcription applications that you can start from OpenBook’s 
Launch Menu. When you start an application from the 
Launch Menu, the new application becomes active while 
OpenBook runs in the background. Documents, originally 
opened in OpenBook, open in the file format of the new 
application.  

Note:  You may need screen-reading software to read 
documents in some of these launchable applications.  

To move between applications, hold down the ALT key, and 
press the TAB key. You may need to press TAB more than 
once to cycle through each application. When you reach the 
application you want active, release both keys 
simultaneously.  

Adding New Launchable Applications 

You can choose to have OpenBook search for and add 
standard launchable applications such as Microsoft Word, 
WordPad, or Notepad, or you can manually add specific 
applications you want to use as launchable applications. 

To add standard launchable applications, press ALT+C to 
open the Launch menu and select Setup Standard 
Launchables. OpenBook begins searching your computer for 
standard word processing and Braille translation applications 
and adds them to the Launch menu. As this can take several 
minutes, you can activate the Cancel button at any time to 
abort the search. Once this process completes, OpenBook 
displays a dialog box stating how many applications were 
found. Activate the OK button to close this dialog box.  
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To add a launchable application manually, do the following: 

6. From the Launch menu, choose Manage 
Launchables. Select Add… from the sub-menu. 
Alternatively, you can press ALT+C, M, A. 

7. OpenBook displays the Add Launch Application dialog 
box.  

8. In the Menu Name edit box, enter the name of the 
launchable application. This is the name that will 
appear on the Launch menu. 

9. In the Program Path edit box, enter the location and 
name of the file used to start the application.  

If you do not know the location and/or name of the file, 
press ALT+B to activate the Browse for Program 
button. Locate the file that starts the application and 
select it. Press ENTER to insert the location and name 
of the file into the Program Name edit box. 

If you know the name of the file, but not the location, 
press ALT+S to activate the Automatic Search for 
Program  button. Enter the name of the file and press 
ENTER to activate the OK button. OpenBook locates 
the file and inserts the full path and file name into the 
Program Name edit box. 

10. If you want to apply parameters to the command line 
enter any command line arguments in the Command 
Line Argument edit box. You must know what 
command line arguments the application will accept. 
For example, using /A with NotePad forces NotePad to 
open a text file as ASCII text. To find out what 
command line arguments can be used with a specific 
application, refer to the documentation for that program. 
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11. If you want to minimize the application after it is started, 
press ALT+N and select the Minimize on Launch 
check box.  

6. If you want OpenBook to export the active document to 
the application when you launch it, press ALT+X to 
select the Export Document check box. Press TAB 
and enter the folder location where you want OpenBook 
to save the exported document in the Export 
Document To edit box. 

Note:  If you do not know the exact path of the export folder, 
press TAB and then press SPACEBAR on the Browse 
for Folder button. This allows you to browse for the 
folder you want to export documents to. 

6. If you want to convert the active OpenBook document 
into a file format used by the launchable application, 
make a selection in the Save as Type combo box. Use 
the UP and DOWN ARROW keys to select the format 
you want to use when converting documents for this 
launchable application. 

7. Activate the Add button or press ALT+A to add the 
application to the Launch menu. 

Editing Launchable Applications 

To edit the menu name, command line parameters, 
conversion settings, and other options for a launchable 
application: 

5. From the Launch menu, choose Manage 
Launchables. Select Edit… from the sub-menu. 
Alternatively, you can press ALT+C, M, E. 

6. OpenBook displays the Launch Programs dialog box, 
which contains a list of all launchable applications.  
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7. Use the UP and DOWN ARROW keys to select the 
launchable application you want to edit. Then press 
TAB and activate the Edit button. 

7. OpenBook displays the current information and settings 
for the application in the Edit Launch Program dialog 
box. This dialog box is identical to the Add Launch 
Application dialog box. 

8. Modify the settings for the launchable application. Refer 
to “Adding Launchable Applications” for more 
information on the options available in this dialog box. 

9. When you have finished, activate the Update button or 
press ALT+U to save your changes. 

Deleting Launchable Applications 

To remove an application from the Launch menu: 

11. From the Launch menu, choose Manage 
Applications. Select Delete… from the sub-menu. 
Alternatively, you can press ALT+C, M, D. 

12. OpenBook displays the Launch Programs dialog box, 
which contains a list of all launchable applications.  

13. Use the UP and DOWN ARROW keys to select the 
launchable application you want to remove. Then press 
ENTER to activate the Delete button. 

14. Activate the Yes button or press ALT+Y to confirm that 
you want to remove the application from the Launch 
menu.  

OpenBook confirms that the application has been removed. 
Press ENTER to activate the OK button. 
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Book 19 
Using a Braille Display  

Using a Braille display offers tactile access to the OpenBook 
environment. This multi-sensory approach adds an essential 
dimension to your computer experience as you are more 
able to fully conceptualize your Windows operating system. 
Keys on your Braille display allow multidirectional movement 
on your computer screen while drop-down menus, dialog 
boxes, and edit fields are shown on your Braille display.  

OpenBook has many features to enhance Braille reading 
with your display. You can configure whether or not text on 
your display is shown in contracted Braille. You can also 
specify your Braille displays panning increment and text 
alignment. To learn more about OpenBook and the controls 
that set your Braille display, explore the Braille Basic 
Settings dialog box. 

To open the Braille Basic Settings dialog box, press ALT+G 
or click on the Settings menu. Then, move to and press 
ENTER on Braille Basic Settings. 

If you use OpenBook in conjunction with another screen 
reader that provides Braille support, such as JAWS, the 
Braille features in OpenBook will be unavailable as the 
screen reader will handle the Braille output. If you want to 
use the built-in Braille features in OpenBook, you must 
disable the screen reader. In addition, you can not use 
Braille in OpenBook if MAGic screen magnification software 
is currently running. 
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Enabling Braille 

To enable Braille, press ALT+G or click on the Settings 
menu and choose Enable Braille. When enabled, a check 
mark appears next to this option. Repeat this process to turn 
it off. 

If you have a Freedom Scientific Focus Braille display or 
PAC Mate™ Portable Braille Display, OpenBook will 
automatically detect the display and you can begin using 
Braille right away. If you have a Braille display from another 
manufacturer, you must use the Braille Manager to add the 
display so it will be recognized by OpenBook. 

Adding a Braille Display 

If your Braille display was not automatically detected, do the 
following to add your display: 

6. Press ALT+G or click on the Settings menu and select 
Braille Manager to open the Braille Manager dialog box. 

7. When this dialog box opens, you are placed in a tree 
view that lists the Braille displays currently installed, if 
any. Press TAB to move to the Add, Remove, or 
Change Devices button and press ENTER. 

8. In the list view, use the arrow keys to select your display 
and press the SPACEBAR to check it. You can add as 
many displays as you want. When finished, select the 
Next button. 

9. In the Primary Device combo box, select the Braille 
display you want OpenBook to use as the default and 
choose Next. 
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10. In the Select the output port edit combo, choose the port 
your Braille display is connected to. For example, USB, 
com1, com2, etc. If you are adding more than one 
display, select Next until you have configured each 
display. 

11. Press ENTER on Finish to return to the list of installed 
Braille displays and press ENTER on Close to exit the 
Braille Manager dialog box. 

To begin using the display, you must open the Settings 
menu and toggle the Enable Braille setting off and back on 
so OpenBook will detect the display. 

Changing the Default Braille Display 

If you have more than one display installed in OpenBook, 
you can change which one is the default display. 

To change the default Braille display: 

6. Press ALT+G or click on the Settings menu and select 
Braille Basic Settings to open the Braille Basic Settings 
dialog box. 

7. In the Default Braille Display combo box, select the 
Braille display you would like to use, then select the OK 
button. 

To begin using the display, you must open the Settings 
menu and toggle the Enable Braille setting off and back on 
so OpenBook will detect the display. 

Braille Translation Options 

You can view text on your display in either contracted Braille 
or computer Braille. OpenBook also has the ability to do 
Braille contractions and Braille translation in either 
Contracted English Braille or Unified English Braille (UEB). 
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To configure these options, press ALT+G or click on the 
Settings menu, select Braille Basic Settings, and activate the 
Advanced button. When the Braille Options dialog box 
opens, press TAB to move to the following controls: 

8. Enable Translator: Select this check box to have 
contracted Braille sent to your Braille display. In 
computer Braille, each character is represented by a 
single Braille cell. In contracted Braille, certain 
combinations of letters are combined into a shorter 
form, and more information is displayed at one time. 
This check box is uncheck by default. 

9. Contracted or Unified English Braille: Select the 
Contracted English Braille radio button to configure 
OpenBook for contracted English Braille. Select the 
Unified English Braille radio button to configure 
OpenBook for UEB. The default selection is contracted 
English Braille. 

10. Expand Current Word: If this check box is checked, 
and the translator is enabled, the word at the Braille 
cursor location is displayed in computer Braille. If the 
translator is enabled and this check box is cleared, the 
Braille cursor rests at the beginning of the word and 
only moves as you navigate from word to word. It is 
helpful to check this option when editing documents 
while using contracted Braille. This check box is 
checked by default. 

11. Suppress Capital Signs: In contracted Braille, 
OpenBook indicates capital letters by preceding them 
with the DOT 6 character. If you select this check box, 
OpenBook does not use capital indication in order to 
preserve space on your Braille display. This check box 
is cleared by default. 
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Braille Flash Messages 

Braille Flash Messages are short announcements that 
appear on your Braille display for only a few seconds. These 
messages can announce application start messages, error 
messages, OpenBook messages, context help messages, 
status information, and user requested information.  

Braille Flash Messages disappear automatically after a short 
time, but you can dismiss one at any time by pressing a 
cursor routing button. If you need more time to finish reading 
a message, press one of your Braille display's panning 
buttons to keep the message on the display longer.  

Do the following to turn Braille Flash Messages on or off, 
change the message verbosity level, and specify the length 
of time messages remain on the display: 

5. Press ALT+G or click on the settings menu and select 
Braille Basic Settings to open the Braille Basic Settings 
dialog box. 

6. Activate the Advanced button to open the Braille Options 
dialog box, press TAB to move to the Flash Messages 
button, and press ENTER. 

7. In the Flash Message Time Out combo box, Select the 
length of time (in milliseconds) that you want Braille 
Flash Messages to remain on your Braille display. You 
can choose a value between zero and 30,000 
milliseconds. 1,000 milliseconds are equivalent to 1 
second. Select "Manually Clear Only," if you want the 
message to remain on the display until you press a 
cursor routing button. 
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8. Select the Enable Flash Messages check box if you want 
OpenBook to announce information by using Braille 
Flash Messages. Clear this check box to disable these 
Messages. 

9. Select the Enable Message Prefixes check box to have 
OpenBook display a special prefix before Braille Flash 
Messages to distinguish them from screen text. This 
prefix is a three-letter abbreviation that indicates the 
source of the message. If your Braille display has status 
cells, OpenBook uses those to indicate that the text is a 
Braille Flash Message regardless of whether you select 
this check box. Clear this check box if you do not want 
to use this feature. 

10. In the Verbosity Level radio buttons, choose Beginner, 
Intermediate, or Advanced depending on the types of 
messages you want to receive. To further customize 
what is displayed at each level, press ENTER on the 
Beginner, Intermediate, or Advanced Preferences 
buttons and check or uncheck the messages you want. 

11. When you are finished customizing the Braille Flash 
Messages, select OK to return to the Braille Options 
dialog box, select OK again to return to the Braille Basic 
Settings dialog box, and select the Close button. 

Linking and Unlinking the Cursor 
There are two settings that determine how a Braille display affects 
or is affected by the active cursor. 

Braille Follows Active: When set, as you move through 
OpenBook, the information at the active cursor is 
displayed in Braille. For example, when you move 
through the controls in a dialog box, information about 
the active control is displayed in Braille. 
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Active Follows Braille: When set, the active cursor follows 
the Braille Cursor. However, the Braille Cursor cannot 
move where the active cursor cannot go. For example, 
with this option set, you cannot move the Braille cursor 
to the title bar of the active window. 

To change these settings: 

12. Press ALT+G or click on the Settings menu and select 
Braille Basic Settings to open the Braille Basic Settings 
dialog box. 

13. Press TAB to move to the Advanced button and press 
ENTER. 

14. Press TAB to move to the Active Follows Braille and 
Braille Follows Active check boxes and check or 
uncheck these options depending on your preference. 

Status Cells 
For those Braille displays that have Status Cells, they are 
generally located on the left of the display. These cells greatly 
enhance your Braille viewing and understanding of text 
formatting. The number of status cells in your Braille display 
determines the type and amount of information displayed. 

Along with Status Cells, DOTS 7 and 8 of each cell indicates 
the current state of text relative to your Braille display.  

For instance: 

If DOTS 7 and 8 are up on all cells of your display, then the 
current line of text is completely displayed.  

If text is shown on only one side of your Braille display, then 
DOTS 7 and 8 will be raised on the status cells for that 
side, and down for the other.  
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If there is one more line of text to be shown on the display's 
right, then DOTS 7 and 8 in the last status cell will be 
down.  

If there is two or more full lines of text to be shown on the 
display's right, then DOTS 7 and 8 of the last two status 
cells will be down.  

A blinking DOT 7 and a blinking DOT 8 indicates the position 
of the status cell and Braille cursor, which corresponds 
to the character on the screen.  

To change options for status cells: 

Press ALT+G or click on the Settings menu and select 
Braille Basic Settings to open the Braille Basic Settings 
dialog box. 

Press TAB to move to the Advanced button and press 
ENTER. 

Press ENTER on the Advanced Braille Display Settings 
button. 

In the group of radio buttons, select where you would like the 
status cells to appear on the display. Your choices are 
Left (default), Right, or None. 

Changing the Braille Cursor 

By default, the Braille cursor is represented by DOTS 7 and 
8. However, you can change the dot pattern used for the 
cursor as well as whether it blinks or not. 

To change cursor settings: 

Press ALT+G or click on the Settings menu and select 
Braille Basic Settings to open the Braille Basic Settings 
dialog box. 
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Press TAB to move to the Advanced button and press 
ENTER. 

Press TAB to move to Cursor Settings and press ENTER. 

In the Dot Pattern edit box, type the dot pattern you would 
like to use to represent the cursor. For example, 78. 

In the group of radio buttons, choose whether you want the 
cursor to blink, be always down so it is not shown on 
the display, or always up. 

In the Blink Rate edit box, enter a number to specify the rate 
at which the Braille cursor blinks. The default is 500 
milliseconds. 
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Book 20 
OpenBook with Multiple Users  

Enabling Multiple Users 

For those environments where there are many OpenBook 
users, but only one computer, OpenBook allows for more 
than one user to login and have their individual preferences, 
settings, and library. Select enable Multiuser Login from the 
Advanced Menu (ALT+A) to switch between multiuser and 
single-user mode.  When you uncheck this item, OpenBook 
switches to single-user mode, and does not display the User 
Log In screen when you launch the program.  

Note:  This item is always enabled in the network version of 
OpenBook. 

It is good practice for an OpenBook user who is in a public 
setting to log off when they are done working. This way the 
next user can easily login. To log off, go to the File Menu 
(ALT+F) and select the Log Off menu item. This opens the 
Log In dialog box, which prepares OpenBook for the next 
user login.   

Logging In  

The Log In dialog box is only available when the Multiuser 
Login is enabled in the Advanced Menu. If you have never 
logged in as a user you will need to type in your name and 
then press TAB to move to the Ok button. When you arrive 
at the Ok button, press ENTER.  
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If you have previously logged in as a user, your login name 
will be among the names in the ‘Please Sign In Here’ combo 
box. In this case, use the UP or DOWN Arrow key to locate 
your name or simply press the first letter of your name until 
you see and/or hear it spoken. Next, press TAB to move to 
the Ok button. When you arrive at the Ok button, press 
ENTER.  
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Book 21 

Desktop Keyboard Layout 

Reading 

Number Announcement Toggle CTRL+SHIFT+N 

Read Dialog Box in Tab Order  INSERT+B 

Read Default Button of Dialog Box INSERT+E 

Read Current Dialog Box Control INSERT+TAB 

Say Character  NUM PAD 5 

Say Word  INSERT+NUM PAD 5 

Spell Word  INSERT+NUM PAD 5 
twice 

Spell Word Phonetically  INSERT+NUM PAD 5 
three times 

Say Line  INSERT+UP ARROW 

Say Sentence  ALT+NUM PAD 5 

Say Paragraph  CTRL+NUM PAD 5 

Say To Cursor  INSERT+HOME 

Say From Cursor  INSERT+PAGE UP 

Say Top Line of Window  INSERT+END 

Read Status Bar  INSERT+PAGE DOWN 

Say Window Title  INSERT+T 

Say All  INSERT+DOWN 
ARROW or F12 
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Skim Read  CTRL+INSERT+DOWN 
ARROW 

Fast Forward/Rewind (during Say All or skimming)   
  LEFT/RIGHT ARROW 
  or LEFT SHIFT/RIGHT 
  SHIFT 

Silence Speech  CTRL 

Audio File Navigation 

Start/Stop Audio Playback INSERT+DOWN 
ARROW 

Pause Playback      CTRL 

Move to the Next Heading or Audio File DOWN ARROW 

Move to the Previous Heading or Audio File UP ARROW 

Expand a subheading (in DAISY files only) RIGHT ARROW 

Close a subheading (in DAISY files only)  LEFT ARROW 

Say Current Heading or Audio File INSERT+NUM PAD 
5 

Move to the First Heading or Audio File  CTRL+HOME 

Move to the Last Heading or Audio File  CTRL+END 

Fast Forward Five Seconds RIGHT ARROW or 
RIGHT SHIFT 

Rewind Five Seconds LEFT ARROW or 
LEFT SHIFT 

Increase audio Rate for DAISY Files ALT+CTRL+PAGE 
UP 
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Decrease audio rate for DAISY Files ALT+CTRL+PAGE 
DOWN 

Navigation 

Back Space  BACKSPACE 

Go To Bookmark  F9 

Open Go To Dialog box  CTRL+G 

Go To Next item (page, comment, or highlight) as specified 
in Go To dialog box  F5 

Go To Prior item (page, comment, or highlight) as specified 
in Go To dialog box  SHIFT+F5 

Say Next Character (Edit Mode) RIGHT ARROW (moves 
by word in Read-only 
mode) 

Say Prior Character (Edit Mode) LEFT ARROW (moves 
by word in Read-only 
mode) 

Say Next Word   CTRL+RIGHT ARROW, 
  INSERT+RIGHT  
  ARROW, or RIGHT  
  ARROW when in Read- 
  only Mode 

Say Prior Word  CTRL+LEFT ARROW, 
  INSERT+LEFT ARROW, 
  or LEFT ARROW when 
  in Read-Only Mode 

Say Next Line  DOWN ARROW 

Say Prior Line  UP ARROW 
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Say Next Sentence  ALT+DOWN ARROW 

Say Prior Sentence  ALT+UP ARROW 

Say Next Paragraph  CTRL+DOWN ARROW 

Say Prior Paragraph  CTRL+UP ARROW 

Next Page  CTRL+PAGE DOWN 

Prior Page  CTRL+PAGE UP 

Page Down  PAGE DOWN 

Page Up  PAGE UP 

End of File  CTRL+END 

Top of File  CTRL+HOME 

Help 

Context Sensitive Help  SHIFT+F1 

Help  F1 

Keyboard Help  INSERT+1 

Where Am I  CTRL+SHIFT+F12 

Text Selection 

Select Next Character (Edit Mode) SHIFT+RIGHT ARROW 

Select Prior Character (Edit Mode) SHIFT+LEFT ARROW 

Select Next Word  CTRL+SHIFT+RIGHT 
  ARROW,    
  INSERT+SHIFT+RIGHT 
  ARROW, or   
  SHIFT+RIGHTARROW 
  in Read-only Mode 



 

 

204 

Select Prior Word    CTRL+SHIFT+LEFT 
       ARROW,    
       INSERT+SHIFT+LEFT 
       ARROW, or   
       SHIFT+LEFT ARROW in 
       Read-only Mode 

Select Next Line  SHIFT+DOWN ARROW 

Select Prior Line  SHIFT+UP ARROW 

Select to End of Line  SHIFT+END 

Select to Beginning of Line  SHIFT+HOME 

Select Next Page  SHIFT+PAGE DOWN 

Select Prior Page  SHIFT+PAGE UP 

Select to Beginning of Page  CTRL+SHIFT+HOME 

Select to End of Page  CTRL+SHIFT+END 

Select All text on current page  CTRL+A 

Say Selected Text  INSERT+SHIFT+DOWN 
ARROW 

Acquisition 

Toggle Recognize Columns  CTRL+SHIFT+Z 

Acquire  F4 or SPACEBAR when 
  in Read-only Mode 

Acquire and Replace Current Page CTRL+SHIFT+F4 

Mail Sorter Preview    CTRL+SHIFT+F3 

BuckScan Money Identifier  CTRL+M 
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Acquisition Context Menu  APPLICATIONS Key 

Visual Settings 

Cycle Between Views  CTRL+SHIFT+V 

Font Background Color  CTRL+5 

Font Size – Increase  CTRL+4 

Font Size – Decrease  CTRL+3 

Font Spacing – Increase  CTRL+8 

Font Spacing – Decrease  CTRL+7 

Font Type  CTRL+6 

Toggle Two Tone  CTRL+2 

Scroll Exact View Down  ALT+CTRL+DOWN 
ARROW 

Scroll Exact View Left  ALT+CTRL+LEFT 
ARROW 

Scroll Exact View Right  ALT+CTRL+RIGHT 
ARROW 

Scroll Exact View Up  ALT+CTRL+UP 
ARROW 

Pan Down Incrementally   CTRL+WINDOWS 
Key+DOWN ARROW 

Pan Up Incrementally    CTRL+WINDOWS 
Key+UP    ARROW 

Pan Left Incrementally   CTRL+WINDOWS 
Key+Left    ARROW 
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Pan Right Incrementally   CTRL+WINDOWS 
Key+RIGHT    ARROW 

Pan Up One Screen   PAGE UP 

Pan Down One Screen   PAGE DOWN 

Pan to Top Left   WINDOWS Key+HOME 

Pan to Top Right   WINDOWS Key+PAGE  
  UP 

Pan to Bottom Left   WINDOWS Key+PAGE  
  DOWN 

Pan to Bottom Right   WINDOWS Key+END 

Pan Down Smoothly   WINDOWS Key+DOWN  
  ARROW 

Pan UP Smoothly   WINDOWS Key+UP  
  ARROW 

Pan Left Smoothly   WINDOWS Key+LEFT  
  ARROW 

Pan Right Smoothly   WINDOWS Key+RIGHT  
  ARROW 

Increase Smooth Panning Speed  PLUS 

Decrease Smooth Panning Speed  MINUS 

Increase Zoom Level  CTRL+PLUS (Press and 
hold to zoom continuously until you reach the desired zoom 
level) 

Decrease Zoom Level  CTRL+MINUS (Press 
and hold to zoom continuously until you reach the desired 
zoom level) 
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Zoom to Page Width  CTRL+SHIFT+W 

Zoom to Page Height  CTRL+SHIFT+H 

Zoom to Default Zoom Level  CTRL+SHIFT+D 

Rotate Image Right  CTRL+SHIFT+R 

Rotate Image Left  CTRL+SHIFT+L 

Toggle Camera Light  CTRL+L 

Center Image  WINDOWS Key+C 
(Exact View and Camera 
View) 

Drag Image  ALT+LEFT MOUSE 
BUTTON (press and 
hold then move to drag 
image in Exact View and 
Camera View) 

OpenBook Feature Hotkeys 

Insert Bookmark  CTRL+F9 

Delete Bookmark  CTRL+SHIFT+F9 

Insert Comment  ALT+CTRL+M 

Delete Comment  SHIFT+DELETE 

Edit Comment  ALT+ENTER 

Say Comment  ALT+SHIFT+ 
APOSTROPHE 

Begin/End Highlight  CTRL+F11 

Highlight Selected Text  ALT+F11 

Cancel Highlight  ESC 
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Remove Highlight  CTRL+SHIFT+F11 

Say Highlight  ALT+CTRL+F11 

Toggle Highlight Announcement ALT+SHIFT+F11 

Next Highlight  F11 

Prior Highlight  SHIFT+F11 

Copy to Clipboard  CTRL+C 

Cut to Clipboard (Edit mode)  CTRL+X 

Paste from Clipboard (Edit mode) CTRL+V 

Delete Current Page  CTRL+DELETE 

Delete Character (Edit Mode)  DELETE 

Dictionary  CTRL+D or F8 

Edit Mode/Read-only Mode toggle CTRL+E 

Move Page Down in Exact View ALT+PAGE DOWN 

Move Page Up in Exact View  ALT+PAGE UP 

Insert Page Break (Edit Mode)  CTRL+ENTER 

Delete Page Break (Edit Mode) CTRL+SHIFT+DELETE 

Find text  CTRL+F 

Find next occurrence of text  CTRL+SHIFT+F 

Replace text (Edit Mode)  CTRL+H 

Spell Check  F7 

Thesaurus  CTRL+T 

Undo  CTRL+Z 
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Decrease Voice Rate  ALT+CTRL+PAGE
 DOWN 

Increase Voice Rate  ALT+CTRL+PAGE UP 

Mute Synthesizer  CTRL+F5 

Close Document Window  CTRL+F4 

Document Toggle  CTRL+F6 

New File  CTRL+N 

Open File  CTRL+O 

Open Audio Directory  CTRL+R 

Print  CTRL+P 

Save Current Page  CTRL+SHIFT+S 

Save Document  CTRL+S 

Exit OpenBook  ALT+F4 
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Book 22 

Laptop Keyboard Layout 

Reading 

Number Announcement Toggle CTRL+SHIFT+N 

Read Dialog Box in Tab Order  CAPSLOCK+B 

Read Default Button of Dialog Box CAPSLOCK+E 

Read Current Dialog Box Control CAPSLOCK+TAB 

Say Character  CAPSLOCK+COMMA 

Say Word  CAPSLOCK+K 

Spell Word  CAPSLOCK+K twice 

Spell Word Phonetically  CAPSLOCK+K three 
times 

Say Line  CAPSLOCK+UP
 ARROW or
 CAPSLOCK+I 

Say Sentence  CAPSLOCK+H 

Say Paragraph  CAPSLOCK+CTRL+I 

Say To Cursor  CAPSLOCK+SHIFT+J 

Say From Cursor  CAPSLOCK+PAGE UP
 or
 CAPSLOCK+SHIFT+L 

Say Top Line of Window  CAPSLOCK+END or
 CAPSLOCK+SHIFT+Y 

Read Status Bar  CAPSLOCK+SHIFT+N 
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Say Window Title  CAPSLOCK+T 

Say All  CAPSLOCK+DOWN 
ARROW,  
CAPSLOCK+A, or F12 

Skim Read  CTRL+INSERT+DOWN 
ARROW 

Fast Forward/Rewind (during Say All or skimming)   
  LEFT/RIGHT ARROW 
  or LEFT SHIFT/RIGHT 
  SHIFT 

Silence Speech  CTRL 

Audio File Navigation 

Start/Stop Audio Playback INSERT+DOWN 
ARROW 

Pause Playback      CTRL 

Move to the Next Heading or Audio File DOWN ARROW 

Move to the Previous Heading or Audio File UP ARROW 

Expand a subheading (in DAISY files only) RIGHT ARROW 

Close a subheading (in DAISY files only)  LEFT ARROW 

Say Current Heading or Audio File CAPSLOCK+K 

Move to the First Heading or Audio File  CTRL+HOME 

Move to the Last Heading or Audio File  CTRL+END 

Fast Forward Five Seconds RIGHT ARROW or 
RIGHT SHIFT 

Rewind Five Seconds LEFT ARROW or 
LEFT SHIFT 
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Increase audio Rate for DAISY Files ALT+CTRL+PAGE 
UP 

Decrease audio rate for DAISY Files ALT+CTRL+PAGE 
DOWN 

Navigation 

Back Space  BACKSPACE 

Go To Bookmark  F9 

Open Go To Dialog box  CTRL+G 

Go To Next item (page, comment, or highlight) as specified 
in Go To dialog box  F5 

Go To Prior item (page, comment, or highlight) as specified 
in Go To dialog box  SHIFT+F5 

Say Next Character (Edit Mode) RIGHT ARROW or 
CAPSLOCK+PERIOD 
(moves by word in Read-
only Mode)  

Say Prior Character (Edit Mode) LEFT ARROW or 
CAPSLOCK+M (moves 
by word in Read-only 
Mode) 

Say Next Word   CTRL+RIGHT ARROW, 
  INSERT+RIGHT  
  ARROW, or RIGHT  
  ARROW when in Read- 
  only Mode 
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Say Prior Word  CTRL+LEFT ARROW, 
  INSERT+LEFT ARROW, 
  or LEFT ARROW when 
  in Read-Only Mode 

Say Next Line  DOWN ARROW or  
  CAPSLOCK+O 

Say Prior Line  UP ARROW or   
  CAPSLOCK+U 

Say Next Sentence  ALT+DOWN ARROW 

Say Prior Sentence  ALT+UP ARROW or 
  CAPSLOCK+Y 

Say Next Paragraph  CTRL+DOWN ARROW 

Say Prior Paragraph  CTRL+UP ARROW or 
  CAPSLOCK+CTRL+U 

Next Page  CTRL+PAGE DOWN 

Prior Page  CTRL+PAGE UP 

Page Down  PAGE DOWN 

Page Up  PAGE UP 

End of File  CTRL+END 

Top of File  CTRL+HOME 

Help 

Context Sensitive Help  SHIFT+F1 

Help  F1 

Keyboard Help  INSERT+1 or
 CAPSLOCK+1 
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Where Am I  CTRL+SHIFT+F12 

Text Selection 

Select Next Character (Edit Mode) SHIFT+RIGHT ARROW 

Select Prior Character (Edit Mode) SHIFT+LEFT ARROW 

Select Next Word  CTRL+SHIFT+RIGHT 
  ARROW,    
  INSERT+SHIFT+RIGHT 
  ARROW, or   
  SHIFT+RIGHTARROW 
  in Read-only Mode 

Select Prior Word    CTRL+SHIFT+LEFT 
       ARROW,    
       INSERT+SHIFT+LEFT 
       ARROW, or   
       SHIFT+LEFT ARROW in 
       Read-only Mode 

Select Next Line  SHIFT+DOWN ARROW 

Select Prior Line  SHIFT+UP ARROW 

Select to End of Line  SHIFT+END 

Select to Beginning of Line  SHIFT+HOME 

Select Next Page  SHIFT+PAGE DOWN 

Select Prior Page  SHIFT+PAGE UP 

Select to Beginning of Page  CTRL+SHIFT+HOME 

Select to End of Page  CTRL+SHIFT+END 

Select All text on current page  CTRL+A 
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Say Selected Text  CAPS 
LOCK+SHIFT+DOWN 
ARROW or CAPS 
LOCK+SHIFT+A 

Acquisition 

Toggle Recognize Columns  CTRL+SHIFT+Z 

Acquire  F4 or SPACEBAR when 
  in Read-only Mode 

Acquire and Replace Current Page CTRL+SHIFT+F4 

Mail Sorter Preview    CTRL+SHIFT+F3 

BuckScan Money Identifier  CTRL+M 

Acquisition Context Menu  APPLICATIONS Key 

Visual Settings 

Cycle Between Views  CTRL+SHIFT+V 

Font Background Color  CTRL+5 

Font Size – Increase  CTRL+4 

Font Size – Decrease  CTRL+3 

Font Spacing – Increase  CTRL+8 

Font Spacing – Decrease  CTRL+7 

Font Type  CTRL+6 

Toggle Two Tone  CTRL+2 

Scroll Exact View Down  ALT+CTRL+DOWN 
ARROW 
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Scroll Exact View Left  ALT+CTRL+LEFT 
ARROW 

Scroll Exact View Right  ALT+CTRL+RIGHT 
ARROW 

Scroll Exact View Up  ALT+CTRL+UP 
ARROW 

Pan Down Incrementally   CTRL+WINDOWS 
Key+DOWN ARROW 

Pan Up Incrementally    CTRL+WINDOWS 
Key+UP    ARROW 

Pan Left Incrementally   CTRL+WINDOWS 
Key+Left    ARROW 

Pan Right Incrementally   CTRL+WINDOWS 
Key+RIGHT    ARROW 

Pan Up One Screen   PAGE UP 

Pan Down One Screen   PAGE DOWN 

Pan to Top Left   WINDOWS Key+HOME 

Pan to Top Right   WINDOWS Key+PAGE  
  UP 

Pan to Bottom Left   WINDOWS Key+PAGE  
  DOWN 

Pan to Bottom Right   WINDOWS Key+END 

Pan Down Smoothly   WINDOWS Key+DOWN  
  ARROW 

Pan UP Smoothly   WINDOWS Key+UP  
  ARROW 
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Pan Left Smoothly   WINDOWS Key+LEFT  
  ARROW 

Pan Right Smoothly   WINDOWS Key+RIGHT  
  ARROW 

Increase Smooth Panning Speed  PLUS 

Decrease Smooth Panning Speed  MINUS 

Increase Zoom Level  CTRL+PLUS (Press and 
hold to zoom continuously until you reach the desired zoom 
level) 

Decrease Zoom Level  CTRL+MINUS (Press 
and hold to zoom continuously until you reach the desired 
zoom level) 

Zoom to Page Width  CTRL+SHIFT+W 

Zoom to Page Height  CTRL+SHIFT+H 

Zoom to Default Zoom Level  CTRL+SHIFT+D 

Rotate Image Right  CTRL+SHIFT+R 

Rotate Image Left  CTRL+SHIFT+L 

Toggle Camera Light  CTRL+L 

Center Image  WINDOWS Key+C 
(Exact View and Camera 
View) 

Drag Image  ALT+LEFT MOUSE 
BUTTON (press and 
hold then move to drag 
image in Exact View and 
Camera View) 
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OpenBook Feature Hotkeys 

Insert Bookmark  CTRL+F9 

Delete Bookmark  CTRL+SHIFT+F9 

Insert Comment  ALT+CTRL+M 

Delete Comment  SHIFT+DELETE 

Edit Comment  ALT+ENTER 

Say Comment  ALT+SHIFT+ 
APOSTROPHE 

Begin/End Highlight  CTRL+F11 

Highlight Selected Text  ALT+F11 

Cancel Highlight  ESC 

Remove Highlight  CTRL+SHIFT+F11 

Say Highlight  ALT+CTRL+F11 

Toggle Highlight Announcement ALT+SHIFT+F11 

Next Highlight  F11 

Prior Highlight  SHIFT+F11 

Copy to Clipboard  CTRL+C 

Cut to Clipboard (Edit mode)  CTRL+X 

Paste from Clipboard (Edit mode) CTRL+V 

Delete Current Page  CTRL+DELETE 

Delete Character (Edit Mode)  DELETE 

Dictionary  CTRL+D or F8 
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Edit Mode/Read-only Mode toggle CTRL+E 

Move Page Down in Exact View ALT+PAGE DOWN 

Move Page Up in Exact View  ALT+PAGE UP 

Insert Page Break (Edit Mode)  CTRL+ENTER 

Delete Page Break (Edit Mode) CTRL+SHIFT+DELETE 

Find text  CTRL+F 

Find next occurrence of text  CTRL+SHIFT+F 

Replace text (Edit Mode)  CTRL+H 

Spell Check  F7 

Thesaurus  CTRL+T 

Undo  CTRL+Z 

Decrease Voice Rate  ALT+CTRL+PAGE
 DOWN 

Increase Voice Rate  ALT+CTRL+PAGE UP 

Mute Synthesizer  CTRL+F5 

Close Document Window  CTRL+F4 

Document Toggle  CTRL+F6 

New File  CTRL+N 

Open File  CTRL+O 

Open Audio Directory  CTRL+R 

Print  CTRL+P 

Save Current Page  CTRL+SHIFT+S 

Save Document  CTRL+S 
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Exit OpenBook  ALT+F4 
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Book 23 

Traditional (Ruby) Keyboard Layout 

Reading 

Read Dialog Box in Tab Order  CTRL+B 

Read Status Bar  CTRL+SHIFT+F10 

Say All  F10, F12 or NUM PAD
 ENTER 

Skim Through Document  SHIFT+F12 

Fast Forward/Rewind (during Say All or skimming)
 LEFT/RIGHT ARROW or
 LEFT SHIFT/RIGHT
 SHIFT 

Silence Speech  CTRL 

Audio File Navigation 

Start/Stop Audio Playback  F10, F12 or 
NUM PAD 
ENTER 

Pause Playback    CTRL 

Move to the Next Heading or Audio File DOWN 
ARROW 

Move to the Previous Heading or Audio File UP ARROW 

Expand a subheading (in DAISY files only) RIGHT 
ARROW 

Close a subheading (in DAISY files only)  LEFT 
ARROW 
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Say Current Heading or Audio File   NUM PAD 5 

Move to the First Heading or Audio File  CTRL+HOME 

Move to the Last Heading or Audio File  CTRL+END 

Fast Forward Five Seconds  RIGHT 
ARROW or 
RIGHT SHIFT 

Rewind Five Seconds  LEFT ARROW 
or LEFT 
SHIFT 

Increase audio Rate for DAISY Files CTRL+2 or 
NUM PAD 
ASTERISK 

Decrease audio rate for DAISY Files CTRL+1 or 
SHIFT+NUM 
PAD 
ASTERISK 

Navigation 

Go To Bookmark  F9 

Open Go To Dialog box  CTRL+G 

Go To Next item (page, comment, or highlight) as specified 
in Go To dialog box  F5 

Go To Prior item (page, comment, or highlight) as specified 
in Go To dialog box  SHIFT+F5 

Say Next Character (Edit Mode) RIGHT ARROW (moves 
by word in Read-only 
Mode) 
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Say Prior Character (Edit Mode) LEFT ARROW (moves 
by word in Read-only 
Mode) 

Say Next Word (Read-only Mode) RIGHT ARROW 

Say Prior Word (Read-only Mode) LEFT ARROW 

Say Next Line  DOWN ARROW 

Say Prior Line  UP ARROW 

Say Next Paragraph  CTRL+DOWN ARROW 

Say Prior Paragraph  CTRL+UP ARROW 

Next Page  CTRL+PAGE DOWN 

Prior Page  CTRL+PAGE UP 

Move Up One Screen  PAGE UP 

Move Down One Screen  PAGE DOWN 

End of File  CTRL+END 

Top of File  CTRL+HOME 

Help 

Help  F1 or NUM PAD MINUS 

Help, context-sensitive help  SHIFT+NUM PAD
 MINUS or SHIFT+F1 

Key Describer toggle  CTRL+F12 

Where Am I  NUM PAD 7 

Text Selection 

Select Next character (Edit Mode) SHIFT+RIGHT ARROW 
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Select Prior character (Edit Mode) SHIFT+LEFT ARROW 

Select Next Word  CTRL+SHIFT+RIGHT 
ARROW or 
SHIFT+RIGHT ARROW 
in Read-only Mode 

Select Prior Word  CTRL+SHIFT+LEFT 
ARROW or 
SHIFT+LEFT ARROW in 
Read-only Mode 

Select Next Line  SHIFT+DOWN ARROW 

Select Prior Line  SHIFT+UP ARROW 

Select Next Page  SHIFT+PAGE DOWN 

Select Prior Page  SHIFT+PAGE UP 

Select to beginning of page  CTRL+SHIFT+HOME 

Select to end of page  CTRL+SHIFT+END 

Select to beginning of line  SHIFT+HOME 

Select to end of line  SHIFT+END 

Select All text on current page  CTRL+A 

Acquisition 

Toggle Recognize Columns  CTRL+SHIFT+Z 

Acquire (Edit Mode)  F4 or NUM PAD INSERT 

Acquire (Read-only Mode)  SPACEBAR, F4, or 
NUM PAD INSERT 

Acquire and Replace Current Page CTRL+SHIFT+F4 
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Mail Sorter Preview    CTRL+SHIFT+F3 

BuckScan Money Identifier  CTRL+M 

Acquisition Context Menu  SHIFT+F10 

Visual Settings 

Cycle Between Views  CTRL+SHIFT+V 

Font size – increase     CTRL+4 

Font size – decrease   CTRL+3 

Font / Background Color   CTRL+5 

Font type      CTRL+6 

Font spacing – increase   CTRL+8 

Font spacing – decrease   CTRL+7 

Scroll Exact View Down  ALT+CTRL+DOWN 
ARROW 

Scroll Exact View Left  ALT+CTRL+LEFT 
ARROW 

Scroll Exact View Right  ALT+CTRL+RIGHT 
ARROW 

Scroll Exact View Up  ALT+CTRL+UP 
ARROW 

Pan Down Incrementally   CTRL+WINDOWS 
Key+DOWN ARROW 

Pan Up Incrementally    CTRL+WINDOWS 
Key+UP    ARROW 

Pan Left Incrementally   CTRL+WINDOWS 
Key+Left    ARROW 
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Pan Right Incrementally   CTRL+WINDOWS 
Key+RIGHT    ARROW 

Pan Up One Screen   PAGE UP 

Pan Down One Screen   PAGE DOWN 

Pan to Top Left   WINDOWS Key+HOME 

Pan to Top Right   WINDOWS Key+PAGE  
  UP 

Pan to Bottom Left   WINDOWS Key+PAGE  
  DOWN 

Pan to Bottom Right   WINDOWS Key+END 

Pan Down Smoothly   WINDOWS Key+DOWN  
  ARROW 

Pan UP Smoothly   WINDOWS Key+UP  
  ARROW 

Pan Left Smoothly   WINDOWS Key+LEFT  
  ARROW 

Pan Right Smoothly   WINDOWS Key+RIGHT  
  ARROW 

Increase Smooth Panning Speed  PLUS 

Decrease Smooth Panning Speed  MINUS 

Increase Zoom Level  CTRL+PLUS (Press and 
hold to zoom continuously until you reach the desired zoom 
level) 

Decrease Zoom Level  CTRL+MINUS (Press 
and hold to zoom continuously until you reach the desired 
zoom level) 
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Zoom to Page Width  CTRL+SHIFT+W 

Zoom to Page Height  CTRL+SHIFT+H 

Zoom to Default Zoom Level  CTRL+SHIFT+D 

Rotate Image Right  CTRL+SHIFT+R 

Rotate Image Left  CTRL+SHIFT+L 

Toggle Camera Light  CTRL+L 

Center Image  WINDOWS Key+C 
(Exact View and Camera 
View) 

Drag Image  ALT+LEFT MOUSE 
BUTTON (press and 
hold then move to drag 
image in Exact View and 
Camera View) 

OpenBook Feature Hotkeys 

Copy text  CTRL+C 

Cut text (Edit mode)  CTRL+X 

Paste text (Edit mode)  CTRL+V 

Delete Current Page  CTRL+DELETE 

Delete Character (Edit Mode)  DELETE 

Dictionary  CTRL+D or F8 

Edit Mode/Read-only Mode Toggle CTRL+E 

Move Page Down in Exact View ALT+PAGE DOWN 

Move Page Up in Exact View  ALT+PAGE UP 

Insert Page Break (Edit Mode)  CTRL+ENTER 
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Delete Page Break (Edit Mode) CTRL+SHIFT+DELETE 

Find text  CTRL+F 

Find next occurrence of text  CTRL+SHIFT+F 

Replace text (Edit Mode)  CTRL+H 

Spell Check  F7 or CTRL+K 

Spell Word  F3 twice or NUM PAD 5 
twice 

Spell Word Phonetically  F3 three times or NUM
 PAD 5 three times 

Thesaurus  CTRL+T 

Undo  CTRL+Z 

Insert Bookmark  CTRL+F9 

Delete Bookmark  CTRL+SHIFT+F9 

Close current document  CTRL+F4 or CTRL+W 

Decrease Voice Rate  CTRL+1 or SHIFT NUM
 PAD ASTERISK 

Increase Voice Rate  CTRL+2 or NUM PAD
 ASTERISK 

Mute Synthesizer  CTRL+F5 

Document Properties  CTRL+R 

Exit OpenBook  ALT+F4 

New File  CTRL+N 

Open File  CTRL+O 
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Print current document  CTRL+P 

Save current document  CTRL+S 

Toggle Windows  CTRL+F6 

Word Count  SHIFT+F7 

Using a Laptop Keyboard Layout – 
Traditional 

You can use OpenBook on a portable notebook or laptop 
computer. However, most portable computers do not have 
standard 17-key keypads. We have therefore assigned 
alternate keys to the OpenBook NUM PAD functions. 

Acquire  F4 or SPACEBAR 

Delete Page  CTRL+DELETE 

Speak  F10 or F12 

Select  ENTER 

Escape  ESC 

Key Describer  CTRL+F12 

Where Am I?  SHIFT+CTRL+F12 

Help  F1 

Voice Rate  CTRL+1 and CTRL+2 

Move Up  UP ARROW 

Move Down  DOWN ARROW 

Move Left  LEFT ARROW 

Move Right  RIGHT ARROW 

Page Up  PAGE UP 
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Page Down  PAGE DOWN 


